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Chapter 1

Tutorial Description

Overview

This Vivado® tutorial is a collection of smaller tutorials that explain and demonstrate all
steps in the process of transforming C, C++ and SystemC code to an RTL implementation
using High-Level Synthesis. The tutorial shows how you create an initial RTL implementation
and then you transform it into both a low-area and high-throughput implementation by
using optimization directives without changing the C code. The following sections describe
a summary of each tutorial.

High-Level Synthesis Introduction

This tutorial introduces Vivado High-Level Synthesis (HLS). You can learn the primary tasks
for performing High-Level Synthesis using both the Graphical User Interface (GUI) and Tcl
environments.

C Validation

This tutorial reviews the aspects of a good C test bench and demonstrates the basic
operations of the Vivado High-Level Synthesis C debug environment. The tutorial also
shows how to debug arbitrary precision data types.

Interface Synthesis

This interface synthesis tutorial reviews all aspects of creating ports for the RTL design. You
can learn how to control block-level I/0 port protocols and port I/O protocols, how arrays
in the C function can be implemented as multiple ports and types of interface protocol
(RAM, FIFO, AXIl4-Stream), and how AXI4 bus interfaces are implemented.

To create an optimal implementation of the design the tutorial concludes with a design
example where 1/O accesses and logic are optimized together.
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2: X”_INX® Chapter 1: Tutorial Description

Arbitrary Precision Types

The lab exercises in this tutorial contrast a C design written in native C types with the same
design written with Vivado High-Level Synthesis arbitrary precision types, showing how the
latter improves the quality of the hardware results without sacrificing accuracy.

Design Analysis

This tutorial uses a DCT function to explain the features of the interactive design analysis
features in Vivado High-Level Synthesis. The initial design takes you through a number of
analysis and optimization stages that highlight all the features of the analysis perspective
and provide the basis for a design optimization methodology.

Design Optimization

Using a matrix multiplier example, this tutorial reviews two-design optimization techniques.
The Design Optimization lab explains how a design can be pipelined, contrasting the
approach of pipelining the loops versus pipelining the functions.

The tutorial shows you how to use the insights learned from analyzing to update the initial
C code and create a more optimal implementation of the design.

RTL Verification

This tutorial shows how you can use the RTL CoSimulation feature to automatically verify
the RTL created by synthesis. The tutorial demonstrates the importance of the C test bench
and shows you how to use the output from RTL verification to view the waveform diagrams
in the Vivado and Mentor Graphics ModelSim simulators.

Using HLS IP in IP Integrator

This tutorial shows how RTL designs created by High-Level Synthesis are packaged as IP,
added to the Vivado IP Catalog, and used inside the Vivado Design Suite.

Using HLS IP in a Zyng SoC Design

In addition to using an HLS IP block in a Zynq®-7000 SoC design, this tutorial shows how
the C driver files created by High-Level Synthesis are incorporated into the software on the
Zynq Processing System (PS).

Using HLS IP in System Generator for DSP

This tutorial shows how RTL designs created by High-Level Synthesis can be packaged as IP
and used inside System Generator for DSP.
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2: X”_INX® Chapter 1: Tutorial Description

Software Requirements

This tutorial requires that the Vivado Design Suite 2017.1 release or later is installed.

Hardware Requirements

Xilinx recommends a minimum of 2 GB of RAM when using the Vivado tools.

Locating the Tutorial Design Files

The tutorial design files are located as a zipped archive on the Xilinx Website. After
accepting the license agreement the zip file will be automatically downloaded.

i? IMPORTANT: All the tutorial examples for Vivado High-Level Synthesis are available at: Reference
Design Files

Preparing the Tutorial Design Files

Extract the zip file contents into any write-accessible location.

This tutorial assumes that you have placed the unzipped design files in the location
C:\Vivado HLS Tutorial.

f IMPORTANT: /f the Vivado_HLS_Tutorial directory is unzipped to a different location, or if it resides on
Linux, adjust the pathnames to the location at which you have placed the Vivado HLS Tutorial
directory.
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Chapter 2

High-Level Synthesis Introduction

Overview

This tutorial introduces Vivado® High-Level Synthesis (HLS). You can learn the primary
tasks for performing High-Level Synthesis using both the Graphical User Interface (GUI) and
Tcl environments.

The tutorial shows how use of optimization directives transforms an initial RTL
implementation into both a low-area and high-throughput implementation.
Lab 1 Description

Explains how to set up a High-Level Synthesis (HLS) project and perform all the major steps
in the HLS design flow:

Validate the C code.
Create and synthesize a solution.

Verify the RTL and package the IP.

Lab 2 Description

Demonstrates how to use the Tcl interface.

Lab 3 Description

Shows you how to optimize the design using optimization directives. This lab creates
multiple versions of the RTL implementation and compares the different solutions.

Tutorial Design Description

To obtain the tutorial design file, see Locating the Tutorial Design Files.
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2: XI LI NX® Chapter 2: High-Level Synthesis Introduction

This tutorial uses the design files in the tutorial directory.
Vivado HLS Tutoriall\Introduction.

The sample design used in this tutorial is a FIR filter. The hardware goal for this FIR design
project is:

« Create a version of this design with the highest throughput.

The final design must process data supplied with an input valid signal and produce output
data accompanied by an output valid signal. The filter coefficients are to be stored
externally to the FIR design, in a single port RAM.

Lab 1: Creating a High-Level Synthesis Project

Introduction

This lab shows how to create a High-Level Synthesis project, validate the C code, synthesize
the design to RTL, and verify the RTL.

f IMPORTANT: The figures and commands in this tutorial assume the tutorial data directory
Vivado HLS Tutorial files are unzipped and placed in the location C:\Vivado HLS Tutorial.

Step 1: Creating a New Project
1. Open the Vivado® HLS Graphical User Interface (GUI):

- On Windows systems, open Vivado HLS by double-clicking the Vivado HLS 2020.1

desktop icon.

Vivado HLS

Figure 2-1: The Vivado HLS Desktop Icon

o On Linux systems, type vivado_hls at the command prompt.

TIP: You can also open Vivado HLS using the Windows menu Start > All Programs > Xilinx Design
Tools > Vivado 2020.1 > Vivado HLS > Vivado HLS 2020.1.

Vivado HLS opens with the Welcome Screen as shown below. If any projects were previously
opened, they are shown in the Recent Project pane, otherwise this window is not shown in
the Welcome screen.
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¢ Vivado HLS 2019.1_EA2496192 — | X
File Edit Project Selution Window Help
| E\fwadn HLS Welcome Page 5

VIVADO™ XILINX.

HLS

Quick Start Recent Projects

proj_hls_stream
Ciwivado_hls\hls_examplesihls_stream’\proj_hls_stream

A\ o
=2\ \ i o
Create New Project Open Project Open Example Project

Documentation

m

Tuterials User Guide Release Motes Guide

Figure 2-2: The Vivado HLS Welcome Page
2. In the Welcome Page, select Create New Project to open the Project wizard.
3. As shown in Figure 2-3:
a. Enter the project name fir prj.
b. Click Browse to navigate to the location of the 1ab1 (Introduction) directory.
c. Select the 1ab1 directory and click OK.
d. Click Next.
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v
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v
Project Configuration i_G‘l
| Create Vivado HLS project of selected type i . i/
Project name: | fir_prj |
Location: | CA\Vivado_HLS_Tutorial\Introduction’lab1 Browse...
Ba MNext > nish Cancel

Figure 2-3:

This information defines the name and location of the

Project Configuration

Vivado HLS project directory. In

this case, the project directory is £ir_ prj and it resides in the 1ab1 folder.

4. Enter the following information to specify the C design files:

a. Click Add Files.

b. Select fir.c and click OK.

c. Use Browse button to specify fir (fir.c) as the top-level function.
d. Click Next.
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¢ MNew Vivado HLS Praject O X
Add/Remove Files E‘,}' =
Add/remove C-based source files (design specification) %y
Top Function: | fir | |Brnwse...|
Design Files
Mame CFLAGS Add Files...
e New File...
Edit CFLAGS...
Remove
< Back Mext = Finish Cancel

Figure 2-4: Project Design Files

i? IMPORTANT: /n this lab there is only one C design file. When there are multiple C files to be
synthesized, you must add all of them to the project at this stage. Any header files that exist in the local
directory labl are automatically included in the project. If the header resides in a different location,
use the Edit CFLAGS button to add the standard gcc/g++ search path information (for example, - I
<path to header file dirs).

Figure 2-5 shows the input window for specifying the test bench files. The test bench and
all files used by the test bench (except header files) must be included. You can add files one
at a time, or select multiple files to add using the Ctrl and Shift keys.
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¢ MNew Vivade HLS Project O *
Add/Remove Files E;," —
Add/remove C-based testbench files (design test)
TestBench Files
MName CFLAGS Add Files...
fi !
et New File...
out.gold.dat
Add Folder...
Edit CFLAGS...
Remove
< Back Mext = Finish Cancel

Figure 2-5: Test Bench Files

5. Click the Add Files button to include both test bench files: fir test.c and
out .gold.dat.

6. Click Next.
Both C simulation (and RTL CosSmulation) execute in subdirectories of the solution.

If you do not include all the files used by the test bench (for example, data files read by the
test bench, such as out.gold.dat), C and RTL simulation might fail due to an inability to
find the data files.

The Solution Configuration window (shown in Figure 2-6) specifies the technical
specifications of the first solution.

A project can have multiple solutions, each using a different target technology, package,
constraints, and/or synthesis directives.
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¢ New Vivado HLS Project O X

Solution Configuration e

Create Vivado HLS solution for selected technology

Solution Name: solution’ ‘

Clock
Period: | 10 ‘ Uncertainty: ‘ ‘

Part Selection
Part: xcvu9p-flgh2104-1-e E

[ ] vitis Bottom Up Flow

< Back Finish Cancel

Figure 2-6: Solution Configuration

7. Accept the default solution name (solution1), clock period (10 ns), and clock
uncertainty (defaults to 12.5% of the clock period, when left blank/undefined).

8. Click the part selection button to open the part selection window.

9. Select the Parts tab and select xcvu9p-flgb2104-1-e from the list of available devices.
Select the following from the drop-down filters to help refine the parts list:

a. Product Category: General Purpose
b. Family: Virtex® UltraScale™
c. Sub-Family: Virtex UltraScale+
d. Package: flgb2104
e. Speed Grade: 1
f. Temp Grade: All
10. Select xcvu9p-flghb2104-1-e.
11. Click OK.
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Chapter 2: High-Level Synthesis Introduction

In the Solution Configuration dialog box (shown in Figure 2-6, above), the selected part
name now appears under the Part Selection heading.

12. Click Finish to open the Vivado HLS project, as shown in Figure 2-7.

et
[ Explorer &3
]

it Includes

S Source

= Test Bench
Y= solutiont

fir_prj

¢ Vivade HLS 2019.1 - fir_prj (C:\Vivado_HLS_Tutorial\Intreduction\lab1\fir_prj) — O *
File Edit Project Solution Window Help

EoWmaRor-E B89 gl | %% Debug || éSynthesws & Analysis

0__'| Errors| & Warnings Sk

s

0= Outline 52 ¥ Directive =]

= O | |An outline is not availzble.

&
i
L0
[l
A
4
I
(|

Figure 2-7: Vivado HLS Project

« The project name appears on the top line of the Explorer window.

« A Vivado HLS project arranges information in a hierarchical form.

« The project holds information on the design source, test bench, and solutions.

« The solution holds information on the target technology, design directives, and results.

« There can be multiple solutions within a project, and each solution is an
implementation of the same source code.

TIP: At any time, you can change project or solution settings using the corresponding Project Settings
O and/or Solution Settings buttons in the toolbar.

Understanding the Graphical User Interface (GUI)

Before proceeding, review the regions in the Graphical User Interface (GUI) and their
functions. Figure 2-8 shows an overview of the regions, and describes each below.
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4 Vivado HLS - fir_prj (C:A\Vivado_HLS_TutorialIntroduction\labI\fir_prj) = o <
File Edit Project Solution Window Help
{ XonESWB@Eosaid. e %5 Debug [/ ]Synthesis |~ Analysis
[ Explorer £2 ol & = 08 |[E= Outline =2 . Dirffftive = 0
4 1 fir_prj T =
= Includes An = =
= Source Toolbar Buttons Perspectives
@= Test Bench T

4 Y= solution
« # constraints
W directives.tcl

W scripttcl .
B Information
Pane
Project Auxiliary
Explorer Pane
Pane
B Console 52 @) Emrors| & Wamings $ ¢BBE-K=D0
CDT Build Console [fir_prj]
Console
Pane

1 item selected
Figure 2-8: Vivado HLS Graphical User Interface

Explorer Pane

Shows the project hierarchy. As you proceed through the validation, synthesis, verification,
and IP packaging steps, sub-folders with the results of each step are created automatically
inside the solution directory (named csim, syn, sim, and impl respectively).

When you create new solutions, they appear inside the project hierarchy alongside
solution1.

Information Pane

Shows the contents of any files opened from the Explorer pane. When operations complete,
the report file opens automatically in this pane.

Auxiliary Pane

Cross-links with the Information pane. The information shown in this pane dynamically
adjusts, depending on the file open in the Information pane.
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2: XI LI NX® Chapter 2: High-Level Synthesis Introduction

Console Pane

Shows the messages produced when Vivado HLS runs. Errors and warnings appear in
Console pane tabs.

Toolbar Buttons
You can perform the most common operations using the Toolbar buttons.

When you hold the cursor over the button, a popup tool tip opens, explaining the function.
Each button also has an associated menu item available from the drop-down menus.

Perspectives

The perspectives provide convenient ways to adjust the windows within the Vivado HLS
GUL.

« Synthesis Perspective

The default perspective allows you to synthesize designs, run simulations, and package the
IP.

+ Debug Perspective

Includes panes associated with debugging the C code. You can open the Debug Perspective
after the C code compiles (unless you use the Optimizing Compile mode as this disables
debug information).

« Analysis Perspective

Windows in this perspective are configured to support analysis of synthesis results. You can
use the Analysis Perspective only after synthesis completes.

Step 2: Validate the C Source Code

The first step in an HLS project is to confirm that the C code is correct. This process is called
C Validation or C Simulation.

In this project, the test bench compares the output data from the £ir function with known
good values.

1. Expand the Test Bench folder in the Explorer pane.
2. Double-click the file fir test.c to view it in the Information pane.

3. In the Auxiliary pane, select main () in the Outline tab to jump directly to the main ()
function.

Figure 2-9 shows the result of these actions
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[

o o % A ; |
File Edit Project Solution Window Help |

[F 5], y:Bg i mREa e Bigl W Eiar:® %5 Debug s | Synthesis & Analysis
I Explorer &2 = 8 || g firtestc 22 = O ||5= Qutline &3 4 Directive = m
v S firpr int main () { o Elk®s e ¥
[l Includes const int  SAMPLES=650@; U stdioh
v £ Source FILE *fps W math.h |
[ fir.c o firh
5 L%stBen(h data_t signal, output; u "_ g |
T coef_t taps[N] = {@,-1@,-9,23,56,63,56,23,-9,-18,8,}; @ main():in
L fir_test.c
|5 out.gold.dat int i, ramp_up;
= solution1 signal = @;
ramp_up = 1;
fp=fopen("out.dat","w");
for (i=@;i<=SAMPLES;i++) {
if (ramp_up == 1)
signal = signal + 13
else
signal = signal - 1;
// Execute the function with latest input
fir(&output,taps,signal);
v
B Console 52 @] Errors| & Warnings SRR B B~ 4 - O

Vivado HLS Console

Figure 2-9: Reviewing the Test Bench Code

The test bench file, fir test.c, contains the top-level C function main (), which in turn
calls the function to be synthesized (£ir). A useful characteristic of this test bench is that it
is self-checking:

« The test bench saves the output from the £ir function into the output file, out . dat.
« The output file is compared with the golden results, stored in file out .gold.dat.

« If the output matches the golden data, a message confirms that the results are correct,
and the return value of the test bench main () function is set to 0.

« If the output is different from the golden results, a message indicates this, and the
return value of main () is set to 1.

The Vivado HLS tool can reuse the C test bench to perform verification of the RTL.

If the test bench has the previously described self-checking characteristics, the RTL results
are automatically checked during RTL verification. Vivado HLS re-uses the test bench during
RTL verification and confirms the successful verification of the RTL if the test bench returns
a value of 0. If any other value is returned by main (), including no return value, it indicates
that the RTL verification failed. There is no requirement to create an RTL test bench. This
provides a robust and productive verification methodology.

4. Click the Run C Simulation button, or use menu Project > Run C Simulation, to
compile and execute the C design.
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5. In the C Simulation dialog box, click OK.

The Console pane (Figure 2-10) confirms the simulation executed successfully.

¢ Vivado HLS 2019.1- fir_prj (C:\Vivade_HLS_Tuterial\Introduction\lab1\fir_prj) T ] x
File Edit Project Solution Window Help
E [3 B! ERX G R ESehE RO -V O-0F i E . %5 Debug |, | Synthesis & Analysis
[ Explorer 52 = 8 |[ [ firtest.c = fir_esim.log &2 = 0 |[g= Outline 52 [ Directive = g
~ 125 fir_prj 7 INFO: EHLS 299—19] In directory 'C:/\rivado_HLS_Tutorial/Introduction/labl/ﬁ?A An outline is not available.
) Includes 8 INFO: [APCC 202-3] Tmp d]}rectury is apec_db
v B Saurca 9 INFO: [APCC 282-1] APCC is done.
Ll i 18  Compiling(apcc) ../../../../fir.c in debug mode
g fire 11INFO: [Common 17-1472] The existence of ¥HOMEDRIVEX/.Xilinx (e.g. C:/.Xilinx]
w fi= Test Bench 12 INFO: [HLS 20@-1@] Running 'C:/Xilinx 2019 1/Vivado/20819.1.EA2496192/bin/unwr
|8 fir test.c 13 INFO: [HLS 28@-18] For user 'scampbell’ on host 'xcoscampbell3@' (Windows NT.
Ly fir_ p p 2
=, out.gold.dat 14 INFO: [HLS 28@-18] In directory 'C:/Vivade_HLS_Tutorial/Introduction/labl/fir
. .‘?t;l'uﬁon‘l 15 INFO: [APCC 202-3] Tmp directory is apcc_db
- 16 INFO: [APCC 202-1] APCC is done.
17 Generating csim.exe
12 Comparing against output data
19
28 PASS: The output matches the golden output!
21
22 INFO: [SIM 1] CSim done with @ errors.
23INFO: [SIM 3] ====sssssssssss (SIM finish ===s==sszssszss
w
< >
& Console 2 Q] Errors| & Wamings =% bE & B | ME-B-g =08
Vivado HLS Console
INFO: [HLS 2@@-18] In directory 'C:/Vivado HLS Tutorial/Introduction/labl/fir_prj/solutionl/csim/build’ i
INFO: [APCC 282-3] Tmp directory is apecc_db
INFO: [APCC 2082-1] APCC is done.
Generating csim.exe
Comparing against output data
PASS: The output matches the golden output!
INFO: [SIM 211-1] CSim done with @ errors.
INFO: [SIM 211-3] ****sssssssssss [STM Finish *sssesssssssess
Finished C simulation.
v
< 2>

Figure 2-10: Results of C Simulation

TIP: If the C simulation ever fails, select the Launch Debugger option in the C Simulation dialog box,
O compile the design, and automatically switch to the Debug perspective. There you can use a C
debugger to fix any problems.

The C Validation tutorial module provides more details on using the Debug environment.

The design is now ready for synthesis.

Step 3: High-Level Synthesis

In this step, you synthesize the C design into an RTL design and review the synthesis report

1. Click the Run C Synthesis toolbar button or use the menu Solution > Run C Synthesis
> Active Solution.
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When synthesis completes, the report file opens automatically. Because the synthesis
report is open in the Information pane, the Outline tab in the Auxiliary pane automatically
updates to reflect the report information.

2. Click Performance Estimates in the Outline tab (Figure 2-11).

3. In the Detail section of the Performance Estimates, expand the Loop view.

Performance Estimates
-] Timing (ns)

—-| Summary

Clock | Target | Estimated | Uncertainty
ap_clk 10,00 5772 1.25

- Latency (clock cycles)

-] Summary

Latency Interval

min | max | min | max | Type
34 34 34 34 | none

- Detail
+ Instance
- Loop
Latency Initiation Interval
Loop Mame min | max | [teration Latency | achieved | target | Trip Count | Pipelined
- Shift_Accum_Loop 33 33 3 - - 11 nao

Figure 2-11: Performance Estimates

In the Performance Estimates pane, shown in Figure 2-11, you can see that the clock period
is set to 10 ns. Vivado HLS targets a clock period of Clock Target minus Clock Uncertainty
(10.00-1.25 = 8.75 ns in this example).

The clock uncertainty ensures there is some timing margin available for the (at this stage)
unknown net delays due to place and routing.

The estimated clock period (worst-case delay) is 5.772 ns, which meets the 8.75 ns timing
requirement.

In the Summary section, you can see:

« The design has a latency of 34-clock cycles: it takes 34 clocks to output the results.

« The interval is 34 clock cycles: the next set of inputs is read after 34 clocks. The design
is not pipelined. The next execution of this function (or next transaction) can only start
when the current transaction completes.

The Detail section shows:
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« There are no sub-blocks in this design. Expanding the Instance section shows no
submodules in the hierarchy.

« All the latency delay is due to the RTL logic synthesized from the loop named
Shift Accum_Loop. This logic executes 11 times (Trip Count). Each execution
requires 3 clock cycles (Iteration Latency), for a total of 33 clock cycles, to execute all
iterations of the logic synthesized from this loop (Latency).

« The total latency is one clock cycle greater than the loop latency. It requires one clock
cycle to enter and exit the loop (in this case, the design finishes when the loop finishes,
so there is no exit cycle).

4. In the Outline tab, click Utilization Estimates (Figure 2-12).

- The design uses a single memory implemented as LUTRAM (since it contains less
than 1024 elements), 3 DSP48s, and approximately 200 flip-flops and LUTs. At this
stage, the device resource numbers are estimates.

- The resource utilization numbers are estimates because RTL synthesis might be able
to perform additional optimizations, and these figures might change after RTL
synthesis.

Utilization Estimates

=l Summary

MName BRAM_18K | DSP4BE FF LuT URAM
DspP
Expression - 3 0 83
FIFO
Instance
Memaory 0 > od ] 0
Multiplexer - 2 Z 105
Register : > m -
Total 0 3 175 196 0
Available 4320 6240 | 2364480 | 1182240 960
Available SLR 1440 2280 | 788160 | 3940820 320
Utilization (%) 0 ~0 ~0 ~0 0
Utilization SLR (26) 0 ~0 -0 ~0 0

Figure 2-12: Utilization Estimates

5. In the Detail section of the Utilization Estimates, expand the Expression view.
- The multiplier instance shown in the Expression view accounts for all the DSP48s.

- The multiplier is a pipelined multiplier. It appears in the Expression section
indicating it is a sub-block. Standard combinational multipliers have no hierarchy
and are listed in the Expressions section (indicating a component at this level of
hierarchy).

In: Lab 3: Using Solutions for Design Optimization, you optimize this design.

6. In the Outline tab, click Interface (Figure 2-13).
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=| fir_csim.log =l Synthesis(solution1) &3 = O
Interface oy
- Summary
RTL Ports Dir  Bits Protocol Source Object C Type
ap_clk in 1 ap_ctrl_hs fir  return value
ap_rst in 1 ap_ctrl_hs fir  return value
ap_start in 1 ap_ctrl_hs fir  return value
ap_done out 1 ap_ctrl_hs fir  return value
ap_idle out 1 ap_ctrl_hs fir  return value
ap_ready out 1 ap_ctrl_hs fir  return value
v out 32 ap_vid v pointer
y_ap_vid out 1 ap_vid ¥ painter
c_addressO  out 4 ap_memary C array
c_cel out 1 ap_memory C array =
c_g0 in 32 ap_memory C array
X in 32 ap_none X scalar
4 il 3

Figure 2-13: Interface Report

The Interface section shows the ports and I/O protocols created by interface synthesis:

« The design has a clock and reset port (ap_clk and ap_reset). These are associated
with the Source Object £ir: the design itself.

« There are additional ports associated with the design as indicated by Source Object fir.
Synthesis has automatically added some block level control ports: ap start,
ap_done, ap_idle, and ap_ready.

« The Interface Synthesis tutorial provides more information about these ports.

« The function output y is now a 32-bit data port with an associated output valid signal
indicator y_ap_ v1ld.

« Function input argument c (an array) has been implemented as a block RAM interface
with a 4-bit output address port, an output CE port and a 32-bit input data port.

« Finally, scalar input argument x is implemented as a data port with no 1/O protocol
(ap_none).

Later in this tutorial: Lab 3: Using Solutions for Design Optimization explains how to
optimize the 1/O protocol for port x.

Step 4: RTL Verification

High-Level Synthesis can re-use the C test bench to verify the RTL using simulation.

High-Level Synthesis N Send Feedback 23
UG871 (v2020.1) August 7, 2020 www.xilinx.com [—\/—]


https://www.xilinx.com
https://www.xilinx.com/about/feedback/document-feedback.html?docType=Tutorials&docId=UG871&Title=Vivado%20Design%20Suite%20Tutorial&releaseVersion=2020.1&docPage=23

2: XI LI NX® Chapter 2: High-Level Synthesis Introduction

1. Click the Run C/RTL CoSimulation toolbar button or use the menu Solution > Run
C/RTL CoSimulation.

2. Click OK in the C/RTL Co-simulation dialog box to execute the RTL simulation.

The default option for RTL co-simulation is to perform the simulation using the Vivado
simulator and Verilog RTL. To perform the verification using a different simulator or
language use the options in the C/RTL Co-simulation dialog box.

When RTL co-simulation completes, the report opens automatically in the Information
pane, and the Console displays the message shown in Figure 2-14. This is the same
message produced at the end of C simulation.

« The C test bench generates input vectors for the RTL design.
« The RTL design is simulated.

« The output vectors from the RTL are applied back into the C test bench and the
results-checking in the test bench verify whether or not the results are correct.

« The Vivado HLS indicates that simulation passes if the test bench returns a value of 0. It
is the value of the return variable in the test bench, and this alone, which indicates if
the simulation was successful. It is important that the test bench returns a value of 0
only if the results are correct.

) Console &2 . @) Errors| & Wamings| ‘= DRCs % af = | BN = O
Vivado HLS Console
INFO: [COSIM 212-316] Starting C post checking ... A

Comparing against cutput data
Fkkkkkkkkkkkkkdkkkkkkkhr bk kkkkk kbR Rk kkkkkE

PASS: The output matches the golden output!

e 3k e o o e ok ok ok ok e ok ok ok ok ke sk ok ok ok ok s ke ohe ok ok ke o ok e ok ok ok ok ke ok ok ok o ke ke ok ke

INFO: [COSIM 212-1888] *** C/RTL co-simulation finished: PASS ***
Finished C/RTL cosimulation.

Figure 2-14: RTL Verification Results

The Chapter 8, RTL Verification tutorial provides additional information.

Step 5: IP Creation

The final step in the High-Level Synthesis flow is to package the design as an IP block for
use with other tools in the Vivado Design Suite.

1. Click the Export RTL toolbar button or use the menu Solution > Export RTL.
2. Ensure the Format Selection drop-down menu shows IP Catalog.

3. Click OK.
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The IP packager creates a package for the Vivado IP Catalog. (Other options available from
the drop-down menu allow you to create IP packages for System Generator for DSP, a
Synthesized Checkpoint format for Vivado, or a Pcore for Xilinx Platform Studio.)

4. Expand Solution1 in the Explorer.

5. Expand the impl folder created by the Export RTL command.

6. Expand the ip folder and find the IP packaged as a zip file, ready for adding to the

Vivado IP Catalog (Figure 2-15).

L™ Explorer &5

w Y= xcvudp

S 0

~

% constraints

= csim
w [= impl
v = ip

=| autocimpl.log

=| auxiliary.xml
=| componentxml

[%] pack.bat

i run_ippack.tcl
o .

g vivado.jou

=| vivado.log
xilinx_com_hls_fir_1_0.zip

& constraints

= bd

= doc

= example

= hdl

= misc

= subcore

[= xgui &

Figure 2-15:

RTL Verification Results

At this stage, leave the Vivado HLS GUI open. You will return to this in the next lab exercise.

Lab 2: Using the Tcl Command Interface

Introduction

This lab exercise shows how to create a Tcl command file based on an existing Vivado HLS

project and use the Tcl interface.
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Step 1: Create a Tcl file

1. Open the Vivado HLS Command Prompt.

- On Windows, use Start > All Programs > Xilinx Design Tools > Vivado 2020.1 >
Vivado HLS > Vivado HLS 2020.1 Command Prompt (Figure 2-16).

o On Linux, open a new shell.

BN Vivado HLS 2019.1 Command Prompt - O *

ado HLS Command Prompt
= Available commands:
rivado_hls,apcc,gcc, g++,make

=1

—

oft Windows [Version 18.8.15863]

{(c) 2817 Microsoft Corporation. All rights reserved.

C:\Xilinx_ 2819 1\Vivado\2819.1:

Figure 2-16: The Vivado HLS Command Prompt

When you create a Vivado HLS project, Tcl files are automatically saved in the project
hierarchy. In the GUI still open from Lab 1, a review of the project shows two Tcl files in
the project hierarchy (Figure 2-17).

2. In the GUI, still open from Lab 1, expand the Constraints folder in solution1 and
double-click the file script.tcl to view it in the Information pane.
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17 Explorer £1 e w IR script.tel &2 = 8
1 P
w 2= fir_pr L ;
[ Includes ol ik This ¥
3 ## Please
v = Source 4
g firc 5
v iz Test Bench 6 open_project fir_prj
[, fir_test.c 7 set_top fir
~ out.gold.dat 3 add_files fir.c
. Ef”_ g: : 9 add_files -tb fir test.c
v & solutont 16 add_files -tb out.gold.dat
v constraints 11 open_solution "solutionl"
4 directives.tcl 12 set_part {xcvudp-flgb2le4-1-e}
ﬁéscript.tcl 13 create_clock -period 18 -name default
& csim 14 config_compile -no_signed_zeros=8 -unsafe_math_ocptimizations=@
imol 15 config_schedule -effort medium -enable_dsp_full reg=@ -relax_ii for_timing=8
@lmp 16 config_bind -effort medium
= sim 17 config sdx -optimization_level none -target none
= syn 18 config_export -format ip_catalog -rtl verilog
9 #source "./fir_prj/solutionl/directives.tcl”
8 csim_design

csynth_design
cosim_design
export_design -rtl verilog -format ip_catalog

[
=T Nt

Figure 2-17: The Vivado HLS Project Tcl Files

« The file script.tcl contains the Tcl commands to create a project with the files
specified during the project setup and run all stages of the HLS flow.

+ Thefile directives.tcl contains any optimizations applied to the design solution.
No optimization directives were used in Lab 1 so this file is empty.

In this lab exercise, you use the script.tcl from Lab 1 to create a Tcl file for the Lab 2
project.

3. Close the Vivado HLS GUI from Lab 1. This is project no longer needed.

4. In the Vivado HLS Command Prompt, use the following commands (also shown in
Figure 2-18) to create a new Tcl file for Lab 2.

a. Change directory to the Introduction tutorial directory
C:\Vivado HLS Tutorial\Introduction.

b. Use the command cp labl\fir prj\solutionl\script.tcl
lab2\run hls.tcl to copy the existing Tcl file to Lab 2. (The Windows command
prompt supports auto-completion using the Tab key: press the tab key repeatedly to
see new selections).

c. Use the command cd lab2 to change into the 1ab2 directory.
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C:\>cd Uivado_HLS_Tutorial\Introduction

C:\VUivado_HLS_Tutorial\Introduction>cp labl\fir_prj\solutioni\script.tcl lab2\ru
n_hls.tcl

C:\Uivado_HLS_Tutorial\Introduction>cd lab2

C:\Uivado_HLS_Tutorial\Introduction\lab2>

Figure 2-18: Copying the Lab 1 Tcl file to Lab 2

5. Using any text editor, perform the following edits to the file run_hls.tcl in the 1ab2
directory. The final edits are shown in Figure 2-19.

a. Add a -reset option to the open_project command. Because you typically run
Tcl files repeatedly on the same project, it is best to overwrite any existing project
information.

b. Add a -reset option to the open solution command. This removes any existing
solution information when the Tcl file is re-run on the same solution.

c. Leave the source command commented. If the previous project contains any
directives you wish to re-use, you can copy the directives directly into this file.

d. Add the exit command to the last line of the Tcl file.

e. Save and exit.
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B run_hlstel E3 l

GRS S SRR Rk
## This file is generated automatically by Vivado HLS.

## Please DO NOT edit it.

## Copyright (C) 1986-2019 Xilinx, Inc. All Rights Reserved.
GRS S SRR Rk

=1 @ s W R

#Reset and create the project
open_project -reset fir prj

9 set top fir
10 add files fir.c

11 add files -tb fir test.c
12 add files -tb out.gold.dat
14 #Reset and open the solution
15 open_solution -reset "solutionl"
16 set part {xcvuSp-flgb2104 }
17 create clock -period -name default
18

z #Configure default options

0 config compile -no signed zeros=0 -unsafe math optimizations=

config schedule -effort medium -enable dsp full reg=0 -relax 11 for timing=

config bind -effort medium
config sdx -optimization level none -target none
config export -format ip catalog -rtl wverilog

#Comment out previous solutions directives
#source "./fir prj/solutionl/directives.tcl™

L (s ST o (Y = S I N I

csim design

csynth design

cosim design

export design -rtl wverilog -format ip catalog

=R i)

#Exit Vivado HLS
exit

LS WP % T % T T T T o Y Y T T 0 T T T O Y ]

[ 5 [ =S I 6 B

Figure 2-19: Updated run_hls.tcl file for Lab 2

You can run the Vivado HLS in batch mode using this Tcl file.
6. In the Vivado HLS Command Prompt window, type vivado hls -f run hls.tcl.

Vivado HLS executes all the steps covered in lab1. When finished, the results are available
inside the project directory fir prj.

« The synthesis report is available in fir prj\solutionl\syn\report.
» The simulation results are available in fir prj\solution\sim\report.
« The output package is available in fir prj\solutionl\impl\ip.

« The final output RTL is available in fir prj\solutionl\impl and then Verilog or
VHDL.

High-Level Synthesis N Send Feedback 29
UG871 (v2020.1) August 7, 2020 www.xilinx.com l—\/—l


https://www.xilinx.com
https://www.xilinx.com/about/feedback/document-feedback.html?docType=Tutorials&docId=UG871&Title=Vivado%20Design%20Suite%20Tutorial&releaseVersion=2020.1&docPage=29

2: XI LI NX® Chapter 2: High-Level Synthesis Introduction

Y

High-Level Synthesis

CAUTION! When copying the RTL results from a Vivado HLS project, you must use the RTL from the
impl directory. Additional processing is performed by Vivado HLS during export_design before you
can use this RTL in other design tools.

Lab 3: Using Solutions for Design Optimization

Introduction

This lab exercise uses the design from Lab 1 and optimizes it.

Step 1: Creating a New Project

1. Open the Vivado HLS Command Prompt.

- On Windows, use Start > All Programs > Xilinx Design Tools > Vivado 2020.1 >
Vivado HLS > Vivado HLS 2020.1 Command Prompt.

o On Linux, open a new shell.

2. Change to the Lab 3 directory:
cd C:\Vivado HLS Tutoriall\Introduction\lab3

3. In the command prompt window, type: vivado hls -f run hls.tcl
This sets up the project.

4. In the command prompt window, type vivado _hls -p fir prj to open the project
in the Vivado HLS GUI.

Vivado HLS opens, as shown in Figure 2-20, with the synthesis for solution1 already
complete.
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¢ Vivado HLS5 2019.1- fir_prj (C\Vivado_HLS_Tuterial\ntroductiontlab2\fir_prj) - O X
File Edit Project Solution Window Help
sk B o Rt 2O r-~¥M 8- e &) 45 Debug | | Synthesis & Analysis
L Explorer 232 = 8 = B | 5% Outline 2 [ Directive = 8
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= Source
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“% directives.tcl
4 scriptcl
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= build
= report
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= ip
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(= verilog
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(= report
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= vhdl
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Figure 2-20: Introduction Lab 3 Initial Solution

As stated earlier, the design goals for this design are:

« Create a version of this design with the highest throughput.
« The final design should be able to process data supplied with an input valid signal.
« Produce output data accompanied by an output valid signal.

« The filter coefficients are to be stored externally to the FIR design, in a single port
RAM.

Step 2: Optimize the 1/0 Interfaces

Because the design specification includes /O protocols, the first optimization you perform
creates the correct 1/0 protocol and ports. The type of I/O protocol you select might affect
what design optimizations are possible. If there is an I/O protocol requirement, you should
set the 1/O protocol as early as possible in the design cycle.

You reviewed the 1/O protocol for this design in Lab 1 (Figure 2-13), and you can review the
synthesis report again by navigating to the report folder inside the solutioni1\syn folder.
The 1I/0 requirements are:

« Port C must have a single port RAM access.

« Port X must have an input data valid signal.
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« Port Y must have an output data valid signal.

Port C already is a single-port RAM access. However, if you do not explicitly specify the RAM
access type, High-Level Synthesis might use a dual-port interface. HLS takes this action if
doing so creates a design with a higher throughput. If a single-port is required, you should
explicitly add to the design the 1/O protocol requirement to use a single-port RAM.

Input Port X is by default a simple 32-bit data port. You can implement it as an input data
port with an associated data valid signal by specifying the 1/O protocol ap_v1d.

Output Port Y already has an associated output valid signal. This is the default for pointer
arguments. You do not have to specify an explicit port protocol for this port, because the
default implementation is what is required, but if it is a requirement, it is a good practice to
specify it.

To preserve the existing results, create a new solution, solution2.

1. Click Project > New Solution toolbar button to create a new solution.

2. Leave the default solution name as solution2. Do not change any of the technology
or clock settings.

3. Click Finish.

This creates solution2 and sets it as the default solution. To confirm you can verify that
the current active solution?2 is highlighted in bold in the Explorer pane.

To add optimization directives to define the desired 1/0 interfaces to the solution, perform
the following steps.

4. In the Explorer pane, expand the Source container (as shown in Figure 2-21).
5. Double-click fir.c to open the file in the Information pane.

6. Activate the Directive tab in the Auxiliary pane and select the top-level function fir to
jump to the top of the fir function in the source code view.
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¢ Vivado HLS 2019.1_EA2496192 - fir_prj (C:\Vivado_HLS_Tutorial\Introduction\lab2\fir_prj) - m} x
File Edit Project Selution Window Help
HER+BCXG R GH B ES s -0 0 -0 | 35 Debug |, | Synthesi | 4 Analysis
[ Explerer £2 W = 8 |8 firc 2 = O ||g= Outline |1 Directive &2 =g
v I fipr 2@ Vendor: Xilinx a ” v @ fir
il Includes #include "fir.h ey
v = Source void 1 ( @ c
g firc data_t "y, o
iz Test Bench coef_t c[N], #[1 shift_reg
23 solutionl data_t x ' Shift_Accum_Loop
v {= solution2 I

~ $F constraints
U directives.tcl
U scriptiel

static data_t shift_reg[N];
acc_t acc;

data_t data;

int i;

acc=0;
Shift_Accum_Loop: for (i=N-1;i»=@;i--) {
if (i==8) {
shift_reg[@]=x;
data = x;

} else {
shift_reg[i]=shift_reg[i-1];
data = shift reg[il; v
onsole W] Errors| & Warnings| "= s =k af = LT e
B Console 22 @] E Warnings| ‘= DRC BE = 8- = 0

Vivado HLS Console

1 item selected

Figure 2-21: Opening the Directives Tab

The Directives tab, shown on the right side of Figure 2-21, lists all of the objects in the
design that can be optimized. In the Directive tab, you can add optimization directives to
the design. You can view the Directives tab only when the source code is open in the
Information pane.

Apply the optimization directives to the design.

7. In the Directive tab, select the ¢ argument/port (green dot).

8. Right-click and select Insert Directive.

9. Implement the single-port RAM interface by performing the following:
a. Select RESOURCE from the Directive drop-down menu.
b. Click the core box.
c. Select RAM_1P_BRAM, as shown in Figure 2-22. Then select OK.

The steps above specify that array c be implemented using a single-port block RAM
resource. Because array c is in the function argument list, and hence is outside the function,
a set of data ports are automatically created to access a single-port block RAM outside the
RTL implementation.

Because 1/0O protocols are unlikely to change, you can add these optimization directives to
the source code as pragmas to ensure that the correct I/O protocols are embedded in the
design.
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10. In the Destination section of the Directive Editor, select Source File.

11. To apply the directive, click OK.

Chapter 2: High-Level Synthesis Introduction

Directive
| |RESOURCE w

Destination
() Source File
(®) Directive File

Options

variable (required): | C |

| RAM_1P_BRAM ‘ r

latency (optional): | |

core (required):

metadata (opticnal): | |

Help Cancel

Figure 2-22:

/ Vivado HLS Core Selection O ¥

Filter
Core Type: | storage v

Options
Memory Type: | RAM v
Mumber of Ports: m W

Resource Type: | ALL v

RAM_1P
RAM_1P_LUTRAM
RAM_1P_URAM

Single-port RAM using 'Block RAM'

Cancel

Adding a Resource Directive

TIP: If you wish to change the destination of any directive, double-click on the directive In the Directive
O tab and modify the destination.

12. Specify port x to have an associated valid signal/port.

a.

b.

In the Directive tab, select input port x (green dot).

Right-click and select Insert Directive.

Select Interface from the Directive drop-down menu.

Select Source File from the Destination section of the dialog box.

Select ap_vld as the mode.

Click OK to apply the directive.

13. Specify port y to have an associated valid signal/port.

a.

In the Directive tab, select input port y (green dot).

b. Right-click and select Insert Directive.

C.

Select Source File from the Destination section of the dialog box.
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d. Select Interface from the Directive drop-down menu.
e. Select ap_vld for the mode.

f. Click OK to apply the directive.

When complete, verify that the source code and the Directive tab are correct as shown in
Figure 2-23. Right-click on any incorrect directive to modify it.

[€] *firg &3 = O |[8= Outline |G Directive 52 =04
46 #include "fir.h" - ® fir

/ . . #[1 shift_reg

8void fir (

9  data_t *y, 2y

0 coef t c[N], # HLS INTERFACE ap_vld port=y

1 data_t x 4C

2 ) { # HLS RESOURCE variable=c core=RAM_1P_BRAM

3 #pragma HLS INTERFACE ap_vld port=y P x

4#pr‘agma HLS INTERFACE ap_vld pOI"‘t=X # HLS INTERFACE ap_\.fld port=x

5 #pragma HLS RESOURCE variable=c core=RAM_1P_BRAM %' Shift_Accum_Loop
static data_t shift_reg[N];
acc_t acc;

int i;

m

S WD 0O~ O

acc=0;
Shift_Accum_Loop: for (i=N-1;i»=0;i--) { 4
< 10 3

[z}

Figure 2-23: 1/0 Directives for solution2
14. Click the Run C Synthesis toolbar button to synthesize the design.

15. When prompted, click Yes to save the contents of the C source file. Adding the
directives as pragmas modified the source code.

When synthesis completes, the report file opens automatically.

16. Click the Outline tab to view the Interface results, or simply scroll down to the bottom
of the report file.

Figure 2-24 shows that the ports now have the correct I/O protocols.
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Step 3: Analyze the Results
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Figure 2-24:

Protocol
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Source Object
fir
fir
fir

C Type
return value
return value
return value
return value
return value
return value

pointer
pointer
array
array
array
scalar
scalar

1/0 Protocols for solution2

m

Before optimizing the design, it is important to understand the current design. It was shown
in Lab 1 how the synthesis report can be used to understand the implementation. However,
the Analysis perspective provides greater detail in an inter-active manner.

Follow the steps below to show the Analysis perspective as shown in Figure 2-25.

1. Click the Analysis perspective button.

2. Click the Shift_Accum_Loop in the Schedule Viewer window to expand it.

» The Chapter 6, Design Analysis tutorial provides a more complete understanding of the
Analysis perspective, but the following explains what is required to create the smallest
and fastest RTL design from this source code.

« The left column of the Performance pane view shows the operations in this module of

the RTL hierarchy.

« The top row lists the control states in the design. Control states are the internal states

High-Level Synthesis uses to schedule operations into clock cycles. There is a close

correlation between the control states and the final states in the RTL Finite State
Machine (FSM), but there is no one-to-one mapping.
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Schedule Viewer | Resource Wiewer

Figure 2-25: Solution2 Analysis Perspective: Performance

Some of the objects here correlate directly with the C source code. Right-click the object to
cross-reference with the C code.

The design starts in the first state with a read operation on port x.

In the next state, it starts to execute the logic created by the for-loop
Shift Accum_Loop. Loops are shown in grey, and you can expand or collapse them.

In the first state, the loop iteration counter is checked: addition, comparison, and a
potential loop exit.

There is a one-cycle memory read operation on the block RAM synthesized from array
data.

There is a memory read on the c port.
The multiplication operation takes 1 cycles to complete.
The for-loop is executed 11 times.

At the end of the final iteration, the loop exits in Control Step 1 and the write to porty
occurs.

You can also use the Analysis perspective to analyze the resources used in the design.

3. Click the Resource view, as shown in Figure 2-26.

4. Expand all the resource groups.
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Operation\Control Step

~ [+]I/O Ports
X rear]
Y write | |
c(p) rearl
~w [+]Memory Ports
shift_reg(p0) write write ]
<(p0) [ repd
w [+]Expressions
i_0_phi_fu_120 nhi mux
acc_0_phi_fu_107 nhi mux
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mul_In71_fu_173 *

Figure 2-26: Solution2 Analysis Perspective: Resource

Figure 2-26 shows:

« Thereis aread on port x and a write to port y. Port c is reported in the memory section
because this is also a memory access (the memory is outside the design).

» There is a single pipelined multiplier used in this design.

« One of the adders is being shared: there are two instances of the adder on one row.
With the insight gained through analysis, you can proceed to optimize the design.

Before concluding the analysis, it is worth commenting on the multicycle multiplication
operations, which require multiple DSP48s to implement. The source code uses an int
data-type. This is a 32-bit data-type that results in large multipliers. A DSP48 multiplier is
18-bit and it requires multiple DSP48s to implement a multiplication for data widths greater
than 18-bit.

The Arbitrary Precision Types tutorial shows how you can create designs with more suitable
data types for hardware. Use of arbitrary precision types allows you to define data types of
any arbitrary bit size (more than the standard C/C++ 8-, 16-, 32- or 64-bit types).

Step 4: Optimize for the Highest Throughput (Lowest Interval)
The two issues that limit the throughput in this design are:

« The for loop. By default loops are kept rolled: one copy of the loop body is
synthesized and re-used for each iteration. This ensures each iteration of the loop is
executed sequentially. You can unroll the for loop to allow all operations to occur in
parallel.

¢ The block RAM used for shift reg. Because the variable shift regis an array in
the C source code, it is implemented as a block RAM by default. However, this prevents
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its implementation as a shift-register. You should therefore partition this block RAM
into individual registers.

Begin by creating a new solution.

1. Click the Synthesis perspective button.

oA W

previous solutions.

Click the New Solution button.
Leave the solution name as solution3.

Click Finish to create the new solution.

In the Project menu, select Close Inactive Solution Tabs to close any existing tabs from

The following steps, summarized in Figure 2-27 explain how to unroll the loop.

@ firc 3 ED Synthesis(solution2)(fir]

4 gpragma HLS INTERFACE ap vl
5 #pragma HLS RESOURCE variab)

static data_t shift_reg[N
acc_t acc;

data_t data;

int i;

shift_reg[@]=x;
data = x;
} else {
shift_reg[i]=sh
data = shift_re

acc+=data*c[i];;

L S Y R N R~ == TR I W R S WY I =~ T B = e Y

"] Vivade HLS Directive Editor X |G Outline | (14 Directive 3 - g
N v @ fir
Directive
=y
UNROLL il # HLSINTERFACE ap_vld port=y
o @ c
bt # HLS RESOURCE variable=c core=RAM_1P_BRAM
() Source File @ x
(®) Directive File # HLS INTERFACE ap_vld port=x
S #[1 shift_reg
phions %' Shift_Accum_Loop
skip_exit_check {optional): []
region (optional): O
Figure 2-27: Unrolling FOR Loop

6. Click in the £ir.c file, then in the Directive tab, select loop Shift_Accum_Loop.

in the Directive tab.

IMPORTANT: Reminder: the source code must be open in the Information pane to see any code objects

7. Right-click and select Insert Directive.

8. From the Directive drop-down menu, select Unroll.

Leave the Destination as the Directive File.

When optimizing a design, you must often perform multiple iterations of optimizations to
determine what the final optimization should be. By adding the optimizations to the
directive file, you can ensure they are not automatically carried forward to the next solution.
Storing the optimizations in the solution directive file allows different solutions to have
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different optimizations. Had you added the optimizations as pragmas in the code, they
would be automatically carried forward to new solutions, and you would have to modify the
code to go back and re-run a previous solution.

Leave the other options in the Directives window unchecked and blank to ensure that the
loop is fully unrolled.

9. Click OK to apply the directive.

10. Apply the directive to partition the array into individual elements.
a. In the Directive tab, select array shift_reg.
b. Right-click and select Insert Directive.
c. Select Array_Partition from the Directive drop-down menu.
d. Specify the type as complete.
e. Select OK to apply the directive.

With the directives embedded in the code from solution2 and the two new directives just
added, the directive pane for solution3 appears as shown in Figure 2-28.

5= Outline | (4 Directive &3 * = 04

v @ fir
-y
# HLSINTERFACE ap_vld port=y
® c
# HLS RESOURCE variable=c core=RAM_1P_BRAM
® x
# HLSINTERFACE ap_vld port=x
#[1 shift_reg
Ofp HLS ARRAY_PARTITION variable=shift_reg complete dim=1
~w 2" Shift_Accum_Loop
O HLS UNROLL

Figure 2-28: Solution3 Directives

In Figure 2-28, notice the directives applied in solution2 as pragmas have a different
annotation (#HLS) than those just applied and saved to the directive file (%HLS). You can
view the newly added directives in the Tcl file, as shown next.

11.In the Explorer pane, expand the Constraint folder in Solution3 as shown in
Figure 2-29.

12. Double-click the solution3 directives.tcl file to openitin the Information pane.
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I’ Explorer &3 t;)ct‘ = 8 ||[4 firc £l Synthesis(selution2)(fir_csynth.rpt) < directives.tel 2 = 8
- 'ID'C ﬁr_prj 1 :. ............................................................
il Includes 2 -1:1; This file is gemla'afl:ed gutomatically by Vivado HLS.
= ¢ 3 ## Please DO NOT edit it.
Vv 5 20urce 4 #% Copyright (C) 1986-2819 Xilinx, Inc. All Rights Reserved.
@fir.c G S R e B R B e
fiz Test Bench 6 set_directive_unroll "fir/Shift_Accum_Loop”
£3 solutiond 7 set_directive_array_partition -type complete -dim 1 "fir" shift_reg
3 solution2 g

w Y= solution3
~ &8 constraints
% directives.tcl
S script.tcl

Figure 2-29: Solution3 Directives.tcl File

13. Click the Synthesis toolbar button to synthesize the design.
When synthesis completes, the synthesis report automatically opens.

14. Compare the results of the different solutions. Click the Compare Reports toolbar
button.

Alternatively, use Project > Compare Reports.

15. Add solutionl, solution2, and solution3 to the comparison.
16. Click OK.
Figure 2-30 shows the comparison of the reports. solution3 has the smallest initiation

interval and can process data much faster. As the interval is only 11, it starts to process a
new set of inputs every 11 clock cycles.
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All Compared Solutions
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solution: xcvudp-figh2104-1-e
solutiond: xcvudp-figh2104-1-e

solution3: xcvudp-figh2104-1-e

Performance Estimates

= Timing (ns)
Clack solution] | solution2 | solution3
ap_clk | Target 10.00 10.00 10.00
Estimated | 5.772 6.339 7.918

= Latency (clock cycles)

solution] | solution2 | solution3
Latency | min | 34 34 1
max | 34 34 1
Interval | min | 34 34 1
max | 34 34 1

Utilization Estimates

solutionl | solutiond | solution3
BRAM_18K | O 0 0
DSP42E 3 3 33
FF 175 208 557
LUT 196 234 699
URAM 0 0 0

Figure 2-30: Comparison of Lab3 Solutions

Itis possible to perform additional optimizations on this design. For example, you could use
pipelining to further improve the throughput and lower the interval. The Chapter 7, Design
Optimization tutorial provides details on using pipelining to improve the interval.

As mentioned earlier, you could modify the code itself to use arbitrary precision types. For
example, if the data types are not required to be 32-bit int types, you could use bit accurate

types (for example, 6-bit, 14-bit, or 22-bit types), provided that they satisfy the required
accuracy. For more details on using arbitrary precision type see the Chapter 5, Arbitrary

Precision Types tutorial.
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Conclusion

In this tutorial, you learned how to:

« Create a Vivado High-Level Synthesis project in the GUI and Tcl environments.
« Execute the major steps in the HLS design flow.
« Create and use a Tcl file to run Vivado HLS.

« Create new solutions, add optimization directives, and compare the results of different
solutions.
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Chapter 3

C Validation

Overview

Validation of the C algorithm is an important part of the High-Level Synthesis (HLS) process.
The time spent ensuring the C algorithm is performing the correct operation and creating
a C test bench, which confirms the results are correct, reduces the time spent analyzing
designs that are incorrect "by design” and ensures the RTL verification can be performed
automatically.

This tutorial consists of three lab exercises.

Lab 1 Description

Reviews the aspects of a good C test bench, the basic operations for C validation and the C
debugger.

Lab 2 Description

Validates and debugs a C design using arbitrary precision C types.

Lab 3 Description

Validates and debugs a design using arbitrary precision C++ types.

Tutorial Design Description

You can download the tutorial design file from the Xilinx website. See the information in
Locating the Tutorial Design Files.

This tutorial uses the design files in the tutorial directory
Vivado HLS Tutoriall\C Validation.

The sample design used in this tutorial is a Hamming Window FIR. There are three versions
of this design:
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« Using native C data types.
« Using ANSI C arbitrary precision data types.

« Using C++ arbitrary precision data types.

This tutorial explains the operation and methodology for C validation using High-Level
Synthesis. There are no design goals for this tutorial.

Lab 1: C Validation and Debug

Overview

This exercise reviews the aspects of a good C test bench and explains the basic operations
of the High-Level Synthesis C debug environment.

IMPORTANT: The figures and commands in this tutorial assume the tutorial data directory

i? Vivado HLS Tutorial is unzipped and placed in the location C:\Vivado HLS_ Tutorial. If the
tutorial data directory is unzipped to a different location, or on Linux systems, adjust the few
pathnames referenced, to the location you have chosen to place the Vivado HLS Tutorial
directory.

Step 1: Create and Open the Project

1. Open the Vivado HLS Command Prompt.

o On Windows use Start > All Programs > Xilinx Design Tools > Vivado 2020.1 >
Vivado HLS > Vivado HLS 2020.1 Command Prompt.

o On Linux, open a new shell.

2. Using the command prompt window (Figure 3-1), change the directory to the C
Validation tutorial, lab1.

3. Execute the Tcl script to setup the Vivado HLS project, using the command vivado hls
-f run hls.tcl as shown in Figure 3-1.

C:\Uivado_HLS_Tutorial>cd C_Ualidation

C:\Uivado_HLS_Tutorial:C_Ualidation>cd labl

4 (M

C:\Uivado_HLS_Tutorial\C_Ualidation\labl1>vivado_hls -f run_hls.tcl

Figure 3-1: Setup the Tutorial Project

4. When Vivado HLS completes, open the project in the Vivado HLS GUI using the
command vivado_hls -p hamming window prj as shown in Figure 3-2.
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@I [APCC-3] Tmp directory is apcc_db -
@I [APCC-1] APCC is done.
@I [LIC-101] Checked in feature [HLS]
Generating csim.exe
Running DUT. . .done.
Testing DUT results

@I [SIM-1] CSim done with O errors.
@I [LIC-101] Checked in feature [HLS]

4 [

C:\Uivado_HLS_Tutorial:C_Ualidation\labl>vivado_hls -p hamming_window_prj

Figure 3-2: Initial Project for C Validation Lab 1

Step 2: Review Test Bench and Run C Simulation

1. Open the C test bench for review by double-clicking hamming window test.cinthe
Test Bench folder (Figure 3-3).

[t5 Explorer &2 ¢ = B g hamming_window_test.c &2 =0
4 1= hamming_window_prj 73 // Check the results returned by DUT against expected va *
- [ Includes fp=Ffopen("result.dat","w");

printf("Testing DUT results");

for (i = 0; i < WINDOW_LEN; i++) {

77 fprintf(fp, "%d %d \n", hw_result[i],sw_result[i]);
78 if (hw_result[i] !=s sw_result[i]) {

79 err_cnt++;

check_dots = @;

printf("\n!!! ERROR at i = %4d - expected: %10d\tg

Source
4 = Test Bench

lel hamming_window_test.c
a = solution1

I

4 % constraints
4 directives.tcl

W scripttcl i, sw_result[i], hw_result[i]);
4 = csim } else { // indicate progress on console
. &= build if (check_dots == @)
. & report printf("\n");

printf(".");
if (++check_dots == 64)
check_dots = @;
}

¥
fclose(fp);
printf("\n");

// Print final status messa
if (err_cnt) {

printf("!!! TEST FAILED - %d errors detected !!!\n",
} else

printf("*** Test Passed ***\n");

gg
ge

m

// Only return @ on success
return err_cnt;

4 11} I

Figure 3-3: C Test Bench for C Validation Lab 1

A review of the test bench source code shows the following good practices:
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« The test bench:
- Creates a set of expected results that confirm the function is correct.
o Stores the results in array sw_result.

« The Design Under Test (DUT) is called to generate results, which are stored in array
hw_result. Because the synthesized functions use the hw_result array, it is this
array that holds the RTL-generated results later in the design flow.

« The actual and expected results are compared. If the comparison fails, the value of
variable err cnt is set to a non-zero value.

« The test bench issues a message to the console if the comparison failed, but more
importantly returns the results of the comparison. If the return value is zero the test
bench validates the results are good.

This process of checking the results and returning a value of zero if they are correct
automates RTL verification.

You can execute the C code and test bench to confirm that the code is working as expected.

2. Click the Run C Simulation toolbar button to open the C Simulation Dialog box, shown
in Figure 3-4.

¢ CSimulation Dialog @

C Simulation

bl

Options
Launch Debugger
Build Only
Clean Build

Optimizing Compile

Input Arguments

Do not show this dialog box again.

[ Ok l | Cancel |

Figure 3-4: Run C Simulation Dialog Box
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3. Select OK to run the C simulation.
As shown in Figure 3-5, the following actions occur when C simulation executes:

« The simulation output is shown in the Console window.

« Any print statements in the C code are echoed in the Console window. This example
shows the simulation passed correctly.

« The C simulation executes in the solution subdirectory csim. You can find any output
from the C simulation in the build folder, which is the location at which you can see the
output file result.dat written by the fprintf command highlighted in Figure 3-5.

Because the C simulation is not executed in the project directory, you must add any data
files to the project as C test bench files (so they can be copied to the csim/build
directory when the simulation runs). Such files would include, for example, input data read
by the test bench.

[ty Explorer 2 w* = O]/ [¢ hamming_window_test.c 2 =0
fprintf(fp, "%d %d \n", hw_result[i],sw _result[i]);*

check_dots = @;
printf("\n!!! ERROR at i = %4d - expected: %1@d\
82 i, sw_result[i], hw_result[i]);

= Test Bench
[¢ hamming_window_test.c
= solution1

=5 hamming_window_prj 77
@l Includes 78 if (hw_result[i] != sw_result[i]) {
£ Source 79 err_cnt++;
80
81

83 } else { // indicate progress on console
& constraints 84 if (check_dots == @)
W directives.tcl 85 printf("\n");
W scripticl 86 printf(".");
= csim 87 if (++check_dots == 64)
& build Si check_dots = @;
[ apcclog gé y b
csim.exe 1  fclose(fp);
csim.mk 92 printf("\n"};
= Makefile.rules 93
2 result.dat 94 // Print final status message 3
; 95 if (err_cnt) {
# rL_Jn_5|m.th 96 printf("!!! TEST FAILED - %d errors detected !!!\n"
= sim.bat 97 } else
& apcc_db 98 printf("*** Test Passed ***\n"); -
&= obj Il n 3
= report

El Console &2 . 9] Errors| & Warnings
<terminated= hamming_window_prj.Debug [C/C++ Application] C\Vivado_HLS_Tutorial\
Testing DUT results

**% Test Passed ***
4

Figure 3-5: C Simulation Results

Step 3: Run the C Debugger

A C debugger is included as part of High-Level Synthesis.
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1. Click the Run C Simulation toolbar button to open the C Simulation Dialog box.

2. Select the Launch Debugger option as shown in Figure 3-6.

3. Click OK to run the simulation.

¢ CSimulation Dialog

C Simulation

bl

Options
¥ | Launch Debugger

Build Only
Clean Build

Optimizing Compile

Input Arguments
Do not show this dialog box again.
[ OK l | Cancel |
Figure 3-6: C Simulation Dialog Box

The Launch Debugger option compiles the C code and then opens the Debug environment,
as shown in Figure 3-7. Before proceeding, note the following:

« Highlighted at the top-right in Figure 3-7, you can see that the perspective has
changed from Synthesis to Debug. Click the perspective buttons to return to the
synthesis environment at any time.

« By default, the code compiles in debug mode. The Launch Debugger option
automatically opens the debug perspective at time 0, ready for debug to begin. To
compile the code without debug information, select the Optimizing Compile option in
the C Simulation dialog box.
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¢ Vivado HLS - hamming_window_prj (C:\Vivado_HLS_Tutorial\C_Validation\labl\hamming_window_prj)
File Edit Project |Solution| Run Window Help

AN Bl BiSimE Biwi®
15 Debug & ng.Exp\crerI ?|i# = = O |- Variables 2
4 [€] hamming_window_prj.Debug [C/C++ Application]
4 i csim.exe [4456] Name

4 @ Thread [1] 0 (Suspended : Breakpoint) = argc
= main() at hamming_window_test.c:54 0x40139d * argv
wi gdb (* test_data
(*= hw_result

[£l hamming_window_test.c 2
2#Vendor: Xilinx [J
45 #include <stdio.h>
47 #include "hamming_window.h"
48
49-int main(int argc, char *argv[])

50 {
=4

hamming_window_csim.log

51 in_data_t test_data[WINDOW_LEN];

52 out_data_t hw_result[WINDOW_LEN], sw_result[WINDOW_LEN];
53 int i;

® 54 unsigned err_cnt = @, check dots = @;

55 FTIF *fn-

4

&) Tasks| (21 Problems | @ Executables| 0 Memor;;
hamming_window_prj.Debug [C/C++ Application] csim.exe

B Console &2

®e Breakpoints| iiii Regist
Type

int

char **
in_data_t [256]

out_data_t [256]

=8 Eol %=
%= Debug ||| Synthesis &« Analysis
ers| “x !

% e
Value =
1 =

Oxa54f80

0x28fd0c
0x28f90c¢ -

»
82 Outline 22 =g
vEERERY o % ¥
U stdioh

Y hamming_window.h
® main(int, char*[]) : int

Figure 3-7: The HLS Debug Perspective

You can use the Step Into button (Figure 3-8) to step through the code line-by-line.

i L]

Figure 3-8: The Debug Step Into Button

Expand the Variables window to see the sw_result array.

Expand the sw_result array to the view shown in Figure 3-9.

Click the Step Into button (or key F5) repeatedly until you see the values being updated

in the Variables window.

High-Level Synthesis
UG871 (v2020.1) August 7, 2020

www.Xxilinx.com

| Send Feedback I

50


https://www.xilinx.com
https://www.xilinx.com/about/feedback/document-feedback.html?docType=Tutorials&docId=UG871&Title=Vivado%20Design%20Suite%20Tutorial&releaseVersion=2020.1&docPage=50

(: X”_INX® Chapter 3: C Validation

45 Debug 2 [ Explorer i+ ¥ = O |- Variables 2 . % Breakpoints !if Registers| ¢ Expressions =\ Modules = 8
4[] hamming_window_prj.Debug [C/C++ Application] = \ \ it =
4 il csim.exe [3808] Name Type Value =
4  Thread [1] O (Suspended : Step) - (= hw_result out_data_t [256] 0x2890c 3
= main() at hamming_window_test.c:57 0x4014a9 4 (= gw_result out_data_t [256] 0x28750c
# gdb 4 [ [0..99] out_data_t [100] O0x28f50c
)= sw_result[0] out_data_t -42923460
9= sw_result[1] out_data_t -37643710
)= sw_result[2] out_data_t -32413106
6= sw_result[3] out_data_t 302692880 i
4 » ]
[€] hamming_window_test.c &2 = hamming_window_csim.log = B |[B= Outline 2 = g
- ElE R e ¥ T
for (1 = @; 1 < WINDOW LEN; i++) { = stdioh

// Generate a test pattern for input to DUT
test_data[i] = (in_data_t)((32767.8 * (double)((i % 16) - 8) / 8.9) + 8.5); o main(int, char (]} : int
// Calculate the coefficient value for this index ' o
in_data_t coeff_val = (in_data_t)(WIN_COEFF_SCALE * (8.54 -

0.46 * cos(2.0 * M PI * i / (double)(WINDOW_LEN - 1))));
// Generate array of expected values -- n.b. explicit casts to avoid
// integer promotion issues T

L

W hamming_window.h

Figure 3-9: Analysis of C Variables

In this manner, you can analyze the C code and debug it if the behavior is incorrect.

For more detailed analysis, to the right of the Step Into button are the Step Over (F6), Step
Return (F7) and the Resume (F8) buttons.

7. Scroll to line 70 in the hamming window_test.c file.

8. Place the cursor in the left-hand margin on line 70, right-click with the mouse button
and select Toggle Breakpoint. A breakpoint (blue dot) is indicated in the margin, as
shown in Figure 3-10.

9. Activate the Breakpoints tab, also shown in Figure 3-10, to confirm there is a breakpoint
set at line 70.

10. Click the Resume button (highlighted in Figure 3-10) or the F8 key to execute up to the
breakpoint.
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I R : { = L:&: R i ® :E’DEbLll + | Synthesis &< Analysis

% Debug = (5 Explorer i+ = = O |[= Variableq| ® Breakpoints &2 | ¥ii Registers| 47 Expressions| = Modules - 0
4 [€] hamming_window_prj.Debug [C/C++ Application] &

x & wBES ¥
4 {8 csim.exe [3808] v |« hamming_window_test.c [line; 69]
4 o Thread [1] 0 (Suspended : Step)
= main() at hamming_window_test.c:57 0x4014a9
wi gdb
l< hamming_window_test.c &2 hamming_window_csim.log = B |[8 Outline 2 = 0
sw_result[i] = (out_data_t)test_data[i] * (out_data_t)coeff_val; - SR e % T
}

H stdio.h
™ hamming_window.h

e // Call the DUT g
‘ : A e
| printf("Running DUT..."); maki(int, Ciar'll

hamming_window(hw_result, test_data);
printf("done.\n");

// Check the results returned by DUT against expected wvalues 2
Figure 3-10: Using Breakpoints

11. Click the Step Into button (or key F5) multiple times to step into the hamming window
function.

12. Click the Step Return button (or key F7) to return to the main function.

13. Click the red Terminate button to end the debug session.

You can use the Run C simulation button to restart the debug session from within the
Debug perspective.

14. Exit the Vivado HLS GUI and return to the command prompt.

Lab 2: C Validation with ANSI C Arbitrary Precision
Types

Introduction

This exercise uses a design with arbitrary precision C types. You will review and debug the
design in the GUI.

Step 1: Create and Open the Project

1. From the Vivado HLS command prompt used in Lab 1, change to the 1ab2 directory, as
shown in Figure 3-11.

2. To create a new Vivado HLS project, type vivado _hls -f run hls.tcl.
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C:\Wivado_HLS_Tutorial\C_Ualidation\labl>cd

C:\Wivado_HLS_Tutorial\C_Ualidation>cd lab2

C:\Vivado_HLS_Tutorial:\C_Ualidation\lab2>vivado_hls -f run_hls.tcl

Figure 3-11: C Validation for Arbitrary Precision Types Lab
3. To open the Vivado HLS GUI project, type vivado _hls -p hamming window prj.

4. Open the Source folder in the Explorer pane and double-click hamming window.c to
open the code, as shown in Figure 3-12.

[ Explorer &3 ¢ = B [g hamming_window.c &2 =8
4 25 hamming_window_prj 45 #include "hamming_window.h" // Provides default WINDOW_LEN if no =
[k Includes 46 - o o .
4 S Source 47 // Translation module function prototypes:
- : : 48 static void hamming_rom_init(in_data_t rom_array[])};
lel hamming_window.c 49
= Test Bench 50 // Function definitions:
4 (= solution1 51void hamming_window(out_data t outdata[WINDOW_LEN], in_data t in
4 % constraints 524 L
% directives.tcl 53 static in_data_t window_coeff[WINDOW_LEN]; [
% scripticl 54 unsigned i;
. 55
= eim 56 // In order to ensure that 'window coeff' is inferred and pro
57 // initialized as a ROM, it is recommended that the arrva

4 11} I

Figure 3-12: C Code for C Validation Lab 2

5. Hold down the Ctrl key and click hamming window.h on line 46 to open this header
file.

6. Scroll down to view the type definitions (Figure 3-13).

lel hamming_window.c T hamming_window.h &2 =8

[¢

TG —CrTe LT O o O e COCtrerTe T CoT E o

integer, which may be interpreted as a

J o= =] ~] o o

intle_t in_data_t;
int32_t out_data_t;
73 #include "ap_cint.h"
74 typedef intl6 in_data_t;
75 typedef int32 out_data_t;

77void hamming_window(out_data_t outdata[], in_data_t indata[]);

79 #endif // HAMMING_WINDOW_H_ not defined

80 %

m

4 11} I

Figure 3-13: Type Definitions for C Validation Lab 2
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In this lab, the design is the same as Lab 1, however, the types have been updated from the
standard C data types (int16_t and int32_t) to the arbitrary precision types provided by
Vivado High-Level Synthesis and defined in header file ap_cint.h.

More details for using arbitrary precision types are discussed in the Chapter 5, Arbitrary
Precision Types tutorial. An example of using arbitrary precision types would be to change
this file to use 12-bit input data types: standard C types only support data widths on 8-bit
boundaries.

This exercise demonstrates how such types can be debugged.

Step 2: Run the C Debugger

1. Click the Run C Simulation toolbar button to open the C Simulation Dialog box.
2. Select the Launch Debugger option.
3. Click OK to run the simulation.

The warning and error message shown in Figure 3-14 appears.

The message in the console pane and log file indicate you cannot debug the arbitrary
precision types used for ANSI C designs in the debug environment.

ﬁ IMPORTANT: When working with arbitrary precision types you can use the Vivado HLS debug
environment only with C++ or SystemC. When using arbitrary precision types with ANSI C,the debug
environment cannot be used. With ANSI C, you must instead use printf or fprintf statements for
debugging.
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2@E [SIM-34] C:/Xilinx/Vivado HL5/2815.3/inclu

> wl Includes . " - ? "
3@E [SIM-1] CSim file generation failed: compi

4 S Source

4
[& hamming_window.c
> = Test Bench
4 Y= solution1
4 4 constraints
‘5& diré(iist.tcl | Message Dialog @
Tk scriptic
4 (= csim Vivado HLS C Simulation could not complete...
> & build Please check the error and warning messages:
- (= report - There are 2 errors
4 = impl
> B ip ["] Do not show this dialog box again.
- = verilog
o
4 (= sim q ‘7

» (= autowrap

4 Vivado HLS - hamming_window_prj (C:\Vivado_HLS_Tutorial\C_Validation\lab2\hamming_window_prj) [ol@m| =]

File Edit Project Solution Window Help

g & EX R S B Er-Z@ A 601 *ﬁDebugHAnalysis

[ Explorer 52 = O | [ hamming_window. =/ hamming_window_ &2 2 = O |[B Outline = I Directive @« Y= 0
4 2% hamming_window_prj 1 Compiling ../../../../hamming_window_test. » An outline is not available.

. & report 2 Console 2 . %] Errors| @& Warnings|  Man Page %= MB-yri =0
B tv Vivado HLS Console
- & verilog while exgcutiﬂg ‘ ) ) ) ‘ ) ) ) -
_ "source C:/Vivado_HLS_Tutorial/C_Validation/lab2/hamming_window_prj/solutionl/csim.tcl"
> = wrapc . . -
i invoked from within
b & wrapc_pc "hls::main C:/Vivado_ HLS_Tutorial/C_Validation/lab2/hamming_window_prj/solutionl/csim.tcl”
4 = syn ("uplevel” body line 1)
» = report invoked from within
» (= systemc "uplevel 1 hls::main {*}$args”
. & verilog (procedure "hls_proc" line 5)
. & vhdl invoked from within
"hls_proc gargv"
@I [LIC-101] Checked in feature [HLS] |:‘
< | ]
Figure 3-14: C Simulation Dialog Box
4. Select the Explorer pane.
5. Expand the Test Bench folder in the Explorer pane.
6. Double-click the file hamming window test.c.
[t Explorer 52 " = B[ g hamming_window.c <) *hamming_window_test.c &3 =0
=5 hamming_window_prj &
il Includes // Check the results returned by DUT against expected values
S Source fp=fopen("result.dat","w");

printf("Testing DUT results");
for (i = @; i < WINDOW LEN; i++) {
fprintf(fp, "%d %d \n", hw_result[i],sw_result[i])};
brin‘tf("DuT results: Sample=¥d, DUT=%d, Expected=¥d\n", i, hw_result[i],sw result[i]);
if (hw_result[i] != sw_result[i]) {
err_cnt++;
check_dots = @;
printf("\n!!! ERROR at i = ¥4d - expected: ¥l@d\tgot: %1ed",

[& hamming_window.c
= Test Bench
[€) hamming_window_test.c
= solution1
& constraints
W directives.tcl

};?_scrlpt.tcl i, sw_result[i], hw_result[i]);
& csim } else { // indicate progress on console

= build if (check _dots == @)

& report printf("\n");

printf(".");

Figure 3-15: Enable Printing of the Results
7. Save the file.
8. Select the Synthesis button.

|.m

9. Click the Run C Simulation toolbar button or the menu Project > Run C Simulation to

open the C Simulation Dialog box.
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10. Ensure the Launch Debugger option is not selected.

11. Click OK to run the simulation.

The results appear in the console window (Figure 3-16).

El Console &2 . @) Errors| & Warnings X pEE—O
<terminated= hamming_window_prj.Debug [C/C++ Application] C\Vivado_HLS_Tutorial\C_Validation\lab2\hamming_win
.DUT results: Sample=252, DUT=21807104, Expected=21807104 -

.DUT results: Sample=253, DUT=27011801, Expected=27011801
.DUT results: Sample=254, DUT=32266975, Expected=32266975
.DUT results: Sample=255, DUT=37559018, Expected=37559010

**% Test Passed ***

4 [m

Figure 3-16: C Validation Lab 2 Results

12. Exit the Vivado HLS GUI and return to the command prompt.

Lab 3: C Validation with C++ Arbitrary Precision
Types

Overview

This exercise uses a design with arbitrary precision C++ types. You will review and debug
the design in the GUI.

Step 1: Create and Open the Project

1.

2
3.
4

High-Level Synthesis

From the Vivado HLS command prompt used in Lab 2, change to the 1ab3 directory.
Create a new Vivado HLS project by typing vivado _hls -f run hls.tcl.
Open the Vivado HLS GUI project by typing vivado _hls -p hamming window_ prj.

Open the Source folder in the Explorer pane and double-click hamming window.cpp
to open the code, as shown in Figure 3-17.
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[ Explorer &3 & = O|[¢ hamming_window.cpp & =0
4 25 hamming_window_prj 45 #include "hamming_window.h" // Provides default WINDOW_LEN if 1=
» ki Includes 46 . .
=g 47 // Translation module function prototypes:
4 = Source . . . A,
- - 48 static void hamming_rom_init(in_data_t rom_array[]);
[¢ hamming_window.cpp 19
’ &QTEEtSench 50 // Function definitions:
4 {= solution1 51void hamming_window(out_data_t outdata[WINDOW_LEN], in_data_t :
4 # constraints 524 X
< directives.tcl 53  static in_data_t window_coeff[WINDOW_LEN]; ‘:‘
W scripticl 22 unsigned 1i;
» = csim o

56 // In order to ensure that "window_coeff' is inferred and pi
57 // initialized as a ROM, it is recommended that the arrya i1

—
co Fd bhm Amomm aem m mwabn Liiimmd s men amdb T mbnd  Fovnd bl mmiiinmm L.

< | il P

Figure 3-17: C++ Code for C Validation Lab 3

5. Hold down the Ctrl key down and click hamming window.h on line 46 to open this
header file.

6. Scroll down to view the type definitions (Figure 3-18).

l¢ hamming_window.cpp | hamming_window.h &3 =0
70 // This function applies an Hamming window function to the "ini=+
71// returning the windowed data in 'outdata'. The coefficients

72 // scaled integer, which may be interpreted as a signed fixed |
73// with WIN_COEFF_FRACBITS bits after the binary point.

74
75/ /typedef intl6_t in_data_t;
76 //typedef int32_t out_data_t;
77 #include "ap_int.h"
78 typedef ap_int<l6> in_data_t;
79 typedef ap_int<32> out_data_t;
20
81void hamming_window(out_data_t outdata[], in_data_t indata[]); E‘
82 n
07 Mawmds £ F VIARMTRI, LITRIDWME 1) ot ALl
< | il P

Figure 3-18: Type Definitions for C Validation Lab 3

Note: In this lab, the design is the same as in Lab 1 and Lab 2, with one exception. The design is now
C++ and the types have been updated to use the C++ arbitrary precision types, ap_int<#N>,
provided by Vivado HLS and defined in header file ap_int.h.

Step 2: Run the C Debugger

1. Click the Run C Simulation toolbar button to open the C Simulation Dialog box.
2. Select the Launch Debugger option.
3. Click OK.

The debug environment opens.

4. Select the hamming window.cpp code tab.
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5. Set a breakpoint at line 62 in the hamming window. cpp file as shown in Figure 3-19.

6. Click the Resume button (or press the F8 key) to execute the code up to the breakpoint.

35 Debug & ™[5 Explorer [i# = = O |[to-Variables % Breakpoin 52 “._!i Registers| ¢ Expressio |® Modules] = O
4[] hamming_window_prj.Debug [C/C++ Application] iR & W EBES <
4 (¥ csim.exe [3740] «e hamming_window.cpp [line: 61]

4 @ Thread [1] 0 (Suspended : Breakpoint)
= main() at hamming_window_test.cpp:50 0x4013a2

»l gdb
[¢] hamming_window.cpp £2 hamming_window.h [€] hamming window_test.cpp = O |[5 Outline = = 8
// In order to ensure that 'window_coeff' is inferred and properly - FE AR 0% T
// initialized as a ROM, it is recommended that the array initialization U hamming_window.h

// be done in a sub-function with global (wrt this source file) scope.

- L ° ; ++*% hamming_rom_init(in_data_t[]) : v
hamming_rom_init(window_coeff);

@ hamming_window{out_data_t[], ir
for (i = @; i < WINDOW_LEN; i++) { % hamming_rom_init{in_data_t[]) : v
2 #pragma AP pipeline
outdatal[i] = (out data t)window coeff[i] * (out data t)indatal[i];
¥
} -
4

' <[ 11 b

m

Figure 3-19: Debug Environment for C Validation Lab 3

7. Click the Step Into button (or press the F5 key) twice to see the view in Figure 3-20.

The variables in the design are now C++ arbitrary precision types. These types are defined
in header file ap_int.h. When the debugger encounters these types, it follows the
definition into the header file.

As you continue stepping through the code, you have the opportunity to observe in greater
detail how the results for arbitrary precision types are calculated.

[¢/ hamming_window.cpp | hamming_window.h | ap_inth &3 =0
50 INLINE ap_int(const volatile ap_int<_AP_W2> &op):Base((const ap private<_A

52 template<int _AP_W2> E
53 INLINE ap_int(const ap_int<_AP_W2> &op):Base((const ap private<_AP_W2,true

55 template<int _AP_W2:>
56 INLINE ap_int(const ap_uint<_AP_W2> &op):Base((const ap_private<_AP_lW2,fal

58 template<int _AP_W2:>
59 INLINE ap_int(const volatile ap_uint<_AP_W2> &op):Base((const ap_private<_

N

template<int _AP_W2, bool _AP_52>
INLINE ap_int(const ap_range ref<_AP_W2, _AP_S2>& ref):Base(ref) {} -
< 10 3

[=3 0= R

[z}

Figure 3-20: Arbitrary Precision Header File

A more productive methodology is to exit the ap int.h header file and return to view the
results.

8. Click the Step Return button (or press the F7 key) to return to the calling function.

9. Select the Variables tab and expand the ap private variable.
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10. Expand the outdata variable, as shown in Figure 3-21 to see the value of the variable
shown in the VAL parameter.

3% Debug ¥ 5 Explorer i3 Hlaoe eS| ¥ = O||ed- Variables 3 . % Breakpoints| ¥ Registers| 2k Modules =8
[£] hamming_window_prj.Debug [C/C++ Application] <5 @] I=E=0
® CAVivado_HLS_Tutorial\C_Validationlab3\hamming_window_prj\solutit|| Name Type Value -
i Thread [1] 0 (Suspended : Step) 4 # outdata out_data_t * 0x28f4d8
= hamming_window() at hamming_window.cpp:63 0x4017fa 4 (= ap_private<32, trl ap_private<32, true, true.. .}
= main() at hamming_window_test.cpp:69 0x401587 9= mask const uint64_t E
w1 gdb 9= not_mask const uint64_t
09= sign_bit_mask const uinte4_t
0= VAL ap_private<32, true, true... -42923460
» indata in_data_t* 0x28fcd8 <
<[ 11 »
] 1 K] )
[¢ hamming_window.cpp % “_f ap_inth  |f ap_privateh | [€ hamming_window_test.  |™1 = O 8= Outline 2 B R o ~¥70

/4 AniLilglliseu d> d RN, 1L 1S FELUNENUEU Liigl Lne ari'yda Lilitlalizacivin
// be done in a sub-function with global (wrt this source file) scope.
hamming_rom_init(window_coeff);

- & hamming_window.h
45 hamming_rom_init{in_data_t[]) : voi
®  hamming_window(out_data_t[], in_c
for (1 = @; 1 < WINDOW_LEN; i++) { © ® hamming_rom_init(in_data_t[]) : voir
#pragma AP pipeline
outdata[i] = (out_data_t)window_coeff[i] * (out_data_t)indata[i];

m

a4 1L} 3 4 (1) F
Figure 3-21: Arbitrary Precision Variables

Arbitrary precision types are a powerful means to create high-performance, bit accurate
hardware designs. However, in a debug environment, your productivity can be reduced by
stepping through the header file definitions. Use breakpoints and the step return feature to
skip over the low-level calculations and view the value of variables in the Variables tab.

Conclusion

In this tutorial, you learned:

« The importance of the C test bench in the simulation process.
+ How to use the C debug environment, set breakpoints and step through the code.

+ How to debug C and C++ arbitrary precision types.
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Chapter 4

Interface Synthesis

Overview

Interface synthesis is the process of adding RTL ports to the C design. In addition to adding
the physical ports to the RTL design, interface synthesis includes an associated I/0O protocol,
allowing the data transfer through the port to be synchronized automatically and optimally
with the internal logic.

This tutorial consists of four lab exercises that cover the primary features and capabilities of
interface synthesis.

Lab 1 Description

Review the function return and block-level protocols.

Lab 2 Description

Understand the default I/O protocol for ports and learn how to select an I/O protocol.

Lab 3 Description

Review how array ports are implemented and can be partitioned.

Lab 4 Description

Create an optimized implementation of the design and add AXl4 interfaces.

Tutorial Design Description

Download tutorial design file from the Xilinx website. See Locating the Tutorial Design Files.

This tutorial uses the design files in the tutorial directory
Vivado HLS TutoriallInterface Synthesis.
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About the Labs

» The sample design used in the first two labs in this tutorial is a simple one, which helps
the focus to remain on the interfaces.

» The final two lab exercises use a multichannel accumulator.

« This tutorial explains how to implement I/O ports and protocols using High-Level
Synthesis.

* In Lab 4, you create an optimal implementation of the design used in Lab3.

Lab 1: Block-Level 1/O Protocols

Overview

This lab explains what block-level 1/O protocols are and how to control them.

ﬁ IMPORTANT: The figures and commands in this tutorial assume the tutorial data directory
Vivado_HLS_Tutorial is unzipped and placed in the location C:\Vivado_HLS_Tutorial. If the tutorial data
directory is unzipped to a different location, or on Linux systems, adjust the few pathnames referenced,
to the location you have chosen to place the Vivado_HLS_Tutorial directory.

Step 1: Create and Open the Project

1. Open the Vivado HLS Command Prompt.

o On Windows use Start > All Programs > Xilinx Design Tools > Vivado 2020.1 >
Vivado HLS > Vivado HLS 2020.1 Command Prompt.

o In Linux, open a new shell.

2. Using the command prompt window (Figure 4-1), change directory to the Interface
Synthesis tutorial, lab1.

3. Execute the Tcl script to setup the Vivado HLS project, using the command vivado _hls
-f run_hls.tcl, as shown in Figure 4-1.

C:\VUivado_HLS_Tutorial>cd Interface_Synthesis

C:\VUivado_HLS_Tutorial\Interface_Synthesis>cd labl

A ([ 111

C:\Uivado_HLS_Tutorial\Interface_Synthesis\labl>vivado_hls -f run_hls.tcl

Figure 4-1: Setup the Tutorial Project
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4. When Vivado HLS completes, open the project in the Vivado HLS GUI using the
command vivado hls -p adders prj, as shown in Figure 4-2.

10+20+30=60
20+30+40=90
30+40+50=120
40+50+60=150
50+60+70=180

C:\Uivado_HLS_Tutorial\Interface_Synthesis\labl>vivado_hls -p adders_prj

@I [LIC-101] Checked in feature [HLS] -
Generating csim.exe

@I [SIM-1] CSim done with O errors.
@I [LIC-101] Checked in feature [HLS]

A ([ 111

Figure 4-2: Initial Project for Interface Synthesis Lab 1

Step 2: Create and Review the Default Block-Level I/O Protocol

1. Double-click adders.c in the Source folder to open the source code for review

(Figure 4-3).

This example uses a simple design to focus on the I/O implementation (and not the logic in
the design). The important points to take from this code are:

« Directives in the form of pragmas have been added to the source code to prevent any
I/0 protocol being synthesized for any of the data ports (inA, inB and inC). I/O port
protocols are reviewed in the next lab exercise.

« This function returns a value and this is the only output from the function. As seen in
later exercises, not all functions return a value. The port created for the function return
is discussed in this lab exercise.

5 Explorer W T 8
== adders_prj
! Includes
= Source
l¢| adders.c
= Test Bench
= solution1
# constraints
W directives.tcl
U scripttcl
= csim
= build
& report

High-Level Synthesis
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|| adders.c i =0
48int adders(int inl, int in2, int in3) { -
49

50

51// Prevent I0 protocols on all input ports

52 #pragma HLS INTERFACE ap_none port=in3
53 #pragma HLS INTERFACE ap_none port=in2
54 #pragma HLS INTERFACE ap_none port=inl
L= =

56

57 int sum;

58
59 sum = inl + in2 + in3;

60

61 return sum;

m

4 11} I

Figure 4-3: C Code for Interface Synthesis Lab 1
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2. Execute the Run C Synthesis command using the dedicated toolbar button or the
Solution menu.

When synthesis completes, the synthesis report opens automatically.

3. To review the RTL interfaces scroll to the Interface summary at the end of the synthesis
report.

The Interface summary and Outline tab are shown in Figure 4-4.

lc| adders.c =[] Synthesis(solution1)(adders_csynth.rpt) &2 = O ||5% Outline 2 “._[I4 Directive
Interface ~ i=| General Information
w |i=| Performance Estimates
E'@ Timing (ns)
Bits | Protocol | Source Object C Type B Latency (clock cycles)
1 | ap_ctrl_hs adders | return value w || Utilization Estimates
1| ap_ctrl_hs adders | return value E Summary
1 | ap_ctrl_hs adders | return value EIIEI Detail
1 | ap_ctrl_hs adders | return value v I_nterface
ap_return | out 32 | ap_ctrl_hs adders | return value & summary
inl in 32 ap_none inl scalar
in2 in 32 ap_none in2 scalar
in3 in 32 ap_none in3 scalar

Figure 4-4: Interface Summary

There are four types of ports to review:

« The design takes more than one clock cycle to complete, so a clock and reset have been
added to the design: ap_clk and ap_rst. Both are single-bit inputs.

* A block-level I/O protocol has been added to control the RTL design: ports ap_start,
ap_done, ap_idle and ap_ready. These ports will be discussed shortly.

« The design has four data ports.

o Input ports In1, In2, and In3 are 32-bit inputs and have the I/O protocol
ap_none (as specified by the directives in Figure 4-4).

o The design also has a 32-bit output port for the function return, ap return.

The block-level I/0O protocol allows the RTL design to be controlled by additional ports
independently of the data I/O ports. This I/O protocol is associated with the function itself,
not with any of the data ports. The default block-level I/O protocol is called ap _ctrl hs.
Figure 4-5 shows this protocol is associated with the function return value (this is true even
if the function has no return value specified in the code).

Table 4-1 summarizes the behavior of the signals for block-level I/O protocol ap ctrl hs.
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Note: The explanation here uses the term “transaction”. In the context of high-level synthesis, a
transaction is equivalent to one execution of the C function (or the equivalent operation in the
synthesized RTL design).

Table 4-1: Block Level 1/0 Protocol ap_ctrl_hs

Signals Description

ap_start This signal controls the block execution and must be asserted to logic 1 for the design
to begin operation.

It should be held at logic 1 until the associated output handshake ap ready is
asserted. When ap_ready goes high, the decision can be made on whether to keep
ap_start asserted and perform another transaction or set ap_start to logic 0 and
allow the design to halt at the end of the current transaction.

Ifap start is asserted low before ap_ready is high, the design might not have read
all input ports and might stall operation on the next input read.

ap_ready This output signal indicates when the design is ready for new inputs.

The ap_ready signal is set to logic 1 when the design is ready to accept new inputs,
indicating that all input reads for this transaction have been completed.

If the design has no pipelined operations, new reads are not performed until the next
transaction starts.

This signal is used to make a decision on when to apply new values to the inputs ports
and whether to start a new transaction should using the ap_start input signal.

If the ap_start signal is not asserted high, this signal goes low when the design
completes all operations in the current transaction.

ap_done This signal indicates when the design has completed all operations in the current
transaction.

A logic 1 on this output indicates the design has completed all operations in this
transaction. Because this is the end of the transaction, a logic 1 on this signal also
indicates the data on the ap_return port is valid.

Not all functions have a function return argument and hence not all RTL designs have
an ap_return port.

ap_idle This signal indicates if the design is operating or idle (no operation).

The idle state is indicated by logic 1 on this output port. This signal is asserted low
once the design starts operating.

This signal is asserted high when the design completes operation and no further
operations are performed.

You can observe the behavior of these signals by viewing the trace file produced by RTL
CoSimulation. This is discussed in Chapter 8, RTL Verification tutorial, but Figure 4-5 shows
the waveforms for the current synthesis results.
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E adders.wcfg* x [

=4 ™ ap_return[31:0]
I 1 ap_idle

Al

Figure 4-5: RTL Waveforms for Block Protocol Signals

The waveforms in Figure 4-5 show the behavior of the block-level /O signals.

« The design does not start operation until ap start is set to logic 1.
« The design indicates it is no longer idle by setting port ap_idle low.

« Five transactions are shown. The first three input values (10, 20, and 30) are applied to
input ports In1, In2, and In3 respectively.

« Output signal ap_ready goes high to indicate the design is ready for new inputs on
the next clock.

« Output signal ap_done indicates when the design is finished and that the value on
output port ap_return is valid (the first output value, 60, is the sum of all three
inputs).

* Because ap start is held high, the next transaction starts on the next clock cycle.

Note: In RTL CoSimulation, all design and port input control signals are always enabled. For
example, in Figure 4-5 signal ap_start is always high.

In the 2nd transaction, notice on port ap_return, the first output has the value 70. The result
on this port is not valid until the ap_done signal is asserted high.

Step 3: Modify the Block-Level I/0O Protocol

The default block-level I/O protocol is the ap_ctrl hs protocol (the Control Handshake
protocol). In this step, you create a new solution and modify this protocol.
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1. Select New Solution from the toolbar or Project menu to create a new solution.
2. Leave all settings in the new solution dialog box at their default setting and click Finish.

3. Select the C source code tab (adders.c) in the Information pane (or re-open the C source
code if it was closed).

4. Activate the Directives tab and select the top-level function adders, as shown in

Figure 4-6.
¢ adders.c &2 = O |[8= Outline [ Directive &3 =0
46 #include "adders.h" - 4| ® adders
. -
@ inl
Sint ELL] int inl, int in2, int in3
o FEEE(int inl, int in2, int in3) { # HLS INTERFACE ap_none port=inl
@ in2
/ Prevent I0 protocols on all input ports # HLS INTERFACE ap_none port=in2
2 #pragma HLS INTERFACE ap_none port=in3 @ in3
3 #pragma HLS INTERFACE ap_none port=in2 # HLS INTERFACE ap_none port=in3

int sum;

sum = inl + in2 + in3;

m

return sum;

4 (1L} 4

Figure 4-6: Top-Level Function Selected

Because the block-level I/O protocols are associated with the function, you must specify
them by selecting the top-level function.

5. In the Directive tab, mouse over the top-level function adders, right-click, and select
Insert Directive.

The Directive Editor dialog box opens. Select the INTERFACE option from the Directive
pull-down list.

Figure 4-7 shows this dialog box with the drop-down menu for the interface mode
activated.
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+ | Vivado HLS Directive Editor ®

Directive

INTERFACE ~

Destination
(®) Source File
() Directive File

Options

mode (optional): |ap_ctrl_none V|

register (optional): []

depth (optional): | |

latency (optional): | |

name (opticnal): | |

Figure 4-7: Directive Dialog Box for ap_ctrl_none

The drop-down menu shows there are four options for the block-level interface protocol:

« ap ctrl none: No block-level I/O control protocol.
+ ap_ctrl hs: The block-level I/0 control handshake protocol we have reviewed.

« ap ctrl chain: The block-level I/O protocol for control chaining. This I/O protocol is
primarily used for chaining pipelined blocks together.

* s axilite: May be applied in addition to ap_ctrl hs orap ctrl chainto
implement the block-level I/O protocol as an AXI Slave Lite interface in place of
separate discrete I/O ports.

The block-level I/O protocol ap _ctrl chain is not covered in this tutorial. This protocol
is similar to ap_ctrl hs protocol but with an additional input signal, ap _continue,
which must be high when ap_done is asserted for the next transaction to proceed. This
allows downstream blocks to apply back-pressure on the system and halt further processing
when they are unable to continue accepting new data.

6. In the Destination section of the Directive Editor dialog box, select Source File.

By default, directives are placed in the directives.tcl file. In this example, the directive
is placed in the source file with the existing I/O directives.

7. From the mode options, select ap_ctrl_none from the drop-down menu.

8. Click OK.
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The source file now has a new directive, highlighted in both the source code and directives

tab in Figure 4-8.

The new directive shows the associated function argument/port called return. All
interface directives are attached to a function argument. For block-level I/O protocols, the
return argument is used to specify the block-level interface. This is true even if the
function has no return argument in the source code.

[¢ *adders.c &2 = O |[8= Outline [ Directive &3 =0
A6 #include "adders.h" - 4 ® adders

47 i i . i . i . # HLS INTERFACE ap_ctrl_none port=return
48int adders(int inl, int in2, int in3) { -

iltltpragma HLS INTERFACE ap_ctrl none port=retur 2 inl

50 # HLS INTERFACE ap_none port=inl

51 @ in2

52// Prevent I0 protocols on all input ports # HLS INTERFACE ap_none port=in2

53 #pragma HLS INTERFACE ap_none port=in3 2 in3

56
57
58 int sum;

60 sum = inl + in2 + in3;

return sum;

P

54 #pragma HLS INTERFACE ap_none port=in2
55 #pragma HLS INTERFACE ap_none port=inl

| il

# HLS INTERFACE ap_none port=in3

m

Figure 4-8: Block-Level Interface Directive ap_ctrl_none

9. Click the Run C Synthesis toolbar button or use the menu Solution > Run C Synthesis

to synthesize the design.

Adding the directive to the source file modified the source file. Figure 4-8 shows the source
file name as *adders. c. The asterisk indicates that the file is modified but not saved.

10. Click Yes to accept the changes to the source file.

When the report opens, the Interface summary appears, as shown in Figure 4-9.

P Explorer &2 w2

@ adders.c
fi=) Test Bench
(3 solutionl
~ {= solution2
@ constraints
(= impl
v [ syn
v [= report
ED adders_csynth.rpt
(= systemc
(= verilog
(= vhdl

Figure 4-9:
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B8 Eﬁ Synthesis(solution2)(adders_csynth.rpt) 2

~ % Multiplexer

+ Register

Interface

= Summary
RTL Ports | Dir | Bits Protocol Source Object C Type
inl in 32 ap_none inl scalar
in2 in 32 ap_none in2 scalar
in3 in 32 ap_none in3 scalar
ap_return | out 32 | ap_ctrl_none adders | return value

L

Interface Summary for ap_ctrl_none
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When the interface protocol ap_ctrl none is used, no block-level I/O protocols are
added to the design. The only ports are those for the clock, reset and the data ports.

Note that without the ap done signal, the consumer block that accepts data from the
ap_return port now has no indication when the data is valid.

In addition, the RTL CoSimulation feature requires a block-level /O protocol to sequence
the test bench and RTL design for CoSimulation automatically. Any attempt to use RTL
CoSimulation results in the following error message and RTL CoSimulation with halt:

@E [SIM-345] Cosim only supports the following 'ap ctrl none' designs: (1)
combinational designs; (2) pipelined design with task interval of 1; (3) designs with
array streaming or hls stream ports.

@E [SIM-4] *** C/RTL co-simulation finished: FAIL ***

Exit the Vivado HLS GUI and return to the command prompt.

Lab 2: Port I/O Protocols

Overview

This exercise explains how to specify port I/O protocols.

Step 1: Create and Open the Project

1. From the Vivado HLS command prompt used in Lab 1, change to the 1ab2 directory as
shown in Figure 4-10.

2. Type vivado hls -f run hls.tcl to create a new Vivado HLS project.

C:\Uivado_HLS_Tutorial\Interface_Synthesis\labl>cd ..

C:\VUivado_HLS_Tutorial\Interface_Synthesis>cd lab2

4 |11

C:\Uivado_HLS_Tutorial\Interface_Synthesis\lab2>vivado_hls -f run_hls.tcl

Figure 4-10: Setup for Interface Synthesis Lab 2
3. Type vivado_hls -p adders io_ prj to open the Vivado HLS GUI project.

4. Open the source code as shown in Figure 4-11.
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[25 Explorer & = O|[[¢] adders_io.c &3 =g

............................................................... ;Do

4 2% adders_io_prj
) Includes 46 #include "adders_io.h
4 = Source
le| adders_io.c
= Test Bench
4 = solutiont
4 & constraints
< directives.tcl
o scripticl
4 = csim
& build
= report

m

Figure 4-11: C Code for Interface Sythesis Lab 2

The source code (adders io.c) for this exercise is similar to the simple code used in Lab
1. For similar reasons, it helps focus on the interface behavior and not the core logic.

This time, the code does not have a function return, but instead passes the output of the
function through the pointer argument *in out1. This also provides the opportunity to
explore the interface options for bidirectional (input and output) ports.

The types of 1/O protocol that you can add to C function arguments by interface synthesis
depends on the argument type. These options are fully described in the Vivado Design Suite
User Guide: High-Level Synthesis (UG902) [Ref 2].

The pointer argument in this example is both an input and output to the function. In the RTL
design, this argument is implemented as separate input and output ports.
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For the code shown in Figure 4-11, the possible options for each function argument are

described in Table 4-2.

Table 4-2: Port Level 1/0 Protocol Options for Lab 2

Function Argument

1/0 Protocol Options

In1 and In2 These are pass-by-value arguments that can be implemented with the
following I/O protocols:

ap_none: No I/O protocol. This is the default for inputs.

ap_stable: No 1/O protocol.

ap_ack: Implemented with an associated output acknowledge port.
ap_vld: Implemented with an associated input valid port.

ap_hs: Implemented with both input valid and output acknowledge ports.

in_out1 This is a pass-by-reference output that can be implemented with the
following I/O protocols:

ap_none: No I/O protocol. This is the default for inputs.
ap_stable: No 1/O protocol.
ap_ack: Implemented with an associated input acknowledge port.

ap_vld: Implemented with an associated output valid port. This is the
default for outputs.

ap_ovld: Implemented with an associated output valid port (no valid port
for the input part of any inout ports).

ap_hs: Implemented with both input valid port and output acknowledge
ports

ap_fifo: A FIFO interface with associated output write and input FIFO full
ports.

ap_bus: A Vivado HLS bus interface protocol.

Note: The port directives applied in Lab 1 were not actually necessary because ap_none is the
default 1/0 protocol for these C arguments. The directives were provided to avoid addressing any I/O
port protocol behavior in that exercise, default behavior or not.

In this exercise, you implement a selection of I/O protocols.

Step 2: Specify the 1/0O Protocol for Ports

1. Ensure that you can see the C source code in the Information pane.

2. Activate the Directives tab and select input in1, as shown in Figure 4-12.
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dders_jo.c 2 = O/[ & Outline |14 Directive &3 =8
='<5:5<='<<5:='<<5:5<='<5:5<='<<5:='<<5:5<5<5:5<='<<5:5<<5:5<='<5:5<='<<5:5<<5:5<='<‘5<='<<5:5<<5:5<='<‘5<='<<>':5<<5:5<='<<5<='<<5:5<<545<='<<5<5<<5:5<<i/ - R
4 @ adders_io
#include "adders_io.h 2 inl
id adders_io(fTIPENE, int in2, int *in_outl 2 in2
void adders_io(f a5 ll, int in2, int *in_outl) { i "
in_ou

*in_putl = inl + in2 + *in_outl;

m

Figure 4-12: Adding Port I/O Protocols

3. Right-click and select Insert Directive.
4. When the Directive Editor opens leave the Directive drop-down menu as INTERFACE.
a. Leave the destination at the default value. This time, the directives are stored in the
directives.tcl file.
b. Select ap_vld from the mode drop-down menu
c. Click OK.
5. Select argument in2 and add an interface directive to specify the I/O protocol ap_ack.
6. Select argument in out1l and add an interface directive to specify the I/O protocol
ap_hs.
7. In the Explorer pane, expand the Constraints folder and double-click the
directives.tcl file to open it, as shown in Figure 4-13.
[25 Explorer & W =0 adders_io.c < directives.tel & =0
= adders_io_prj 1 ~
& Includes 2 ## This file is generated automatically by Vivado HLS.
= Source 3 ## Please DO NOT edit it.
- ) 4 ## Copyright (C) 2014 Xilinx Inc. All rights reserved.
¢l adders_io.c G I S
fizi Test Bench 6 set directive interface -mode ap vld "adders io" inl
= solution1 7 set_directive_interface -mode ap_ack "adders_io" in2
# constraints 8 set_directive_interface -mode ap_hs "adders_io" in_outl
& directives.tcl 9 |
4 scripticl
&= csim
= build
(= report i
4 P
Figure 4-13: Directives for Lab 2
8. Synthesize the design.
9. Review the Interface summary when the report file opens (Figure 4-14).
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[¢ adders_io.c |9 directives.tel |z adders_io_csynth.rpt i3 =0

- Summary
Dir  Bits  Protocol  Source Object C Type
ap_clk in 1 ap_ctrl_hs adders_io  return value
ap_rst in 1 ap_ctrl_hs adders_io  return value
ap_start in 1 ap_ctrl_hs adders_io  return value
ap_done out 1 ap_ctrl_hs adders_io  return value
ap_idle out 1 ap_ctrl_hs adders_io  return value
ap_ready out 1 ap_ctrl_hs adders_io  return value
inl in 32 ap_vld inl scalar
inl_ap_vid in 1 ap_vld inl scalar
in2 in 32 ap_ack in2 scalar
in2_ap_ack out 1 ap_ack in2 scalar
in_outl_i in 32 ap_hs in_outl pointer
in_outl_i_ap_vid in 1 ap_hs in_outl pointer
in_outl_i_ap_ack out 1 ap_hs in_outl pointer =
in_outl_o out 32 ap_hs in_outl pointer
in_outl_o_ap_vid out 1 ap_hs in_outl pointer
in_outl_o_ap_ack in 1 ap_hs in_outl pointer

Figure 4-14: Interface Summary for Lab 2
« The design has a clock and reset.
« The default block-level 1/0O protocol signals are present.
« Portin1isimplemented with a data port and an associated input valid signal.
« The data on portin1is only read when port in1_ap_vld is active-High.
« Portin2isimplemented with a data port and an associated output acknowledge signal.
« Portin2_ap_ack will be active-High when data port in2 is read.

« The inout i identifies the input part of argument inout1. This has associated input
valid port inoutl i ap v1ld and output acknowledge port inoutl i ap ack.

« The output part of argument inout1 is identified as inout_o. This has associated output
valid port inoutl o _ap_ vld and input acknowledge port inout1_o_ap_ack.

10. Exit the Vivado HLS GUI and return to the command prompt.

Lab 3: Implementing Arrays as RTL Interfaces

Introduction

This exercise shows how array arguments on the top-level function interface can be
implemented as a number of different types of RTL port.
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Step 1: Create and Open the Project

1. From the Vivado HLS command prompt window used in the previous lab, change to the
lab3 directory.

2. Create a new Vivado HLS project by typing vivado hls -f run hls.tcl.
3. Open the Vivado HLS GUI project by typing vivado hls -p array_ io prj.

4. Open the source code (array io.c) as shown in Figure 4-15.

This design has an input array and an output array. The comments in the C source explain
how the data in the input array is ordered as channels and how the channels are
accumulated. To understand the design, you can also review the test bench and the input
and output data in file result.golden.dat.

[25 Explorer 22 = O [ aray.io.c &3 =0
= array_io_prj 46 #include "array_io.h" -
[ Includes . . . .
B Source 8// The data comes in organized in a single array.
- - // - The first sample for the first channel (CHAN)
[€] array_io.c

/{ - Then the first sample for the 2nd channel etc.
// The channels are accumulated independently

/{ E.g. For 8 channels:

#= Test Bench
= solution1

& constraints // Array Order : ® 1 2 3 4 5 6 7 8 9 10 etc. 16 etc...
4 directives.tcl // Sample Order: A®@ BO CO D@ EP FO GO Ho Al Bl Cc2 etc. A2 etc...
& scriptacl // Output Order: A@ B@ CO DO E@ FO GO HO AB+Al BO+B1 CO+(2 etc. AG+Al+A2 etc...

eem void array_io (dout_t d_o[N], din_t d_i[N]) {
& build int i, rem;
= report

// Store accumulated data
static dacc t acc[CHANNELST;

// Accumulate each channel
For_Loop: for (1=0;i<M;i++) {
rem=1%CHANNELS ;
acc[rem] = acc[rem] + d_i[i];
d_o[i] = acc[rem];

Figure 4-15: C Code for Interface Synthesis Lab 3

Step 2: Synthesize Array Function Arguments to RAM Ports
In this step, you review how array ports are synthesized to RAM ports.

1. Run C Synthesis button in the toolbar and review the Interface summary when the
report opens (Figure 4-16).

The interface summary shows how array arguments in the C source are by default
synthesized into RTL RAM ports.

« The design has a clock, reset, and the default block-level I/O protocol ap ctrl hs
(noted on the clock in the report).

+ The d_o argument has been synthesized to a RAM port (I/O protocol ap_memory).
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+ A data port (d_o_do).
« An address port (d_o address0).
« Control ports for a chip-enable (d_o _ce0) and a write-enable port (do_we0).

« The d_i argument has been synthesized to a similar RAM interface, but has an input
data port (d_i_g0) and no write-enable port because this interface only reads data.

In both cases, the data port is the width of the data values in the C source (16-bit integers
in this case) and the width of the address port has been automatically sized to match the
number of addresses that must be accessed (5-bit for 32 addresses).

io_csynth.rpt &2 =0

- Summary
Dir = Bits Protocol Source Object C Type
ap_clk in 1 ap_ctrl_hs array_io  return value
ap_rst in 1 ap_ctrl_hs array_io  return value
ap_start in 1 ap_ctrl_hs array_io  return value
ap_done out 1 ap_ctrl_hs array_io  return value
ap_idle out 1 ap_ctrl_hs array_io  return value
ap_ready out 1 ap_ctrl_hs array_io  return value
d_o_address0  out 5 ap_memory do array
d_o_cel out 1 ap_memory do array
d_o_wel out 1 ap_memory do array
d_o_d0 out 16 ap_memory do array
d_i_address0 out 5 ap_memory d_i array =
d_i_cel out 1 ap_memory d_i array
d_i_g0 in 16 ap_memory d_i array

4 I 3
Figure 4-16: Interface Summary for Initial Lab 3 Design

Synthesizing array arguments to RAM ports is the default. You can control how these ports
are implemented using a number of other options. The remaining steps in Lab 3
demonstrate these options:

« Using a single-port or dual-port RAM interface.
« Using FIFO interfaces.

« Partitioning into discrete ports.

Step 3: Using Dual-Port RAM and FIFO Interfaces

High-Level Synthesis allows you to specify a RAM interface as a single-port or dual-port. If
you do not make such a selection, Vivado HLS automatically analyzes the design and selects
the number of ports to maximize the data rate.
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Step 2 used a single-port RAM interface because the for-loop in the source code is by
default left rolled: each iteration of the loop is executed in turn:

* Read the input port.

« Read the accumulated result from the internal RAM.

« Sum the accumulated and new data and write into the internal RAM.
»  Write the result to the output port.

» Repeat for the next iteration of the loop.

This ensures only a single input read and output write is ever required. Even if multiple input
and outputs are made available, the internal logic cannot take advantage of any additional
ports.

Note: If you specify a dual-port RAM and Vivado HLS can determine only a single port is required,
it uses a single-port and over-ride the dual-port specification.

In this design, if you want to implement an array argument using multiple RTL ports, the
first thing you must do is unroll the for-loop and allow all internal operations to happen in
parallel, otherwise there is no benefit in multiple ports: the rolled for-loop ensure only one
data sample can be read (or written) at a time.

1. Select New Solution from the toolbar or Project menu to create a new solution.
2. Accept the defaults, and click Finish.

3. Ensure the C source code is visible in the Information pane.

4

In the Directive tab select For_Loop, and right-click and select Insert Directive to open
the Directive Editor dialog box.

a. In the Directive Editor dialog box activate the Directive drop-down menu at the top
and select UNROLL.

b. With the Directive Editor as shown in Figure 4-17, click OK.
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Vivado HLS Directive Editor

Directive

UNROLL v

Destination
Source File
@) Directive File

Options
skip_exit_check (optional):

factor (optional):

region (optional):

Help | | Cancel | [ Ok l

Figure 4-17: Directive Editor to Unroll For_Loop

5. Next, specify a dual-port RAM for input reads. The Resource directive indicates the type
of RAM connected to an interface.

a. Inthe Directive tab, select port d_i and right-click and select Insert Directive to open
the Directive Editor dialog box.

b. In the Directive Editor activate the Directive drop-down menu at the top and select
RESOURCE.

c. Click the core box and select RAM_2P_BRAM.

d. Verify that the settings in the Directive Editor dialog box are as shown in Figure 4-18
and click OK.
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¢ Vivado HLS Core Selection O *

Filter
Core Type: | storage ]

Options
Memory Type: | RAM w
MNumber of Ports: | 2P v

Resource Type: | ALL v

RAM_2P
RAM_2P_LUTRAM
RAM_2P_URAM

Dual-port RAM (RO RW) using 'Block RAM'

Figure 4-18: Specifying a Dual-port RAM
6. Implement the output port using a FIFO interface.

a. Inthe Directive tab, select port d_o and right-click and select Insert Directive to open
the Directive Editor dialog box.

b. In the Directive Editor, ensure the directive is Interface.
c. From the Mode drop-down menu, select ap_fifo.

d. Click OK.

The Directive tab shows the directives now applied to the design (Figure 4-19).

o= Outline |4 Directive =g

4| @ array_io
2 do
9 HLS INTERFACE ap_fifo port=d_o
@ dli
9 HLS RESOURCE variable=d_i core=RAM_2P_BRAM
=1 acc
4 %" For_Loop
9 HLS UNROLL

Figure 4-19: Directives Summary for Lab 2 Solution

7. Run C Synthesis from the toolbar to synthesize the design.

When the report opens in the Information pane, the Interface summary is as shown in
Figure 4-20.
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« The design has the standard clock, reset, and block-level I/0 ports.

« Array argument d_o has been implemented as a FIFO interface with a 16-bit data port
(d_o_din) and associated output write (d_o_write) and input FIFO full
(d o full n) ports.

« Argument d_i has been implemented as a dual-port RAM interface.

£l array_io_csynth.rpt i3 =" 1m|
Interface -
- Summary
RTL Ports Dir  Bits Protocol Source Object C Type

ap_clk in p ap_ctrl_hs array_io  return value
ap_rst in | ap_ctrl_hs array_io  return value
ap_start in i ap_ctri_hs array_io  return value
ap_done out 1 ap_ctrl_hs array_io  return value
ap_idle out 1 ap_ctrl_hs array_io  return value
ap_ready out T ap_ctrl_hs array_io  return value
d_o_din out 16 ap_fifo do pointer
d_o_full_n in 1 ap_fifo do pointer
d_o_write out j ap_fifo do pointer
d_i_address0  out 5 ap_memory di array
d_i_cel out 1 ap_memory di array

d_i_g0 in 16 ap_memory d.i array =
d_i_address1 out 5 ap_memory di array
d_i_cel out 1 ap_memory d.i array
diqgl in 16 ap_memory d.i array

Figure 4-20: Dual-Port BRAM and FIFO Interfaces

By using a dual-port RAM interface, this design can accept input data at twice the rate of
the previous design. Because the for-loop was unrolled, the logic in the loop is able to
consume data at this rate. By default, each loop iteration is executed in turn. This
implementation code limits the logic to one read on d_1i in each iteration. Unrolling the
loops allows more reads to be performed (but creates N copies of the logic). However, by
using a single-port FIFO interface on the output the output data rate is the same as before.

Step 4: Partitioned RAM and FIFO Array Interfaces
In this step, you learn how to partition an array interface into any arbitrary number of ports.

1. Select New Solution from the toolbar or the Project menu and create a new solution.

2. Accept the defaults, and click Finish. This includes copying existing directives from
solution2.

3. Ensure the C source code is visible in the Information pane.

4. In the Directive tab, select d_o and right-click and select Insert Directive to open the
Directive Editor dialog box.
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a. In the Directive Editor dialog box activate the Directive drop-down menu at the top
and select ARRAY_PARTITION.

b. Activate the type drop down to partition the array into blocks. Set type to block.
c. Inthe Vivado HLS Directive Editor dialog box, set the factor (optional) to 4.
d. With the Vivado HLS Directive Editor as shown in Figure 4-21, click OK.

Vivado HLS Directive Editor

Directive

ARRAY_PARTITION v

Destination
Source File
@) Directive File

Options

variable (required): do

type (optional): block hd
factor (optional): 4

dimension (optional): 1

| Help | | Cancel | [ (]9 l

Figure 4-21: Directive Editor for Partitioning Array d_o

Now, partition the input array into two blocks (not four).

5. In the Directive tab, select d_i and repeat the previous step, but this time partition the
port with a factor of 2.

The directives tab shows the directives now applied to the design (Figure 4-22).
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o= Qutline |4 Directive &2 i

4 @ array_io
2 do
9 HLS ARRAY_PARTITION partition variable=d_o block factor=4 dim=
9 HLS INTERFACE ap_fifo port=d_o
@ dli
9% HLS ARRAY_PARTITION variable=d_i block factor=2 dim=1
9 HLS RESOURCE variable=d_i core=RAM_2P_BRAM
®[1 acc
4% For_Loop
9 HLS UNROLL
« 111 »

Figure 4-22: Directives Summary for Lab 2 Solution3

6. Run C Synthesis from the toolbar to synthesize the design.

When the report opens in the Information pane, the Interface summary is as shown in
Figure 4-23.

« The design has the standard clock, reset, and block-level I/O ports.

« Array argument d_o has been implemented as a four separate FIFO interfaces.

« Argument d_i has been implemented as two separate RAM interfaces, each of which
uses a dual-port interface. (If you see four separate RAM interfaces, confirm a partition
factor for d_1i is two and not four).
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=l array_io_csynth.rpt i3 =8
Interface i
- Summary
RTL Ports Dir  Bits Protocol Source Object C Type

ap_clk in 1 ap_ctrl_hs array_io  return value
ap_rst in 1 ap_ctrl_hs array_io  return value
ap_start in 1 ap_ctrl_hs array_io  return value
ap_done out 1 ap_ctrl_hs array_io  return value
ap_idle out 1 ap_ctrl_hs array_io  return value
ap_ready out 1 ap_ctrl_hs array_io  return value
d_o_0_din out 16 ap_fifo do0 pointer
d_o_0_full_n in 1 ap_fifo do0 pointer
d_o_0_write out 1 ap_fifo do0 pointer
d_o_1_din out 16 ap_fifo dol pointer
d_o_1_full_n in 1 ap_fifo dol pointer
d_o_1_write out 1 ap_fifo dol pointer
d_o_2_din out 16 ap_fifo do?2 pointer
d_o_2_full_n in 1 ap_fifo do?2 pointer
d_o_2_write out 1 ap_fifo do?2 pointer
d_o_3_din out 16 ap_fifo do 3 pointer
d_o_3_full_n in 1 ap_fifo do 3 pointer
d_o_3_write out 1 ap_fifo do 3 pointer
d_i_0_address0  out 4 ap_memory d.i0 array
d_i_0_cel out 1 ap_memory d.i0 array
d_i_0_ gl in 16 ap_memory d.i0 array
d_i_0_addressl  out 4 ap_memory d.i0 array

d_i_0_cel out 1 ap_memory d.i0 array =
d_i0qgl in 16 ap_memory d.i0 array
d_i_1_address0 out 4 ap_memory dlil array
d_i_1l_cel out 1 ap_memory dlil array
d_i_l gl in 16 ap_memory dlil array
d_i_1_addressl out 4 ap_memory dlil array
dli_lcel out 1 ap_memory dlil array
dilaqgl in 16 ap_memory dlil array

Figure 4-23: Interface Report for Partitioned Interfaces

If input port d_1i was partitioned into four, only a single-port RAM interface would be

required for each port. Because the output port can only output four values at once, there

would be no benefit in reading eight inputs at once.

The final step in this tutorial is to partition the arrays completely.

Step 5: Fully Partitioned Array Interfaces
This step shows you how to partition an array interface into individual ports.

1. Select New Solution from the toolbar and create a new solution.
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2. Click Finish and accept the defaults. This includes copying existing directives from
solution3.

3. Ensure the C source code is visible in the Information pane.

4. In the Directive tab, select the existing partition directive for d_o as shown in
Figure 4-24.

5. Right-click and select Modify Directive.

8= Outline | Directive £ - O

4 @ array_io
2 do
%, HLS ARRAY PARTITION variable=d_o complete factor=4 dim=1

0| # Modify Directive do
2 ¥ Remove Directive

% HLS ARRAY_PARTITION partition variable=d_i complete dim=1
% HLS RESOURCE variable=d_i core=RAM_2P_BRAM
=1 acc
4 %" For_Loop
% HLS UNROLL

Figure 4-24: Modifying the Directive for d_o
6. In the Vivado HLS Directive Editor dialog box:

a. Inthe Vivado HLS Directive Editor dialog box, delete the value 4. Since this array will
be completely partitioned into registers, the partitioning factor is no longer relevant.
(If you leave it there, it will be ignored).

b. Activate the type (optional) drop down and modify the partitioning type to
complete.

c. With the Directive Editor as shown in Figure 4-25, click OK.
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Vivado HLS Directive Editor

Directive

ARRAY_PARTITION v

Destination
() Source File
(@) Directive File

Options
variable (required): do
type (optional): complete hd

factor (optional):

dimension (optional): 1

l Help ] l Cancel ] [ (0]4 l

Figure 4-25: Directive Editor for Partitioning Array d_o

7. Inthe Directive tab, select d_i and repeat the previous step to completely partition the
d 1 array.

8. In the Directive tab, select the RESOURCE directive on d_1i, right-click with the mouse
and select Remove Directive. If the array is partitioned into individual elements, it
cannot be assigned to a block RAM.

The Directives tab shows the directives now applied to the design (Figure 4-26).
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2= Qutline | (4 Directive &2 « =8

4| @ array_io
® do
% HLS INTERFACE ap_fifo port=d_o
% HLS ARRAY_PARTITION variable=d_o complete dim=1
® di
% HLS ARRAY_PARTITION variable=d_i complete dim=1
®[1 acc
® temp
4 %" For_Loop
% HLS UNROLL

Figure 4-26: Directives Summary for Lab 2 Solution4
9. Run C Synthesis from the toolbar to synthesize the design.

10. When the report opens in the Information pane, review the interface summary. Note the
following:

« The design has the standard clock, reset, and block-level I/O ports.
« Array argument d_o has been implemented as 32 separate FIFO interfaces.

« Argument d_1i has been implemented as 32 separate scalar ports. Because the default
interface for input scalars is not in the 1/O protocol, they have the I/O protocol
ap_none.

Although this tutorial has focused exclusively on the 1/O interfaces, at this point it is worth
examining the differences in performance across all four solutions.

11. Select Compare Reports from the toolbar or the Project menu to open a comparison of
the solutions.

12.In the Solution Selection dialog box, add each of the four solutions to the Selected
Solutions pane (Figure 4-27).

13. Click OK.
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Solution Selection

Available solutions:

+ | Solution Selection Dialog

Please select the solutions you want to compare

Selected solutions:

solutionl
Add> > solution2
<<Remove solution3
solutiond

[ Ok l l Cancel ]

Figure 4-27: Compare All Solutions for Lab 3

When the solutions comparison report opens (Figure 4-28), it shows that solution4, using a
unique port for each array element, is much faster than the previous solutions. The internal
logic can access the data as soon as it is required. (There is no performance bottleneck due

to port accesses.)

Performance Estimates

- Timing (ns)
Clock solution | sclution2 | solution3 | solutiond
ap_clk | Target 4.00 4.00 4.00 4.00
Estimated | 2.602 3.150 3.363 3.363
- Latency (clock cycles)
solution | sclution2 | solution3 | solutiond
Latency | min | B85 33 10 1
max | 65 33 10 1
Interval | min | B85 33 10 1
max | 65 33 10 1
Figure 4-28: Performance Comparisons for All Lab 3 Solutions

Scroll further down the comparison report (Figure 4-29) and note that solutions with more
I/0 ports (solutions 2, 3, and 4), allows more parallel processing, but also use considerably

maore resources.
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solution | solution2 | solution? | solutiond
BRAM_18K | 0 0 0 0
DSP48E 0 0 0 0
FF 83 1202 731 642
LUT 137 2125 2083 1945
URAM 0 0 0 0

Figure 4-29: Resource Comparisons for All Lab 3 Solutions

In the next exercise, you implement this same design with an optimum balance between the

ports and resources. In addition to this more optimal implementation, the next exercise

shows how to add AXI4 interfaces to the design.

14. Exit the Vivado HLS GUI and return to the command prompt.

Lab 4: Implementing AXI4 Interfaces

Introduction

This exercise explains how to specify AXI4 bus interfaces for the 1/O ports. In addition to

adding AXI4 interfaces this exercise also shows how to create an optimal design by using
interface and logic directives together.

Step 1: Create and Open the Project

1.

From the Vivado HLS command prompt window used in the previous lab, change to the

lab4 directory.

Create a new Vivado HLS project by typing vivado hls -f run hls.tcl.

Open the Vivado HLS GUI project by typing vivado_hls -p axi_ interfaces prj.

Open the source code as shown in Figure 4-30.
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le| axi_interfaces.c & =0
46 #include "axi_interfaces.h" -
47

48 // The data comes in organized in a single array.

49 // - The first sample for the first channel (CHAN)

50 // - Then the first sample for the 2nd channel etc.

51// The channels are accumulated independently

52// E.g. For 8 channels:

53// Array Order : @ 1 2 3 4 5 6 7 8 9 10 etc. 16 etc...

54 // Sample Order: A® BO CO DO EO FO GO He Al Bl c2 etc. A2 etc...

55// Output Order: A® B@ CO DO EO FO GO HO A@+Al BO+Bl CO+(2 etc. AO+A1+A2 etc...
56

57void axi_interfaces (dout_t d_o[N], din_t d_i[N]) {

58 int i, rem;

59

60 // Store accumulated data

61 static dacc_t acc[CHANNELS];

62

63 // Accumulate each channel =
64 For_Loop: for (i=@;i<M;i++) {

65 rem=i%CHANNELS;

66 acc[rem] = acc[rem] + d_i[i];

67 d_o[i] = acc[rem];

68 }

69}

70 s

Figure 4-30: Source Code for Lab 4

This design uses similar source C code as Lab 3: with the design renamed to
axi interfaces.

Step 2: Create an Optimal Design with AXI4-Stream Interfaces

To reach optimal performance implementation of this design, the data for each channel is
processed in parallel, with dedicated hardware for each channel.

The key to understanding how best to perform this optimization is to recognize that the
channels in the input and output arrays lend themselves to cyclic partitioning. Cyclic
partitioning is fully explained in the Vivado Design Suite User Guide: High-Level Synthesis
(UG902) [Ref 2], but basically means each array element is, in turn, sorted into a different
partition.

In this exercise, you specify the array arguments to be implemented as AXI4-Stream
interfaces. If the arrays are partitioned into channels, you can stream the samples for each
channel through the design in parallel.

Finally, if the I/O ports are configured to supply and consume individual streams of channel
data, partial unrolling of the for-loop can ensure dedicated hardware processes each
channel.

First, partition the arrays:

1. Ensure the C source code is visible in the Information pane.
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2. In the Directive tab, select d_o and right-click and select Insert Directive to open the
Directive Editor dialog box.

a. Select the Directive drop-down menu at the top and select ARRAY_PARTITION.
b. Click the type (optional) drop-down menu to specify cyclic partitioning.

c. In the factor (optional) box, enter the value 8, to create eight separate partitions.
(This results in eight ports.)

d. With the Directive Editor dialog box filled in as shown in Figure 4-31, click OK.

Vivado HLS Directive Editor

Directive

ARRAY_PARTITION v

Destination
Source File
@) Directive File

Options

variable (required): do

type (optional): cyclic hd
factor (optional): 8

dimension (optional): 1

| Help | | Cancel | [ (0]4 l

Figure 4-31: Directives Editor for Cyclic Partitioning

3. Inthe Directive tab, select d_o again and right-click and select Insert Directive to open
the Directive Editor dialog box.

a. Activate the Directive drop-down menu at the top and select INTERFACE.
b. Click the Mode drop-down menu to specify an axis interface.
c. Click OK.

4. In the Directive tab, select d_i and repeat steps 2 and 3 above.

a. Apply ARRAY_PARTITION.
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b.
C.

d.

Apply Cyclic with a factor of 8.
Apply Interface.

Apply an axis interface.

5. Next, partially unroll and pipeline the for-loop:

a.

d.

e.

In the Directive tab, select For_Loop and right-click and select Insert Directive to
open Vivado HLS Directive Editor dialog box.

Select the Directive drop-down menu at the top and select UNROLL.

Select a factor of 8 to partially unroll the for-loop. This is equivalent to re-writing the
C code to execute eight copies of the loop-body in each iteration of the loop (where
the new loop only executes for four iterations in total, not 32).

Click OK.

In the Directive tab, select For_Loop again and right-click and select Insert
Directive to open Vivado HLS Directive Editor dialog box.

Activate the Directive drop-down menu at the top and select PIPELINE. Leave the
interval (II) blank and let it default to 1.

Select enable loop rewinding.

Click OK.

When the top-level of the design is a loop, you can use the pipeline rewind option. This
informs Vivado HLS that when implemented in RTL, this loop runs continuously (with no
end of function and function re-start cycles).

After performing the above steps, the Directives tab should be as shown in Figure 4-32. Be
sure to check all options are correctly applied. If not, double-click the directive to re-open
the Directive Editor.
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&= Outline | Directive 2 - O

@ axi_interfaces
2 do
% HLS INTERFACE axis port=d_o
% HLS ARRAY_PARTITION partition variable=d_o cyclic factor=8 dim=1
@ dli
% HLS INTERFACE axis port=d_i
% HLS ARRAY_PARTITION partition variable=d_i cyclic factor=8 dim=1
®[1 acc
%" For_Loop
% HLS UNROLL factor=8
% HLS PIPELINE rewind

Figure 4-32: Directives Tab for Lab 4 Solutionl

6. Run C Synthesis from the toolbar.

When the report opens in the information pane, confirm both d_i and d_o are implemented
as eight separate AXI4-Stream ports.

7. In the performance section of the report, confirm that the for-loop processes one
sample every clock cycle (Initiation Interval 1) with a latency of 4, and that the design
has less area than solutions 2, 3, or 4 in Lab 3 (Figure 4-29).

Cyclic partitioning of the array interfaces and partial for-loop unrolling has allowed
implementation of this C code as eight separate channels in the hardware.

Pipelining the for-loop allows the logic in each channel to process 1 sample per clock.
Varying the partitioning and loop unrolling allows you to create a design which is the
optimal balance of area and performance to satisfy your particular requirements.

Step 3: Implementing an AXI4-Lite Interfaces

In this exercise, you group block-level I/O protocol ports into a single AXl4-Lite interface,
which allows these block-level control signals to be controlled and accessed from a CPU.

1. Select New Solution from the toolbar or the Project menu to create a new solution.

2. Accept the defaults and click Finish. This includes copying existing directives from
solution.

3. Ensure the C source code is visible in the Information pane.

4. In the Directive tab, select the top-level function axi_interfaces and right-click and
select Insert Directive to open the Directive Editor dialog box.

a. Select the Directive drop-down menu at the top and select INTERFACE.
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b. Select the mode drop-down menu and select s_axilite. This specifies that the ports
associated with the function return (the block-level I/O ports) are implemented as an
AXl4-Lite interface. Since the default mode for the function return is ap_ctrl_hs, there
is no requirement to specify this I/O protocol.

c. Click OK.

The Directives tab appears, as shown in Figure 4-33.

o= Qutline |4 Directive &2 i

419 axi interfaces
% HLS INTERFACE s_axilite port=return
2 do
% HLS INTERFACE axis port=d_o
% HLS ARRAY_PARTITION partition variable=d_o cyclic factor=8 dim=1
@ dli
% HLS INTERFACE axis port=d_i
% HLS ARRAY_PARTITION partition variable=d_i cyclic factor=8 dim=1
®[1 acc
4 %" For_Loop
% HLS UNROLL factor=8
% HLS PIPELINE rewind

Figure 4-33: Directives for Specifying AXI4-Lite Interfaces

5. Run C Synthesis from the toolbar.

When the report opens, review the interface summary to confirm the block-level I/0
protocol ports (ap_start, ap done, etc.) have been replaced with an AXI4Lite interface
and that the output interrupt signal has been added to the design. The source of the
interrupt can be selected through the AXI-Lite interface.

6. Select Export RTL from the toolbar or the Solution menu to create an IP package.

7. Leave the Format Selection as IP Catalog and click OK.

You can see the IP package in the solution2/impl folder. Because you used the Vivado
IP Catalog format, the package is in the ip folder.

The ip folder includes the drivers subfolder, as shown in Figure 4-34.

When you add an AXI4-Lite interface to the design, the IP packaging process also creates
software driver files to enable an external block, typically a CPU, to control this block (start
it, stop it, set port values, review the interrupt status).
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L Explorer &2

v = axi_interfaces_prj
[ Includes
= Source
fi= Test Bench
(3 solutionl
v = solution2
& constraints
v = impl
v [=ip
=| autoimpl.log
=| auxiliary.xml

= axi_interfaces_info.xml

=| componentxml
[E] pack.bat

“ff run_ippack.tcl
Thy . -

g vivado,jou

=| vivado.log

xilinx_com_hls_axi_interfaces_1_0.zip

& constraints
(= bd
[= doc

v (= drivers

v (= axi_interfaces_v1_0

= data
v [ src

%

Chapter 4: Interface Synthesis

Makefile

\g| xaxi_interfaces_hw.h

\g| xaxi_interfaces_linux.c
\.g| xaxi_interfaces_sinit.c
\.g| xaxi_interfaces.c

\g| xaxi_interfaces.h

Figure 4-34:

(= example
(= hdl
&= misc
= subcore
(= xgui

&= misc

(= verilog

(= vhdl

[= syn

IP Package with AXI4 Interfaces

8. Double-click the xaxi interfaces hw.h file to open it in the Information pane.

This shows the addresses to access and control the block-level interface signals. For
example, setting control register 0x0 bit O to the value 1 will enable the ap_start port, or
alternatively, setting bit 7 will enable the auto-restart and the design will re-start
automatically at the end of each transaction.

The remaining C driver files are used to integrate control of the AXI4 Slave Lite interface
into the code running on a CPU or microcontroller and are included in the packaged IP.

High-Level Synthesis
UG871 (v2020.1) August 7, 2020

www.Xxilinx.com

l Send Feedback I 3


https://www.xilinx.com
https://www.xilinx.com/about/feedback/document-feedback.html?docType=Tutorials&docId=UG871&Title=Vivado%20Design%20Suite%20Tutorial&releaseVersion=2020.1&docPage=93

& XILINX.

Chapter 4: Interface Synthesis

r[\jExplorer &3 = B || [R] *xaxi_interfaces hw.h 52

v 125 axi_interfaces_prj
[ Includes
= Source
= Test Bench
(3 solution
v = solution2
% constraints
v = impl
v [=ip
|5 auteimpl.log
uxiliary.xml
xi_interfaces_info.xml

= componentxml

[%] pack.bat

4 run_ippack.tel

g

u vivado,jou

=| vivado.log

¢ xiline_com_hls_axi_interfaces_1_0.zip

% constraints

(= bd

= doc

w [= drivers
w [ axi_interfaces v1_0
= data
v [ src

| & Makefile
.| xaxi_interfaces_hw.h
€] xaxi_interfaces linux.c

vade(TM) HLS - High-Level Synthesis from C, C++ and SystemC v2@19.1 (64-bit)
Copyright 1986-2019 Xilinx, Inc. All Rights Reserved.

// AXILiteS

@xe : Contrel signals

bit @ - ap_start (Read/Write/COH)
b - ap_done (Read/COR)

bit 2 - ap_idle (Read)

bit 3 - ap_ready (Read)

bit 7 - aute_restart (Read/Write)
others - reserved

4 : Global Interrupt Enable Register

others - reserved

bit @ - Channel @ (ap_done)
bit 1 - Channel 1 (ap_ready)
others - reserved
: IP Interrupt Status Register (Read/TOW)
bit @ - Channel @ (ap_done)

#define XAXI_INTERFACES_AXILITES_ADDR_AP_CTRL @x@
#define XAXI_INTERFACES_AXILITES_ADDR_GIE Bxd
#define XAXI_INTERFACES_AXILITES_ADDR_IER @xs
#define XAXI_INTERFACES_AXILITES_ADDR_ISR Bxc

Figure 4-35: IP Software Driver Files

bit @ - Glebal Interrupt Enable (Read/Write)

: IP Interrupt Enable Register (Read/Write)

bit 1 - Channel 1 (ap_ready)
others - reserved
// (SC = self Clear, COR = Clear on Read, TOW = Toggle on Write, COH = Clear on Handshake)

Conclusion

In this tutorial, you learned:

«  What block-level I/O protocols are and how to control them.

« How to specify and apply port-level I/O protocols.

« How to specify array ports as RAM and FIFO interfaces.

« How to partition RAM and FIFO interfaces into sub-ports.

+ How to use both I/O directives and optimization directives to create an optimal design

with AXI4 interfaces.
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Chapter 5

Arbitrary Precision Types

Overview

C/C++ provided data types are fixed to 8-bit boundaries:

« char (8-bit)

« short (16-bit)

« int (32-bit)

« long long (64-bit)
« float (32-bit)

« double (64-bit)

« Exact width integer types such as int16_t (16-bit) and int32_t (32-bit)

When creating hardware, it is often the case that more accurate bits-widths are required.
Consider, for example, a case in which the input to a filter is 12-bit and the accumulation of
the results only requires a maximum range of 27 bits. Using standard C data types for
hardware design results in unnecessary hardware costs. Operations can use more LUTs and

registers than needed for the required accuracy, and delays might even exceed the clock
cycle, requiring more cycles to compute the result.

Vivado High-Level Synthesis (HLS) provides a number of bit accurate or arbitrary precision
data-types, allowing you to model variables using any (arbitrary) width.

This tutorial consists of a two lab exercises:

Lab 1 Description

Synthesize a design using floating-point types and review the results. The design uses
standard C++ floating-point types.

Lab 2 Description

Synthesize the same function used in Lab 1 using arbitrary precision fixed-types
highlighting the benefits in accuracy and results. This exercise shows how this same design
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can be converted to the Vivado HLS ap_fixed types, retaining the required accuracy but
creating a more optimal hardware implementation.

Tutorial Design Description

Download the tutorial design file from the Xilinx website. See the information in Locating
the Tutorial Design Files.

This tutorial uses the design files in the tutorial directory
Vivado HLS TutoriallArbitary Precision.

Lab 1: Arbitrary Precision

Arbitrary Precision Lab 1: Review a Design using Standard C/C++ types.

In this lab, you synthesize a design using standard C types. You use this design as a
reference for the design using arbitrary precision types, which is the basis for Lab 2.

i? IMPORTANT: The figures and commands in this tutorial assume the tutorial data directory
Vivado_HLS_Tutorial is unzipped and placed in the location C:\Vivado_HLS_Tutorial. If the tutorial data
directory is unzipped to a different location, or on Linux systems, adjust the few pathnames referenced,
to the location you have chosen to place the Vivado_HLS_Tutorial directory.

Step 1: Create and Open the Project
1. Open the Vivado HLS Command Prompt.

a. On Windows use Start > All Programs > Xilinx Design Tools > Vivado 2020.1 >
Vivado HLS > Vivado HLS 2020.1 Command Prompt.

b. On Linux, open a new shell. In the command prompt window (Figure 5-1), change
the directory to the Arbitrary Precision tutorial, lab1.

2. Execute the Tcl script to setup the Vivado HLS project, using the command as shown in
Figure 5-1:

vivado hls -f run hls.tcl
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C:\VUivado_HLS_Tutorial>cd Arbitrary_Precision

C:\VUivado_HLS_Tutorial\Arbitrary_Precision>cd labl

A ([ 111

C:\Uivado_HLS_Tutorial\Arbitrary_Precision\labl>vivado_hls -f run_hls.tcl

Figure 5-1: Setup the Tutorial Project

3. When Vivado HLS completes, open the project in the Vivado HLS GUI using the
command vivado_hls -p window_fn prj as shown in Figure 5-2.

hw_result 38.24289 sW_result 38.24289 -
hw_result 32.00000 sW_result 32.00000
hw_result 25.75711 sW_result 25.75711
hw_result 19.75413 sW_result 19.75413
hw_result 14.22175 sW_result 14.22175
hw_result 9.37258 sW_result 9.37258
hw_result 5.39297 sW_result 5.39297
hw_result 2.43585 sW_result 2.43585
hw_result 0.61487 sW_result 0.61487

H: H: H: H: H- H- H. H H

Test Passed
@I [SIM-1] CSim done with O errors.
@I [LIC-101] Checked in feature [HLS]

A ([ 111

C:\Uivado_HLS_Tutorial\Arbitrary_Precision\lab1>vivado_hls -

Figure 5-2: Initial Project for Arbitrary Precision Lab1l

Step 2: Review Test Bench and Run C Simulation

1. Open the Source folder in the Explorer pane and double-click window fn top.cpp to
open the code as shown in Figure 5-3.

[t5 Explorer &2 = 8| ¢ window_fn_top.cpp i3 =8
4 125 window_fn_prj
! Includes
4 = Source
Ll window_fn_top.cpp
= Test Bench
= solution1

| %

4 % constraints

4 directives.tcl

4 scripttcl 54void window_fn_top(
4 = csim 55 win_fn_out t outdata[WIN_LEN], =
. : 56 win_fn_in_t indata[WIN_LEN])
= build 57
& report 58 // Instantiate a window_fn object - types and params define: _

Figure 5-3: C Code for Arbitrary Precision Types Lab 1

2. Hold down the Control key and click the window fn top.h on line 46 to open this
header file.
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3. Scroll down to view the type definitions (Figure 5-4).

€] window_fn_top.cpp T window_fn_top.h &2 =08

587/ Test parameters n
51 #define FLOAT_DATA // Used to select error tolerance in test pi
52 #define WIN_TYPE xhls_window_fn: :HANN

53 #define WIN_LEN 32

54

55// Define floating point types for input, output and window cos
56 typedef float win_fn_in_t;

57 typedef float win_fn_out_t;

58 typedef float win_fn_coef_t;

59

60 // Top level function prototype - wraps all object, method and
1void window_fn_top(win_fn_out_t outdata[WIN_LEN], win_fn_in_t :

e
(s}

m

#endif // WINDOW FN_TOP H_

oo

FEN VR N

< 1 3

Figure 5-4: Types Definition for Arbitrary Precision Types Lab 1

This design uses standard C/C++ floating-point types for all data operations. Vivado
High-Level Synthesis can synthesize floating-point types directly into hardware, provided
the operations are standard arithmetic operations (+, -, *, %).

When using math functions from math.h or cmath.h, see the Vivado Design Suite User
Guide: High-Level Synthesis (UG902) [Ref 2] for details on which math functions are
supported for synthesis.

4. Click the Run C Simulation toolbar button to open the C Simulation Dialog box.

5. Accept the default setting (no options selected) and click OK.

The Console pane shows that the design simulates with the expected results.

Step 3: Synthesize the Design and Review Results

1. Click the Run C Synthesis toolbar button to synthesize the design to RTL.

When synthesis completes, the synthesis report opens automatically. Figure 5-5 shows the

synthesis report.
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Performance Estimates
= Timing (ns)

= Summary

Clock | Target | Estimated | Uncertainty
ap_clk 5.00 4,084 0.63

= Latency (clock cycles)

= Summary

Latency Interval

min | max | min | max | Type
161 161 161 161 | none

= Detail
# Instance

# Loop

Utilization Estimates

= Summary

MName BRAM_18K | DSP43E FF LUT URAM
Dsp - - - 5 -
Expression - - 0 26 -
FIFO - - - - -
Instance 2 3 143 78 %
Memory 1 - 0 0 -
Multiplexer - - - a7 -
Register - - 24 = =
Total 1 3 167 151 0
Hoailable 4320 6840 | 2364480 | 1182240 960
Available SLR 1440 2280 | 788160 | 394080 320
Utilization (%) ~0 ~0 -0 -0 0
Utilization SLR. (35) =0 -0 -0 -0 0

Figure 5-5: Synthesis Report for Floating Point Design

Instances in the top-level design account for most of the area used.

2. Scroll down the report and expand the Instances in the Details section of the Utilization
Estimates (Figure 5-6).
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Utilization Estimates

E Summary
Marne ERAM_12K | DSP42E FF LuT URAM
Dsp 5 - 4 - :
Expression 7 5 0 26 T
FIFO 5 - 3 - 4
Instance - 3 143 73 -
Memory 1 - 0 0 i
Multiplexer - - - 47 -
Register - - 24 - -
Total 1 3 167 131 0
Available 4320 6840 | 2364480 | 1182240 960
Available SLR 1440 2280 | 733160 | 304020 320
Utilization {%a) ~0 ~0 ~0 ~0 0
Utilization SLR (%3] ~0 ~0 ~0 ~0 0
= Detail
= Instance
Instance Module BRAM_18K | DSP43E | FF | LUT | URAM
window_fr_top_froucud_U1 | window_fn_top_fmucud 0 3| 143 T8 0
Total 1 0 3| 143 78 0

Figure 5-6: Area Details for Floating Point Design

The details show this is a floating-point multiplier (fmul). Floating-point operations are
costly in terms of area and clock cycles. The Analysis perspective (Figure 5-7) shows this
operator is also responsible for most of the clock cycles (It takes three of the five states to
execute the logic created by loop winfn loop).

More details on using the Analysis perspective are available in the Chapter 6, Design
Analysis tutorial. For the purposes of understanding this design, two of the operations in
the first state are one-cycle read-from-memory operations, and the operation in the final
state is a write-to-memory operation.

] Module Hierarchy = = B || Schedule Viewer(solutionl) &2
Megative Slack BRAM DSP FF LUT Latency Interval l:l- - | & =32 [Foc
@ window_fn_top - 1 3 167 151 181 162
p N Operation\Control Step | g | 7 | 5 | 5 | N | 5 |
. 1 =

£F Performance Profile ||, Resource Profile 51 B =0 v [Emiptinog ! . , - winfn_loop . .
= i_0_i{phi_munx) : : : : : :

BRAM DSP FF LUT BitsPD BitsP1 BitsP2 icmp_In129(icmp) : : : : : :

v [@ window_fn_top. 1 3 167 151 i(+) ! ! ! ! ! !
& 1/0 Ports(2) 64 coeff tabl load{read) i = i i i i

1 i | | 1 i

s Instances(1) L] 3 143 78 indata_load(read) ! T ! ! ! !

A Memories(1) 1 [V 32 tmp_ilfmul) 1 1 - - - 1

Y Epressions2) 0 o o 2 12 8 0 outdata_addlr_write_In131(write] ! ! i i i !

1010 Ranictareldl 24 a2 ! H i H H !

Figure 5-7: Performance Details for Floating Point Design

3. Exit the Vivado HLS GUI and return to the command prompt.
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Lab 2: Arbitrary Precision

Review a Design using Arbitrary Precision types.

Introduction

This lab exercise uses the same design as Lab 1, however, the data types are now arbitrary
precision types. You first review the design and then examine the synthesis results.

Step 1: Create and Simulate the Project

1. From the Vivado HLS command prompt used in Lab 1, change to the lab2 directory as
shown in Figure 5-8.

2. Create a new Vivado HLS project by typing vivado _hls -f run hls.tcl.

C:\Vivado_HLS_Tutorial>cd Arbitrary_Precision\labl

C:\VUivado_HLS_Tutorial\Arbitrary_Precision\labl>cd ..
C:\Vivado_HLS_Tutorial\Arbitrary_Precision>cd lab2

C:\Vivado_HLS_Tutorial\Arbitrary_Precision\lab2>vivado_hls -f run_hls.tcl

Figure 5-8: Setup for Arbitrary Precision Lab 2
3. Open the Vivado HLS GUI project by typing vivado _hls -p window fn prj.

4. Open the Source folder in the Explorer pane and double-click window_fn_top.cpp to
open the code as shown in Figure 5-9.

o Explorer
=5 window_fn_prj
! Includes
= Source
[l window_fn_top.cpp
= Test Bench
= solution1

/ i.e. prependin

nclude the entire xhls_window_fn name
/ g ]
49 using namespace xhls_window_fn;

# constraints
W directives.tcl

W scriptcl
= csim k =
. : 55 win_fn_out_t outdata[WIN_LEN],
= build - . . .
- 56 win_fn_in_t indata[WIN_LEN])
= report o
58 // Instantiate a window_fn object - types and params defined in header ~
4 1] 3

Figure 5-9: C Code for Arbitrary Precision Lab 2

5. Hold the Control key down and click window fn top.h to open this header file.
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6. Scroll down to view the type definitions (Figure 5-10).

[l window_fn_top.cpp T window_fn_top.h 22 =0

54 // Types and top-level function prototype -
55#include <ap_int.h>

56 // Define widths of fixed point fields

57 #define W IN 8

58 #define IW IN 8

50 #define W OUT 24

60 #define IW OUT 8

1#define W COEF 18

#define IW COEF 2

// Define fixed point types for input, output and coefficients
5typedef ap fixed<W IN,IW IN> win_fn_in_ t;

typedef ap fixed<W OUT,IW OUT> win_fn_out t;

typedef ap fixed<W COEF,IW COEF> win_fn_coef t;

m

VIEn Sh Oh O Sh O O SN
CO =] O LN P Ly pa

)

P ~ - . . i . . . . O

1 b

s

Figure 5-10: Type Definitions for Arbitrary Precision Lab 2

This header file, window fn top.h, is the only file that is different from Lab 1. The data
types have been changed to ap_fixed point types, which are similar to float and double
types in that they support integer and fractional bit representations. These data types are
defined in the header file ap fixed.h. The definitions in the header file define sizes of
the data types:

« W_IN defines the total word length.
« IW_IN defines the number of integer bits.

«  The number of fractional bits is therefore the first term minus the second.

When you revise C code to use arbitrary precision types instead of standard C types, one of
the most common changes you must make is to reduce the size of the data types. In this
case, you change the design to use 8-bit, 24-bit, and 18-bit words instead of 32-bit float
types. This results in smaller operators, reduced area, and fewer clock cycles to complete.

Similar optimizations help when you change more common C types such as int, short, and
char. For example, changing a data type that only needs to be 18-bit from int (32-bit)
ensures that only a single DSP48 is required to perform any multiplications.

In both cases, you must confirm that the design still performs the correct operation and
that it does so with the required accuracy. The benefit of the arbitrary precision types
provided with Vivado High-Level Synthesis is that you can simulate the updated C code to
confirm its function and accuracy.

7. Open the Test Bench folder in the Explorer pane and double-click window_fn_test.cpp
to open the code.
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8. Scroll down to see the view shown in Figure 5-11.

[T Explorer 22 w* = 0| [g window_fn_top.cpp ‘H window_fn_top.h l<| window_fn_test.cpp & =0
£ window_fn_prj 76  window_fn_top(hw_result, testdata); -
[ Includes 7
= Source 78 // Check results
) 79 cout << "Checking results against a tolerance of " << ABS_ERR_THRESH << endl;
g window_fn_top.cpp 80 cout << fixed << setprecision(5);
@iz Test Bench 31 for (unsigned i = @; i < WIN_LEN; i++) {
le| window_fn_test.cpp 82 float abs_err = float(hw_result[i])} - sw_result[i];
= solutioni 83 #if WINDOW_FMN_DEBUG
# constraints 84 cout << "1 =" << i << "\thw_result = " << hw_result[i];
4 directivestcl 85 cout << "\t sw_result = " << sw_result[i] << endl;
W scripticl 86 fandif
. ) 87 if (fabs(abs_err) > ABS _ERR_THRESH) {
& csim 88 cout << "Error threshold exceeded: i = " << 1i;
= build 89 cout << " Expected: " << sw_result[i];
= report 99 cout << " Got: " << hw_result[i];
91 cout << " Delta: " << abs_err << endl; E
92 err_cnt++;
93 }
94 ¥
95 cout << endl; -

4 }

Figure 5-11: Test Bench for Arbitrary Precision Lab 2

The test bench for this design contains code to check the accuracy of the results. The
expected results are still generated using float types. Because of the difference in precision
between fixed point and floating point operations, the result checking verifies that the
results are within a specified range of accuracy (in this case, within 0.001 of the expected
result).

This allows the updated design to be validated quickly and efficiently in C, with fast compile
and run times.

9. Click the Run C Simulation toolbar button to open the C Simulation dialog box.

10. Accept the default setting (no options selected) and click OK.

The Console pane shows the results of the C simulation. With the updated data types, the
results are no longer identical to the expected results. However, they are within tolerance.

El Console 2 €] Errors| & Warnings ® % ERlE =B
<terminated > window_fn_prj.Debug [C/C++ Application] C\Vivado_HLS_Tutorial\Arbitrary_Precision\lab2\window_fn_prj\solution1\csim\build
i =24 hw result = 32 sw_result = 32.00000 -
i =25 hw_result = 25.757 sw_result = 25.75711
i =26 hw result = 19.754 sw_result = 19.75413
i =27 hw_result = 14.222 sw_result = 14.22175
i = 28 hw_result = 9.3721 sw_result = 9.37258
i =29 hw_result = 5.3926 sw_result = 5.39297
i =30 hw_result = 2.4355 sw_result = 2.43585
i =31 hw_result = 8.61426 sw_result = 0.61487

m

Test Passed

Figure 5-12: C Simulation Results for Fixed Point Types
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Step 2: Synthesize the Design and Review Results

1. Click the Run C Synthesis toolbar button to synthesize the design to RTL.

When synthesis completes, the synthesis report opens automatically. Figure 5-13 shows the
synthesis report.

Performance Estimates

= Timing (ns)
¢ Summary
Clock | Target | Estimated | Uncertainty
ap_clk 5.00 4.306 0.63

= Latency (clock cycles)

= Summary

Latency Interval

min | max | min | max | Type
a7 a7 97 97 | none

= Detail
# Instance

= Loop

Uitilization Estimates

=l Summary

Mame BRAM_18K | DSP43E FF LUT URAM
DspP - 1
Expression - = 0 26
FIFO
Instance
Memory 0 = 17 )
Multiplexer - = - 36
Register - = 39
Total 0 1 56 7 0
Awvailable 4320 6840 | 2364480 | 1182240 960
Available SLR 1440 2280 | 788160 | 394080 320
Utilization (%) 0 ~0 ~0 ~0 0
Utilization SLR (%5) 0 -0 ~0 ~0 0

Figure 5-13: Synthesis Report for Fixed Point Design

Note that through use of arbitrary precision types, you have reduced both the latency and
the area (by 40% and 50% respectively), and the operations in the RTL hardware are no
larger than necessary. Since the total number of bits in the memory is now less than
1024-bits, it is now automatically implemented with LUTs and FFs rather than with a block
RAM.

2. Scroll down the report to the Interface summary (Figure 5-14).

Figure 5-14 shows the data ports are now 8-bit and 24-bit.
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=l window _fn_top csynth.rpt &3 & El'_
Interface 3
- Summary
RTL Ports Dir  Bits Protocol Source Object C Type
ap_clk in 1 ap_ctrl_hs  window_fn_top return value
ap_rst in il ap_ctrl_hs = window_fn_top  return value
ap_start in 1 ap_ctrl_hs  window_fn_top return value
ap_done out at ap_ctrl_hs  window_fn_top return value
ap_idle out 1 ap_ctrl_hs  window_fn_top return value
ap_ready out 1 ap_ctrl_hs  window_fn_top return value
outdata_V_address0  out 5 ap_memory outdata_V array
outdata_V_ce0 out 1 ap_memory outdata_V array
outdata_V_we0 out 1 ap_memory outdata_V array
outdata_V_d0 out 24 ap_memory outdata_V array A
indata_V_address0 out 5 ap_memory indata_V array T
indata_V_ce0 out 1 ap_memory indata_V array
indata_V_g0 in 8 ap_memory indata_V array
N I »

Figure 5-14: Fixed Point Interface Summary

3. Exit the Vivado HLS GUI and return to the command prompt.

Conclusion

In this tutorial, you learned:

« How to update the existing standard C types to Vivado High-Level Synthesis arbitrary
precision types.

« The advantages in terms of hardware performance and area of using bit accurate
data-types.
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Chapter 6

Design Analysis

Overview

The general design methodology for creating an RTL implementation from C, C++, or
SystemC includes the following tasks:

« Synthesizing the design.
« Reviewing the results of the initial implementation.

» Applying optimization directives to improve performance.

You can repeat the steps above until the required performance is achieved. Subsequently,
you can revisit the design to improve area.

A key part of this process is the analysis of the results. This tutorial explains how to use the
reports and the GUI Analysis perspective to analyze the design and determine which
optimizations to apply.

This tutorial consists of a single lab exercise that:
« Demonstrates the HLS interactive analysis feature.

« Takes you through one design from the initial implementation through six steps and
multiple optimizations to produce the final optimized design.

As demonstrated throughout the tutorial, performing these steps in a single project gives
you the ability to compare the different solutions.

Lab 1 Description

Synthesize and analyze a DCT design. Use the insights from the design analysis to apply
optimizations and judge the effectiveness of the optimization.

High-Level Synthesis N Send Feedback 106
UG871 (v2020.1) August 7, 2020 www.xilinx.com [—\/—]


https://www.xilinx.com
https://www.xilinx.com/about/feedback/document-feedback.html?docType=Tutorials&docId=UG871&Title=Vivado%20Design%20Suite%20Tutorial&releaseVersion=2020.1&docPage=106

(: X”_INX® Chapter 6: Design Analysis

Tutorial Design Description

You can download the tutorial design file from the Xilinx Website. See the information in
Locating the Tutorial Design Files.

This tutorial uses the design files in the tutorial directory
Vivado HLS Tutoriall\Design Analysis.

The sample design used in the lab exercise is a 2-D DCT function. To highlight the design
analysis feature, your goal is to have this design operate with an interval of 125 or less. The
design should be able to process a new set of input data at least every 125 clock cycles.

Lab 1: Design Optimization

This exercise explains the basic operations of the GUI Analysis perspective and how you can
use it to drive design optimization.

ﬁ IMPORTANT: The figures and commands in this tutorial assume the tutorial data directory
Vivado HLS Tutorial is unzipped and placed in the location C:\Vivado HLS_ Tutorial. If the
tutorial data directory is unzipped to a different location, or if it is on a Linux system, adjust the few
pathnames referenced to the location at which you placed the Vivado HLS Tutorial directory.

Step 1: Create and Open the Project

1. Open the Vivado HLS Command Prompt.

- On Windows click Start > All Programs > Xilinx Design Tools > Vivado 2020.1 >
Vivado HLS > Vivado HLS 2020.1 Command Prompt.

o On Linux, open a new shell.

2. Using the command prompt window (Figure 6-1), change the directory to the Design
Analysis tutorial, lab1.

3. Execute the Tcl script to setup the Vivado HLS project, using the command:
vivado hls -f run hls.tcl, as shown in Figure 6-1.

High-Level Synthesis N Send Feedback 107
UG871 (v2020.1) August 7, 2020 www.xilinx.com [—\/—]


https://www.xilinx.com
https://www.xilinx.com/about/feedback/document-feedback.html?docType=Tutorials&docId=UG871&Title=Vivado%20Design%20Suite%20Tutorial&releaseVersion=2020.1&docPage=107

(: X”_INX® Chapter 6: Design Analysis

C:\Vivado_HLS_Tutorial\Arbitrary_Precision>cd ..

C:\VUivado_HLS_Tutorial>cd Design_Analysis

C:\Vivado_HLS_Tutorial\Design_Analysis>cd labl

C:\Uivado_HLS_Tutorial\Design_Analysis\labl1>vivado_hls -f run_hls.tcl

Figure 6-1: Setup the Design Analysis Tutorial Project

4. When Vivado HLS completes, open the project in the Vivado HLS GUI using the
command vivado hls -p dct prj as shown in Figure 6-2.

@I [HLS-18] Cleaning up the solution database.

@I [HLS-18] Setting target device to 'xcTk160tfbgi84-1"

@I [SYN-201] Setting up clock ‘'default’ with a period of 8ns.
Compiling ../../../../dct_test.cpp in debug mode
Compiling ../../../../dct.cpp in debug mode
Generating csim.exe

Test passed !

@I [SIM-1] CSim done with O errors.

@I [LIC-101] Checked in feature [HLS]

C:\Uivado_HLS_Tutorial\Design_Analysis\lab1>vivado_hls -

Figure 6-2: Open Design Analysis Project for Lab 1
Step 2: Review the Source Code and Create the Initial Design
1. Double-click the file dct . cpp in the Source folder to open the source code for review.

This example uses a DCT function. Figure 6-3 shows an overview of this code.
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Hierarchy Loops Dataflow
RD_Loop_Row:
RD_Loop_Col: \ 4

[a]
=
[
(&)
[a]

}

}
Row_DCT_Loop:
DCT_Outer_Loop:
DCT_Inner_Loop:
H
}
}
Xpose_Row_Outer_Loop:
Xpose_Row_Inner_Loop: °

}

}
Col_DCT_Loop:

Q_ DCT_Outer_Loop: {
I DCT _Inner_Loop:

[

(8] }

= }

}

Xpose_Col_Outer_Loop:
Xpose_Col_Inner_Loop: \
}

}

WR_Loop_Row:
WR_Loop_Col: v
}

}

*+

-

Figure 6-3: Overview of the DCT Design
« The left side of Figure 6-3 shows the code hierarchy.
o Top-level function dct has three sub-functions: read_data, dct_2d and write_data.
o Function dct_2d has a single sub-function dct_1d.
» The center of Figure 6-3 shows loops inside each of the functions.

« The right side of Figure 6-3 shows the how the data is processed through the functions
and loops.

o The read_data function executes, and the data is processed through loop
RD_Loop_Row, which has a sub-loop RD_Loop_Col.

o After the read_data function completes, function dct_2d executes.

o In function dct_2d, Row_DCT_Loop processes the data. Row_DCT_Loop has two
nested loops inside it: DCT_output_loop and DCT_inner_loop.

o DCT_inner_loop calls function dct_1d.
And so on, until the function write_data processes the data.

« Click the Run C Synthesis toolbar button to synthesize the design to RTL.
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Step 3: Review the Performance Using the Synthesis Report

When synthesis completes, the synthesis report opens automatically. Figure 6-4 shows the
performance section of the report.

Performance Estimates
= Timing (ns)

=l Summary

Clock | Target | Estimated | Uncertainty
ap_clk .00 4,143 1.00

= Latency (clock cycles)

= Summary

Latency Interval
min | max | min | max | Type
2035 | 2035 | 2935 | 2935 | none

= Detail
E Instance
Latency Interval
Instance Module | min | max | min | max | Type
grp_dct_2d_fu_152 | dct_2d 2644 | 2644 | 2644 | 2644 | none
it Loop
Latency Initiation Interval
Loop Mame min | max | lteration Latency | achieved | target | Trip Count | Pipelined
- RD_Loop_Row 144 144 18 - - 2 no
+ RD_Loop_Col 16 16 2 g nao
- WR_Loop_Row 144 144 18 - - 2 no
+ WR_Loop_Col 16 16 2 2 no

Figure 6-4: Report for Initial DCT Design

Figure 6-4 highlights the following information.

High-Level Synthesis

The clock frequency of 8 ns has been met.
The top-level design takes 2935 clock cycles to write all the outputs.

You can apply new inputs after 2935 clock cycles. This immediately reveals that the
design is not pipelined, but this fact is also noted in the report: type is set to none and
not pipelined.

The top level has a single instance, which has a latency and initiation interval of 2644.
- This block also has no pipelining and accounts for most of the clock cycles.

Notice that the functions read _data and write data are not noted here as
instances of the top level.

- Figure 6-5 shows that, during synthesis, these blocks were automatically inlined
(the hierarchy was removed).
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o High-level synthesis might automatically inline small functions to improve the
quality of results (QoR). You can prevent this by adding the Inline directive with the
-of £ option to any function being automatically inlined.

El Console &2 . 9] Errors| & Warnings EkRgE="10
Vivado HLS Console

WL [AL3~1IY ] ILdi'LLiy Lude Lrdaisiurmdoiunts ...

@I [HLS-18] Checking synthesizability ...

[XFORM-602] Inlining function 'read_data' into 'dct' (dct.cpp:128) automatically.
DI [XFORM-602] Inlining function 'write data' into 'dct' (dct.cpp:133) automatically.
@I [HLS-111] Elapsed time: 7.476 seconds; current memory usage: 70.6 MB.

@I [HLS-10] Starting hardware synthesis ...

@I [HLS-10] Synthesizing 'dct' ... -
< | il P

Figure 6-5: Automatic Optimization Reporting

« The loops in the read_data and write_data functions are therefore implemented at the
top level and are reported as loops in the top-level function (Figure 6-4).

« Each loop has a latency of 144 clock cycles. (Because the loops are not pipelined, there
is no initiation interval.)

« Using RD_Loop_Row as an example, you can see why the loop latency is 144.

o Sub-loop RD_Loop_Col has a latency of 2 cycles for each iteration of the loop
(iteration latency) and a tripcount of 8: 2 x 8 = 16 clock cycles total latency for the
loop.

- From RD_Loop_Row, it takes 1 clock to enter loop RD_Loop_Col and 1 clock cycle to
return to RD_Loop_Row. The iteration latency for RD_Loop_Row is therefore (1 + 16
+1) 18 clock cycles.

o RD_Loop_Row has a tripcount of 8 so the total loop latency is 8 x 18 = 144 clock
cycles.

« The total latency of 2935 cycles for the dct block is therefore:
o 144 clocks for the RD_Loop_Row block.
o Plus 2644 clock cycles for the dct_2d block.
o Plus 144 clock cycles for WR_Loop_Row.

o Plus a clock cycle to enter each of those three blocks.

To review the details of the instantiated sub-blocks dct_2d and dct_1d, open their respective
reports from the syn/report folder under solution1 in the Explorer pane.

You can also use the design analysis perspective to review these details in a more interactive
manner.

Step 4: Review the Performance Using the Analysis Perspective

Invoke the Analysis perspective any time after synthesis completes.
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1. Click the Analysis perspective button (Figure 6-6) to begin interactive design analysis.

[E=N Fol ™
: % Debug || Synthesis o Analysis
]
Figure 6-6: Opening the Analysis Perspective

The Analysis perspective consists of five panes, each of which is highlighted in Figure 6-7.
You use all of these in the tutorial. The module and loops hierarchies are shown expanded
(by default, they are shown collapsed).

{ﬂ Module Hierarchy 7 F = 8 ED Synthesis(solution1)(dct_csynth.rpt) =' Schedule Viewer(solution1) 2
Negative Slack BRAM DSP FF LUT Latency Interval Pipeline type l:l. - | @ s
v © dct - 5 1 246 964 2935 2936 none
o det 2d - 3 1 177 663 2644 2644 none Operation\Control Step | 0 | 1 | 2 | 3 | 4 | 5 | g | 7 |
RD_Loop_Row i\l RD Loop Row i H H i
=] N " = - - LELHELL
&~ Performance Profile &2 | . Resource Profile + = 8 1 T H 1 1 1 1
det_2d(function) : ; : : : 1 1 !
Pipelined Latency [Iteration Latency  Initiation Interval  Trip count WR_Loop_Row H | H | 1i...=WR Loop Row_ |
v e dit - 2035 - 2936 - | I N ] T N | I
@ RD_Loop_Row no 144 18 - 8 H H H H H H H H
@ WR_Loop Row no 144 18 - 8 i i i i i i i i
i 1 i i 1 i i 1

Figure 6-7: Overview of the Analysis Perspective

Use the Module Hierarchy pane to navigate through the hierarchy. The Module Hierarchy
pane shows both the performance and area information for the entire design. The
Performance Profile pane shows the performance details for this level of hierarchy. The
information in these two panes is similar to the information you reviewed earlier in the
report (for the top-level dct block).

The Schedule Viewer is also shown (on the right side of Figure 6-8). This view shows how
the operations in this particular block are scheduled into clock cycles.

« The left column lists the resources.
o Sub-blocks are shown in blue text.
o Operations resulting from loops are labeled and expandable.
- Standard operations are also shown.

» Notice that the dct has three main blocks:

- Aloop called RD_Loop_Row. The plus symbol (+) indicates that the loop has
hierarchy and that you can expand the loop to view it.

o A sub-block called dct_2d.
o Aloop called WR_Loop_Row.

The top row lists the control states in the design. Control states are the internal states
High-Level Synthesis uses to schedule operations into clock cycles. There is a close
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correlation between the control states and the final states in the RTL Finite State Machine
(FSM), but there is no one-to-one mapping.

2. Click loop RD_Loop_Row and sub-loop RD_Loop_Col to fully expand the loop hierarchy
(Figure 6-8).

&' Schedule Viewer(solution1) 3

OperationtControl Step

~ RD_Loop_Row - RD_Loop_Row E E E
r_0_i(phi_musx) i i i ! ! !
icmp_ln101(icrmp) ! H ! H
r(+) : : : :
RD_Loop_Col E E E

1 I 1

dct_2d(function)

[
=)
=)
b i el i e
5]
=)
ys]
(R
=3

T
I
~ WR_Loop_Row i - WR_Loop_Row
r_0_i2(phi_mux) i i i i
icmp_In113(icmp) E E E E
r1(+) I : i I
WR_Loop_Col : I -WR _I.Ioop =

Figure 6-8: Expanded View of RD_Loop_Row

From this, you can see that in the first state (C1) of the RD_Loop_Row, the loop exit
condition is checked and an add operation performed. This addition is likely the counter for
the loop iterations, and we can confirm this.

3. Select the adder in state C1, right-click and select Go to Source (Figure 6-9).

This opens the C source code to highlight the operation in the C source that created this
adder. From the details on screen (also shown in Figure 6-9), you can determine it is indeed
the loop counter. It is the only addition on this line, and the variable is named “r".
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= Schedule Viewer(solution1) &3

| |#m mp | & @ 32 || Focus Off b g

Operation\ Control Step | 0 | 1 | 5 | 3 | 4

v RD_Loop_Row - RD_Loop_Row

==

r_0_i(phi_muz) - ;—3

icmp_ln101(icrp) T
ri+) :
RD_Loop_Col

det_2d(function)

WR_Loop_Row

- RD Loop Col

R_Loop Row

o e e [ | e

Schedule Viewer | Resource Viewer

i Properties | & Warnings | |.¢| C Source 2

File: C\Vivado_HLS_Tutorial\Design_Analysisilab\dct.cpp

100 intr, c;

m

102 RD_Loop_Row:

103 for(r=0r < DCT_SIZE; r++] {

104 RD_Loop_Cal:

105 for(c=0,c<DCT_SIZE; c++)

106 buf[r][c] = inputlr * DCT_SIZE + c];
107 }

108}

Figure 6-9: C Source Code View

In the next state of loop RD_Loop_Row (state C2), loop RD_Loop_Col starts to execute.

4. Click any of the operations in the RD_Loop_Col to see the source code highlighting
update.

This should help confirm your understanding of how the operations in the C source code
are implemented in the RTL.

« The loop exit condition (¢ < DCT_SIZE ) is checked.
« This is an adder for loop count variable “c”.

« Aread from a RAM performed (one cycle to generate the address, one cycle to read the
data).

« A write operation is performed to a RAM.

Loops in the Schedule Viewer mean that the design iterates around these states multiple
times. The number of iterations is noted as the loop tripcount and shown in the
Performance Profile.
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High-Level Synthesis

To improve performance, these loops should be pipelined. You can review the rest of the
design for other performance optimization opportunities.

5. Click the X in the C Source pane tab to close this window.

6. In the Module Hierarchy pane, click the function dct_2d to navigate into the view for
this function (Figure 6-10).

Operation\Control Step | 0 ] | 5 3 | 4 | 5 6 | Z 8 | 9 | 10
Row_DCT_Loop i - Rnwl DCT o :l :I : i| i i i i
Apose_Row_Outer_Loop : : : = }Eposle Row .O"'ter e 1 ! : : :
Col DCT_Loop ! ! ! ! ! - Col DCT L... ! ! !
Xpose_Col_Outer_Loop i i i i i i il i - ){polsF Col ICiuter =

Figure 6-10: DCT_2D Schedule Viewer

Again, you can see a number of loops (shown in Figure 6-11). Loops ensure the design will
have small area but the design will take multiple iterative states to complete. Each iteration
of the loop will complete before the next iteration starts.

You can pipeline the loops to improve the performance. The details in the Performance
Profile show that most of the latency is caused by loops Row_DCT_Loop and Col_DCT_Loop.

7. Click loops Row_DCT_Loop and Col_DCT_Loop of the dct_2d block in the Schedule
Viewer to fully expand them, as shown in Figure 6-11.

Expanding these loops in Schedule Viewer shows both loops call function dct_1d2. Unless
this function itself is pipelined, there is no benefit in pipelining the loop. The Module
Hierarchy shows the interval for dct_1d2 is 145 clock cycles, which means it can only accept
a new input every 145 clock cycles.

8. In the Module Hierarchy, click function dct_1d2 to navigate into the view for this
function.

9. Expand the loops in the Performance Profile and Schedule Viewer to see the view
shown in Figure 6-11.

£ Module Hierarchy 7 B = 5 || Schedule Viewer(solution) 5
Negative Slack BRAM DSP FF LUT Latency Intervel Pipeline type [ e @ e 3 |Focuson
v o dat - S 1 M5 9642035 2036  none
v e detad . 3 1177 663 2644 2644 none Operation\Control Step | a | q | P | 3 | A | z | g | = | : | | = |
o det_1d2 - 0 1 8 196145 145 none .
~ Row DCT Loop TRow DCT . i
i 0(phi_muw) i
28 performance Profile 2 ™ |=. Resource Profile mE =0 icmp_In74(icmp) E
Pipelined Latency Iteration Latency Initiation Interval  Trip count i) i
v e e SERE RS 264 : i o i i i
® Row_DCT_Loop ne 1 147 . 8 Posefow_Julereop oMo A i
v Col.DCT Loap TColDCTL.
o Xpose Row_Outer Loop no w1 - 8 2o e y
& Col DCT Loop no nE 7 8 e I3 ) i‘
o Xpose_Col_Outer_Loop no w1 g - !
i4(+) i
det_ld2(function)
Xpose_Col_Outer_Loop :| ~¥pose Col Ouier .,
] e

Figure 6-11: DCT_1D Schedule Viewer
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In Figure 6-11 you can see a series of loops (Row_DCT_loop, Col_DCT_Loop) that can be
pipelined.

You can choose to do one of the following:

« You can pipeline the function and then pipeline the loop that calls it. (Because the
function is pipelined, the loop can take advantage of using a pipelined part.)

» You can pipeline the loops within this function and simply make this function execute
faster.

Pipelining the function unrolls all the loops within it, and thus greatly increases the area. If
the objective is to get the highest possible performance with no regard for area, this may be
the best optimization to perform.

You can find more details on pipelining loops and functions in the Chapter 7, Design
Optimization tutorial. For this case, the approach is to optimize the loops and keep the area
at a minimum.

10. Click the Synthesis perspective button to return to the main synthesis view.

E=8 Eol ™™
35 Debug [s | Synthesis |5 Analysis

QOutline 2 .4 Directive =

Figure 6-12: Re-Opening the Synthesis Perspective

Step 5: Apply Loop Pipelining and Review for Loop Optimization
In this step, you create a new solution and add pipelining directives to the loops.

When pipelining nested loops, it is generally best to pipeline the inner-most loop. Typically,
High-Level Synthesis can generally flatten the loop nest automatically (allowing the outer
loop to simply feed the inner loop). For more information on why it is better to perform
certain loop optimizations rather than others, see the Chapter 7, Design Optimization
tutorial.

1. Select the New Solution toolbar button or use the menu Project > New Solution to
create a new solution.

2. Click Finish and accept the defaults.
Ensure that the C source code file (dct.cpp) is open in the Information pane.

3. Inthe Directive tab, add a pipeline directive to loop DCT_Inner_Loop in function dct_1d.

a. Ensure dct.cpp is open and selected to view the code in the Directive pane.
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b. Right-click DCT_Inner_Loop in the Directive pane and select Insert Directive.

c. In the Directive Editor dialog box activate the Directive drop-down menu at the top
and select PIPELINE.

d. Click OK to select the default maximum pipeline rate (l1=1).

4. Repeat step 4 for the following loops:

a. In function dct 2d loop Xpose Row_ Inner Loop

b. In function dct_ 2d loop Xpose Col Inner Loop

Cc. In function read data loop RD Loop Col

d. In function write data loop WR_Loop Col

The Directive pane shows the following (highlighted) optimization directives applied.

o= Outline |4 Directive &3 =08

4 @ dct_1d il
®[1 dct_coeff_table
4 %" DCT_Outer_Loop
4 %" DCT_Inner_Loop
% HLS PIPELINE
4 @ dct_2d
=1 row_outbuf
#[1 col_outbuf
=[] col_inbuf
%" Row_DCT_Loop
4 %" Xpose_Row_Outer_Loop
ad Xpose_Row_Inner_Loop
% HLS PIPELINE
% Col_DCT_Loop
4 %" Xpose_Col_Outer_Loop
4 %" Xpose_Col_Inner_Loop
% HLS PIPELINE
4 @ read_data
4 %" RD_Loop_Row
4% RD_Loop_Col
% HLS PIPELINE
4 @ write_data
4 %" WR_Loop_Row
4% WR_Loop_Col
% HLS PIPELINE
4 @ dct N

Figure 6-13: Optimization Directive for DCT Loop Pipelines

5. Click the Run C Synthesis toolbar button to synthesize the design to RTL. If a file was
modified, please select YES.

6. When synthesis completes, use the Compare Reports toolbar button or the menu
Project > Compare Reports to compare solutions 1 and 2.

High-Level Synthesis
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High-Level Synthesis

Figure 6-14 shows the results of comparing solution1 and solution2. Pipelining the loops
has improved the latency of the design with an almost 50% reduction in solution2.

Performance Estimates

= Timing (ns)
Clock solutionl | sclution2
ap_clk | Target 2.00 2.00

Estimated | 4.143 4,143
- Latency (clock cycles)

solutionl | solution2

Latency | min | 2935 1723

max | 2935 1723
Interval | min | 2935 1723

max | 2935 1723

Figure 6-14: DCT Solutionl and Solution2 Comparison
Next, you once again open the Analysis perspective, analyze the results, and determine
whether or not there are more opportunities to for optimization.

7. Click the Analysis perspective button to begin interactive design analysis.

When the Analysis perspective opens, you can see that the majority of the latency is still
due to block dct_2d. Before proceeding to analyze further, you can review how the loops at
this level have been optimized.

The Performance Profile (Figure 6-15) shows that the latency of both loops has been

reduced from 144 clock cycles in solution1 to only 64 clock cycles.

£ Performance Profile 53 | . Resource Profile H EF & O

Pipelined Latency leration Latency Initiation Interval = Trip count

v @ dct - 1723 - 1724
@ RD_Loop_Row_RD_Loop_Col  yes o4 2 1 b4
@ WR_Loop_Row WF_Loop_Col yes o4 2 1 b4

Figure 6-15: DCT Solution2 Performance of Top-Level Loops

Pipelining loops transforms the latency from
Latency = iteration latency * tripcount
to

Latency = iteration latency + (tripcount * interval)
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Vivado HLS also made this possible by automatically performing loop flattening (there is no
longer any loop hierarchy). You can see this by reviewing the Console pane, or log file, for
solution2. Figure 6-16 shows the loops that have been automatically optimized.

B Console 22 . @] Errors| & Wamnings| BREE<="C0
Vivado HLS Console

ET pTTTiTT TTD§ STSIIITg CITTIISIIT L SIT=rIIm o DiIT TIT o §IIITIFFTITZ STIImIISITEDZ

@I [XFORM-602] Inlining function 'write_data' into "dct' (dct.cpp:94) automatically. ]

[XFORM-541] Flattening a loop nest 'RD_Loop Row' (dct.cpp:59) in function 'dct’.
[XFORM-541] Flattening a loop nest 'WR_Loop Row' (dct.cpp:71) in function 'dct’.
[XFORM-541] Flattening a loop nest 'Xpose Row Outer_ Loop"' (dct.cpp:37) in function 'dct_2d'.
[XFORM-541] Flattening a loop nest 'Xpose Col Outer loop' (dct.cpp:48) in function 'dct 2d'.
[HLS-111] Elapsed time: 12.191 seconds; current memory usage: 30.6 MB.

@I [HLS-10] Starting hardware synthesis ...
@T THIS-181 Sunthacizving "drt'
[« 1 | »

Figure 6-16: DCT Solution2 Loop Flattening

8. In the Module Hierarchy, click function dct_2d to navigate into the view for this
function.

In the Performance Profile you can see that the latency of all the loops has been
substantially reduced (Row_DCT_Loop and Col_DCT_loop have been approximately halved
from the earlier report in Figure 6-10). However, the majority of the latency is still due to
these two loops, each of which calls the dct_1d block.

9. In the Module Hierarchy, click function dct 1d2 to navigate into the view for this
function.

The Performance Profile (Figure 6-17) shows the loop latencies have been reduced, but
there is still a loop hierarchy here. (There is still loop DCT_Outer_Loop, shown in
Figure 6-17, so no loop flattening occurred).

p
EF Performance Profile 52 . | _ Resource P‘rofilew B = O
Pipelined Latency Iteration Latency |Initiation Interval  Trip count
. . ..... . ct_1d2 ) . ) .
v @ DCT_Outer_Loop nao 23 11 - a
@ DCT_lnner_Loop  yes 8 2 1 8

Figure 6-17: DCT Solution2 Performance of dct_1d Loops

Viewing these loops in Performance profile shows why this loop was not optimized further.

10. In the Performance Profile, click loops DCT_Outer Loop and DCT_ Inner Loop to
view the loop hierarchy (Figure 6-18).

11. Select the write operation in state C3.

12. Right-click and select Go to Source.
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Figure 6-18 shows that this loop was not flattened because additional operations outside of
DCT Inner Loop, atthelevel of DCT Outer Loop, prevented loop flattening. One of the
operations that prevented loop flattening is highlighted in Figure 6-18, below.

Operation\Control Step |

w
&

dst_offset_read(read)
src_offset_read(read)
« DCT_Outer_Loop

k_olphi_mux)
icmp_In56(icmp)
l(+)
add_In64_1(+)

» DCT_Inner_Loop
add_In6al+)

dst_addr_write_In64{write)

o

_Outer_Loop

-DCT.

el inn
T

Loop li=

T . W———

R N—— N P ——

Schedule Viewer | Resource Viewer|

[ Properties | & Warnings | [& C Source 2 B Console

File: /group/bcapps/scampbell/Designs/UGE71_2020_lworking/Design_~Analysis/labl/dct.cpp
S8 for (k = 0; k <= DCT_SIZE; k++) {
S9DCT_Inner_Loop:

60 for(n = 0, tmp = 0; n < DCT_SIZE; n++) {
61 int coeff = (int)dct_coeff_tablel[k][n];
62 tmp += srcln] * coeff;

63 128

64 dst[k] = DESCALE(tmp, CONST_BITS);

65 }

66}

Figure 6-18: DCT Solution2 dct_1d Schedule Viewer

The write to the array cannot be flattened into the inner loop. To achieve an interval of 1 on
DCT Outer Loop you will need to pipeline the output loop - there is no benefit in simply
pipelining the inner loop itself.

You should pipeline the outer loop instead. This causes the inner loop to be completely
unrolled. An increase in area results, but you are still far from the throughput goal of 125
and not yet ready to pipeline the entire function (and see an even greater area increase, as
the outer loop is also completely unrolled).

13. Click the Synthesis perspective button to return to the main synthesis view.

Step 6: Apply Loop Optimization and Review for Bottlenecks

1. Select the New Solution toolbar button or use the menu Project > New Solution to
create a new solution.

2. Click Finish and accept the defaults to create solution3.
3. Ensure the C source code is visible in the Information pane.
4. In the Directive tab

a. In function dct_1d, select the pipeline directive on loop DCT_Inner_Loop.
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b. Right-click and select Remove Directive.
c. Still in function dct_1d, select loop DCT_Outer_Loop.
d. Right-click and select Insert Directive.

e. In the Directive Editor dialog box activate the Directive drop-down menu at the
top and select PIPELINE.

f. Click OK to select the default maximum pipeline rate (Il1=1).

The Directive pane should show the following (highlighted) optimization directives applied.

o= Outline |4 Directive &3 =

4 @ dct_1d -
#[1 dect_coeff_table
4 %" DCT_Outer_Loop
% HLS PIPELINE
%" DCT_Inner_Loop
4 @ dct_2d
=[1 row_outbuf
#[1 col_outbuf
=[] col_inbuf
%" Row_DCT_Loop
4 %" Xpose_Row_Outer_Loop |
a Xpose_Row_Inner_Loop
% HLS PIPELINE
%' Col_DCT_Loop
4 %" Xpose_Col_Outer_Loop
4 %" Xpose_Col_Inner_Loop
% HLS PIPELINE
read_data
4 %' RD_Loop_Row
4 %' RD_Loop_Col
% HLS PIPELINE
4 @ write_data
4 %' WR_Loop_Row
4 ' WR_Loop_Col
% HLS PIPELINE
4 @ dct -

[
@

Figure 6-19: Updated Optimization Directives for DCT Loop Pipelines
5. Click the Run C Synthesis toolbar button to synthesize the design to RTL.

6. When synthesis completes, click the Compare Reports toolbar button to compare
solutions 2 and 3.

Figure 6-20 shows the results of comparing solution2 and solution3. Pipelining the
outer-loop has in fact resulted in an increase to the performance and the area.

The significant latency benefit is achieved because multiple loops in the design call the
dct_1d function multiple times. Saving latency in this block is multiplied because this
function is used inside many loops.
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Performance Estimates

=| Timing (ns)

Clock solutiond | solution3

ap_clk | Target 3.00 2.00
Estirated | 4.143 £.351

- Latency (clock cycles)

solutiond | solution3
Latency | min | 1723 243
max | 1723 243
Interval | min | 1723 243
max | 1723 243

Utilization Estimates

solutiond | selution3
BRAM_1BK | 5 5
DSP4RE 1 ]
FF 223 546
LUT 1211 1356
URAM 0 1]

Figure 6-20: DCT Solution2 and Solution3 Comparison

In this case, the report indicates the clock period for solution3 is larger, but can still be
achieved. Vivado HLS will sometimes create a design in which the estimated clock period
fails to meet the required clock period. Typically, the design will meet timing after RTL
synthesis - in this case, you can confirm this by using the Export RTL feature and selecting
Evaluate. In the event you encounter a case where the design fails to meet timing after RTL
synthesis, use LATENCY directive in conjunction with regions in the C code to force Vivado
HLS to register intermediate points on the failing RTL path.

Now that all the loops are pipelined, it is worthwhile to review the design to see if there are
performance-limiting "bottlenecks.” Bottlenecks are limitations in the flow of data that can
prevent the logic blocks from working at their maximum data rate.

Such limitations in the data flow can come from a number of sources, for example, 1/0 ports
and arrays implemented as block RAM. In both cases, the finite number of ports (on the I/0
or block RAM) limits the rate at which data can be read or written.

Another source of bottlenecks is data dependencies in the original source code. In some
cases, these data dependencies are inherent in how the algorithm operates, as when a
calculation cannot be performed until an earlier calculation has completed. Sometimes,
however, the use of an optimization directive or a minor change to the C code can remove
them.

The first task is to identify such issues in the RTL design. There are a number of approaches
you can take:
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« Start with the largest latency or interval in the Module Hierarchy report and navigate
down the hierarchy to find the source of any large latency or interval.

« Click the Resource Profile to examine I/O and memory usage.

« Use the power of the graphical viewer and look for patterns in the Schedule Viewer
which indicate a limitation in data flow.

In this case, you will use the latter approach. You can use the Analysis perspective to
identify such places in the design quickly.

7. Click the Analysis perspective button to begin interactive design analysis.
8. In the Module Hierarchy, ensure module dct is selected.

9. In the Schedule Viewer, expand the first loop in the design as shown in Figure 6-21,
RD_Loop Row RD Loop_ Col (these loops were flattened and the name is now a
concatenation of both loops).

This loop is implemented in two states. The red arrow in Figure 6-21 shows the path from
the start of the loop to the end of the loop: the arrow is almost vertical (everything happens
in two clock cycles) and this loop is well implemented in terms of latency.

Operation\Control Step | 0 | 1 | 2 | 3 | 4 | 5 | [ |

w RD_Loop_Row RD_Loop_Col
indvar_flatten(phi_muz)
r_0_i{phi_muzx)
c_0_i{phi_mux)

k RD_Loop Rof RD Loop C...
\ i i

icmp_In103{icmp)

add_[n103(+)

r(+)

icrmp_In103(icrmp)

select_In103(zelect)

select_In103_1(select)

add_In106(+)

input_load(read)

ci+)

add_In106_1(+)

buf_2d_in_addr_write_In106(write)
det_2difunction)
WR_Loop_Row WR_Loop_Col

X

=

-

- WR_Loop P.t#v WR_Loop._...
T T

Figure 6-21: Analysis of DCT RD_Loop_Row

10. In the Schedule Viewer, expand the WR_Loop_Row_WR_Loop_Col and perform similar
analysis. It is similarly well optimized for latency.

11. Click function dct_2d and navigate into the dct_2d function.

You can use same analysis process down through the hierarchy. If you perform this analysis
you will discover that all the function blocks and loops have a similar optimal (few cycles)
implementation, until the dct_1d block is examined.

12.In the Schedule Viewer, expand the Row DCT Loop to navigate into the loop.
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13.In the Schedule Viewer, click function dct _1d2 and navigate into the dct_1d2
function.

14. Expand the DCT _Outer Loop to see the view shown in Figure 6-22.

Figure 6-22 shows a very different view from the earlier loop schedules (which had only a
few cycles of latency). The schedule shows a long drift from input to output (as shown by
the red arrow).

Figure 6-22 shows the analysis of dct _1d RD_ Loop Row.

~ DCT_Quter_Loop - DCT_Outer Loop ii=4

k_O(phi_rmuzx) "‘
icmp_In35(icmp) A
ki+) i

add_In63_8(+)
dct_coeff_table_0_lo(read)
src_load(read)
dct_coeff_table_1_lo(read)
src_load_1(read)
dct_coeff_table_ 2 lo(read)
dct_coeff_table_3_lo(read)
dct_coeff_table 4 lo(read)
dct_coeff_table_5_lo(read)
dct_coeff_table_ 6 _lo(read)
dct_coeff_table_7_lo(read)
mul_In&1(%)

mul_In&1_1{%)
src_load_2(read)

src_load_3(read) l
add_In63_1(+) A
mul_In61_2(%) \i
mul_In61_2(") 1

src_load_S(read)
src_load_7(read)
add_InB3_2(+)
src_load_4(read)
mul_In&1_5(%)
src_load_B(read)
mul_In&1_7(%)
add_In63_3(+)
add_InB3_3(+)
mul_In&1_4{%)
mul_In&1_6(%)
add_In63_4(+)
add_InB3_6(+)
add_InB3_7(+)
add_InB3(+)
dst_addr_write_In&3{write)

7’

e

4
A e | -

]
i

Figure 6-22: Analysis of dct_1d RD_Loop_Row

There are typically two things that cause this type of schedule: data dependencies in the
source code and limitations due to I/O or block RAM. You will now examine the resources
sharing in this block.
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15. In the Analysis View, click the Resource Viewer tab at the bottom of the window.

16. Expand the Memory Ports, as shown in Figure 6-23.

Operation\Control Step |

%]
L
N
o

0 | 1

[+]1/O Ports
v [+]Memory Ports

det_coeff_table_7(p0) read
dct_coeff_table_4(p0)
dct_coeff_table_3(p0)
src(pl)
det_coeff_table_2(p0)
dct_coeff_table_6(p0)
src(pl)
det_coeff_table_1(p0)
det_coeff_table_0(p0)
dct_coeff_table_3(p0)
dst(pl)

[+]Expressions

=N

- NN

write

—3-3-i-73-17-4-1-

Figure 6-23: Resource Sharing of Memory Ports in DCT_1d

The Resource view shows how the resources in the design are used in different control
states.

The rows list the resources in the design. In Figure 6-23, the memory resources are
expanded.

The columns show the control states in which the resource is used. If a resource is active in
multiple states, the resource is being re-used in different clock cycles.

Figure 6-23 shows the memory accesses on block RAM src are being used to the maximum
in every clock cycle. (At most, a block RAM can be dual-port and both ports are being used).
This is a good indication the design may be bandwidth-limited by the memory resource. To
determine if this really is the case, you can examine further.

17. Select one of the read operations for the src block RAM.

18. Right-click and select Goto Source to see the view shown in Figure 6-24.
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Operation\Contral Step | 0 | 1 | 2 | ] | 4 | 5 |
[+]1/Q Parts )
v [+]Memory Ports
dct_coeff_table_7(p0) read
dct_coeff_table_4(p0) rpiad
det_coeff_table 3(p0) - d
sre(p0) —a e = reard
dct_coeff_table_2(p0) read
dct_coeff_table_6(p0) rpiad
srcipl) e e ey reard
det_coeff_table_1(p0) read
dct_coeff_table_0(p0) read
dct_coeff_table_5(p0) reard
dst(p0) I wite
[+1Expressions v N
< > [ [ [ [ I

schedule Viewer | Resource Viewer
] Properties | & Warnings | [¢] C Source &3

File: C\Vivado_HL5_Tutorial\Design_Analysisilabl\dct.cpp

56 DCT_Outer_Loop:

57 for(k=0;k<DCT_SIZE; k++) {

58 DCT_Inner_Loop:

59  forin=10,tmp=0;n < DCT_SIZE; n++) {
60 int coeff = (int)dct_coeff_table[K][n];
61 trnp += srcfn] * coeff;

i
63 dsifk] = DESCALE(imp, CONST_BITE);

Figure 6-24: Memory Resource SRC and Source Code

Figure 6-24 shows this read on the src variable is from the read operation inside loop
DCT Inner Loop. This loop was automatically unrolled when DCT Outer Loop was
pipelined and all operations in this loop can occur in parallel (if data dependencies allow).

The eight reads are being forced to occur over multiple cycles because the array src is
implemented as a block RAM in the RTL and a block RAM can only allow two reads
(maximum) in any one clock cycle. In Figure 6-24, the read operations take 2 clocks cycles:
a cycle to generate the address for the block RAM and a cycle to read the data. Only the
launch (address generation cycle) is shown because it overlaps with the operation in the
next clock cycle.

You can optimize the block RAM accesses using optimization directives to partition the
block RAM. The array that function dct_1d accesses is defined as an input argument to the
function and therefore resides outside this block.

« The input array to the first instance of dct _1dis buf 2d in in function dct.

« The input array to the second instance of dct_1d is col inbuf in function dct_2d.

In both cases, the arrays are 2-dimensional of size DCT_SIZE by DCT_SIZE (8x8). By default,
this results in a single block RAM with 64 elements. Because the arrays are configured in the
code in the form of Row by Column, we can partition the second dimension and create eight
separate Block RAMs: one for each row, allowing the row data to be accessed in parallel.
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19. Click the Synthesis perspective button to return to the main synthesis view.

Step 7: Partition Block RAMs and Analyze Concurrency

1. Select the New Solution toolbar button or use the menu Project > New Solution to
create a new solution, solution4.

2. Click Finish and accept the defaults to create solution4.
3. Ensure the C source code is visible in the Information pane.
4. In the Directive tab:

a. Infunction dct, select array buf 2d_in.

b. Right-click and select Insert Directive.

¢. In the Directive Editor dialog box, activate the Directive drop-down menu at the
top and select ARRAY_PARTITION.

d. Set the type to Complete.

e. Change the dimension setting to 2 to partition the array along the second
dimension.

f. Click OK.

5. Repeat this process for array col inbuf in function dct_2d.

The Directive pane displays optimization directives, as shown in Figure 6-25 (the two new
directives are highlighted).
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Figure 6-25: Optimization Directives for Array Partitioning
6. Click the Run C Synthesis toolbar button to synthesize the design to RTL.

7. When synthesis completes, use the Compare Reports toolbar button to compare
solutions 3 and 4.

Figure 6-26 shows the results of comparing solution3 and solution4. Improving access to
the data in the src block RAM in the dct_1d block has improved the overall performance
because the dct_1d block executes frequently.
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Figure 6-26:

Performance Estimates

-] Timing (ns)
Clock solution3 | sclutiond
ap_clk | Target 2.00 8.00

Estimated | €351 £.904
- Latency (clock cycles)

solution3 | solutiond

Latency | min | 243 477

max | 843 477
Interval | min | 243 477

max | 843 477

Chapter 6: Design Analysis

DCT Solution3 and Solution4 Comparison

You can review the impact of the partitioning directive on the device resource.

8. Click the Analysis perspective button to begin interactive design analysis.

9. In the Module Hierarchy, ensure module dct is selected.

10. Select the Resource Profile tab in the lower-left.

11. Expand the Memories and Expressions, see the view in Figure 6-27.
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The Resource Profile shows the resources being using at the current level of hierarchy (the

block selected in the Module Hierarchy pane). Figure 6-27 shows:

« This block has two 1/O ports.
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« Most of the area is due to instances (sub-blocks) within this block.

« There are nine memories, eight of which are the partitioned buf_2d_in block RAM. Since
they are less than 1024 bits they are automatically implemented as LUTRAM.

« Most of the logic (expressions) at this level of hierarchy is due to adders, with some due
to comparators and selectors.

The important point from the previous optimization is that you can see there are now
additional memories due to the array partitioning optimization.

You still have a goal to ensure that the design can accept a new set of samples every 125
clock cycles. The synthesis report, however, shows that you can only accept new data every
477 clocks. This is much better than the original, pre-optimized design (approx. 2600 clock
cycles), but further optimization is required.

Up to this point, you have focused on improving the latency and interval of each of the
individual loops and functions in the design. You must now apply the dataflow
optimization, which enables the individual loops and functions to execute in parallel, thus
improving the overall design interval.

12. Click the Synthesis perspective button to return to the main synthesis view.

Step 8: Partition Block RAMs and Apply Dataflow Optimization

1. Select the New Solution toolbar button or use the menu Project > New Solution to
create a new solution, solution5.

2. Click Finish and accept the defaults to create solution5.
3. Ensure the C source code is visible in the Information pane.
4. In the Directive tab:

a. Select the top-level function dct.

b. Right-click and select Insert Directive.

c. In the Directive Editor dialog box activate the Directive drop-down menu and
select DATAFLOW.

d. Click OK.

The Directive pane now displays the following optimization directives (the new directive is
highlighted).
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Figure 6-28: Dataflow Optimization for the DCT Design
5. Click the Run C Synthesis toolbar button to synthesize the design to RTL.

6. When synthesis completes, use the Compare Reports toolbar button or the menu
Project > Compare Reports to compare solutions 4 and 5.

Figure 6-29 shows the results of comparing solution4 and solution5, and you can see the
interval has improved. The design takes 476 clocks cycles to produce the outputs but can
now accept new inputs every 343 clocks.
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Performance Estimates

- Timing (ns)

Clock solutiond | solution3

ap_clk | Target 2.00 2.00
Estimated | £.904 £.904

-] Latency (clock cycles)

solutiond | solution3
Latency | min | 477 478
max | 477 478
Interval | min | 477 343
rmax | 477 343

Figure 6-29: DCT Solution4 and Solution5 Comparison

This is still greater than the 125 cycles required, so you must analyze the current
performance.

7. Click the Analysis perspective button to begin interactive design analysis.

8. In the Module Hierarchy, you can see dct _dct 2d accounts for most of the interval.
Ensure module dct_2d is selected to see the view in Figure 6-30.

#] Module Hierarchy H F = 0
Megative Slack BRAM  DSP FF LUT Latency Interval Pipelinetype
v ¥ dct - 3 2 1009 1654 476 343 dataflow
v @ dct_2d - 2 2 684 1171 342 342 none
@ dct 1d - ] g 350 200 1 11 none
@ write_data - ] 0 32 186 66 66 none
@ read_data - 0 0 29 171 66 i3] none
EEI Performance Profile 23 | Resource Profile 7 F = 8
Pipelined Latency Iteration Latency Initiation Interval  Trip count
w @ dct_2d - 342 - 342 -
@ Row DCT_Loop no 104 13 - 2
@ Xpose_Row_Outer_Loop_Xpose Row_|nner_Loop yes b4 2 1 b4
@ Col DCT Loop no 104 13 - 2
@ Xpose_Col_Outer_Loop_Xpose_Col_lnner_Loop  yes 64 2 1 64

Figure 6-30: DCT Analysis View after Dataflow Optimization

Here, you can see two things:

« The interval of the dct block is less than the sum of the individual latencies (for
read data, dct_2d and write data). This means the blocks are operating in
parallel.

« The interval of dct is nearly the same as the interval for sub-block dct _2d. The
dct_2d block is therefore the limiting factor.
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Because the dct_2d block is selected in the Module Hierarchy the Performance Profile
shows the details for this block. Figure 6-31 shows the interval is the same as the latency, so
none of these blocks operate in parallel.

One way to have the blocks in dct_2d operate in parallel would be to pipeline the entire
function. This, however, would unroll all the loops, which can sometimes lead to a large area
increase. An alternative is use dataflow optimization on function dct 2d.

Another alternative is to use a less obvious technique: raise these loops up to the top-level
of hierarchy, where they will be included in the dataflow optimization already applied to the
top-level. This can be achieved by using an optimization directive to remove the dct_2d

hierarchy: inline the dct_2d function.

Before performing this optimization, review the area increase caused by using dataflow
optimization.

9. In the Module Hierarchy, ensure module dct_2d is selected.
10. Activate the Resource Profile view.

11. Expand the memories to see the view in Figure 6-31.
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t=] Module Hierarchy

Megative Slack BRAM  DSP

v ¥ det 3
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@ dect_1d 0
@ write_data 0
@ read_data 0
EF performance Profile || Resource Profile 53
BRAM  DSP FF  LUT
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oo /O Ports(9)
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4 col_outbuf L 1 0 ]
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12. Click the Synthesis perspective button to return to the main synthesis view.

Step 9: Optimize the Hierarchy for Dataflow

1.

2
3.
4

Select the New Solution toolbar button to create a new solution, solution6.

Click Finish and accept the defaults to create solution6.

Ensure the C source code is visible in the Information pane.

In the Directive tab:

a. Select function dct_24d.

b. Right-click and select Insert Directive.

¢. In the Directives Editor dialog box activate the Directive drop-down menu at the

top and select INLINE.
d. Click OK.
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The Directive pane now shows the following optimization directives (the new directive is
highlighted).

o= Outline |4 Directive =g

1 @ dct_1d
#[1 dect_coeff_table
%" DCT_Outer_Loop
% HLS PIPELINE
%" DCT_Inner_Loop
1 @ dct_2d
% HLS INLINE
=[] row_outbuf

#[1 col_outbuf

=[] col_inbuf

9 HLS ARRAY_PARTITION partition variable=col_inbuf complete dim=2
%" Row_DCT_Loop

%" Xpose_Row_Outer_Loop

4 Xpose_Row_Inner_Loop
96 HLS PIPELINE
%' Col_DCT_Loop
%" Xpose_Col_Outer_Loop
1 " Xpose_Col_Inner_Loop
96 HLS PIPELINE
1 @ read_data
%" RD_Loop_Row
+ ¥ RD_Loop_Col
96 HLS PIPELINE
@ write_data
%" WR_Loop_Row
+ ¥ WR_Loop_Col
96 HLS PIPELINE
1 @ dct
9b HLS DATAFLOW
=[] buf_2d_in
9b HLS ARRAY_PARTITION partition variable=buf_2d_in complete dim=2
=[] buf_2d_out
@ input
2 output

Figure 6-32: Dataflow Optimization for the DCT Design
5. Click the Run C Synthesis toolbar button to synthesize the design to RTL.

6. When synthesis completes, use the Compare Reports toolbar button or the menu
Project > Compare Reports to compare solutions 5 and 6.

Figure 6-33 shows the results of comparing solution5 and solution6. You can see the
interval has improved substantially.

High-Level Synthesis N Send Feedback 135
UG871 (v2020.1) August 7, 2020 www.xilinx.com l—\/—l


https://www.xilinx.com
https://www.xilinx.com/about/feedback/document-feedback.html?docType=Tutorials&docId=UG871&Title=Vivado%20Design%20Suite%20Tutorial&releaseVersion=2020.1&docPage=135

& XILINX.

Performance Estimates

-] Timing (ns)
Clock solution3 | sclutiong
ap_clk | Target 2.00 8.00

Estimated | £.904 £6.904
- Latency (clock cycles)

solutions | sclutiong

Latency | min | 476 463

max | 476 463
Interval | min | 343 93

max | 343 a3

Chapter 6: Design Analysis

Figure 6-33: DCT Solution5 and Solution6 Comparison

The interval is now below the 125 clock target. This design can accept a new set of input

data every 98 clock cycles.

Conclusion

In this tutorial, you learned:

« How to analyze a design using the analysis perspective.

* How to cross-link operations in the views with the C code.

+ How to apply and judge optimizations.

+ A methodology for taking the initial design results and creating an implementation

which satisfies the design goals.
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Chapter 7

Design Optimization

Overview

A crucial part of creating high quality RTL designs using High-Level Synthesis is having the
ability to apply optimizations to the C code. High-Level Synthesis always tries to minimize
the latency of loops and functions. To achieve this, within the loops and functions, it tries to
execute as many operations as possible in parallel. At the level of functions, High-Level
Synthesis always tries to execute functions in parallel.

In addition to these automatic optimizations, directives are used to:

« Execute multiple tasks in parallel, for example, multiple executions of the same function
or multiple iterations of the same loop. This is pipelining.

« Restructure the physical implementation of arrays (block RAMs), functions, loops and
ports to improve the availability of data and help data flow through the design faster.

« Provide information on data dependencies, or lack of them, allowing more
optimizations to be performed.

The final optimization technique is to modify the C source code to remove unintended
dependencies in the code that may limit the performance of the hardware.

This tutorial consists of two lab exercises. You may perform the analysis in these lab
exercises using the Analysis perspective. A prerequisite for this tutorial is completion of the
Chapter 6, Design Analysis tutorial.

Lab 1 Description

Contrast the uses of loop and function pipelining to create a design that can process one
sample per clock. This lab includes examples that give you the opportunity to analyze the
two most common causes for designs failing to meet performance requirements: loop
dependencies and data flow limitations or bottlenecks.

Lab 2 Description

This lab shows how modifications to the code from Lab 1 can help overcome some
performance limitations inherent, but unintended, in the code.
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Tutorial Design Description

You can download the tutorial design file from the Xilinx Website. See the information in
Locating the Tutorial Design Files.

For this tutorial, you use the design files in the tutorial directory
Vivado HLS Tutoriall\Design Optimization.

The sample design you use in the lab exercise is a matrix multiplier function. The design
goal is to process a new sample every clock period and implement the interfaces as
streaming data interfaces.

Lab 1: Optimizing a Matrix Multiplier

This exercise uses a matrix multiplier design to show how you can fully optimize a design
heavily based on loops. The design goal is to read one sample per clock cycle using a FIFO
interface, while minimizing the area.

The analysis includes a comparison of a methodology that optimizes at the loop level with
one that optimizes at the function level.

ﬁ IMPORTANT: The figures and commands in this tutorial assume the tutorial data directory
Vivado_HLS_Tutorial is unzipped and placed in the location C:\Vivado_HLS_Tutorial. If the tutorial data
directory is unzipped to a different location, or on Linux systems, adjust the few pathnames referenced,
to the location you have chosen to place the Vivado_HLS_Tutorial directory.

Step 1: Create and Open the Project

1. Open the Vivado HLS Command Prompt.

- On Windows use Start > All Programs > Xilinx Design Tools > Vivado 2020.1 >
Vivado HLS > Vivado HLS 2020.1 Command Prompt.

o On Linux, open a new shell.

2. Using the command prompt window (Figure 7-1), change directory to the Design
Optimization tutorial, lab1.

3. Execute the Tcl script to set up the Vivado HLS project, using the command
vivado _hls -f run hls.tcl, as shown in Figure 7-1.
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C:\VUivado_HLS_Tutorial>cd Design_Optimization

C:\Vivado_HLS_Tutorial\Design_Optimization>cd labl

4 [

C:\Uivado_HLS_Tutorial\Design_Optimization\labl>vivado_hls -f run_hls.tcl

Figure 7-1: Setup the Design Optimization Tutorial Project

4. When Vivado HLS completes, open the project in the Vivado HLS GUI using the
command vivado hls -p matrixmul prj, as shown in Figure 7-2.

@I [HLS-18] Creating and opening solution 'C:/Uivado_HLS_Tutorial/Design_Optimizjg

ation/labl/matrixmul _prj/solutionl’.

@I [HLS-18] Cleaning up the solution database.

@I [HLS-18] Setting target device to 'xcTk160tfbgi84-1"

@I [SYN-201] Setting up clock ‘'default’ with a period of 13.3333ns.
Compiling ../../../../matrixmul_test.cpp in debug mode
Compiling ../../../../matrixmul.cpp in debug mode
Generating csim.exe

Test passes.

@I [SIM-1] CSim done with O errors.

@I [LIC-101] Checked in feature [HLS]

4 [

C:\Uivado_HLS_Tutorial\Design_Optimization\labl>vivado_hls -p matrixmul_prj

Figure 7-2: Open Design Optimization Project for Lab 1

5. Expand the Sources folder in the Explorer pane and double-click matrixmul . cpp to
view the source code (Figure 7-3).

Scroll down the file to see that the source code has two input arrays, a and b, and output
array res. Hold the mouse over the macros (as shown in Figure 7-3) to see that each is
three-by-three for a total of nine elements.

[t5 Explorer &2 = B[ ¢ matrixmul.cpp &3 =0
=5 matrixmul_prj 46 #include "matrixmul.h” -
! Includes a7
= Source 48 void matrixmul(
" B matrienul o 49 mat_a_t a[MAT_A ROWS][MAT A COLS],
LE B A -
o Teot Bonch 50 mat_b_t b[MAT_B_ROWS][[acro Expansion
= 51 result_t r“es[J\MT_A_RDL\I'3 )
= solution1 52 {
- Press 'F2' for focus|
# constraints 53 // Iterate over the rows o IL"":‘ HT rlnleul_x
4 directives.tcl 54 Row: for(int i = @; i < MAT_A ROWS; i++) { i
4 scripticl 55 // Iterate over the c.o'_‘.m-'s of the SImatr“ix i
- 56 Col: for(int j = @; j < MAT_B_COLS; j++) {
= csim - ST
o 57 res[1][j] = @;
& build 58 // Do the inner nroduct of a row of A and col of R -
= report < 1l 3

Figure 7-3: Source Code for the Matrix Multiplier

Step 2: Synthesize and Analyze the Design

1. Click the Run C Synthesis toolbar button to synthesize the design to RTL.
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When synthesis completes, the synthesis report opens (Figure 7-4), and the Performance
Estimates appear:

« The interval is 80 clock cycles. Because there are nine elements in each input array, the
design takes approximately nine cycles per input read.

« The interval is one cycle longer than the latency, so there is no parallelism in the
hardware at this point.

« The latency/interval is due to nested loops.

- The inner loop called Product:
- Has a latency of 2 clock cycles.
- Has 6 clock cycles total for all iterations.

o The Col loop:
- It requires 1 clock to enter loop Product and 1 clock to exit.
- It takes 8 clock cycles for each iteration (1+6+1).
- Has 24 cycles for all iterations to complete.

- The top-level loop has a latency of 26 clock cycles per iteration, for a total of 78
clock cycles for all iterations of the loop.

Performance Estimates
—| Timing (ns)

-] Summary

Clock | Target | Estimated | Uncertainty
ap_clk 13.33 3.576 1.67

- Latency (clock cycles)

-] Summary

Latency Interval

min | max | min | max | Type

79 79 79 79 | none
- Detail
+ Instance
% Loop
Latency Initiation Interval

Loop Mame min | rmax | lteration Latency | achieved | target | Trip Count | Pipelined
- Row 72 73 26 - - 3 no
+ Col 24 24 8 - - 3 no
++ Product ] -+ 2 - - 3 no

Figure 7-4: Synthesis Report for the Matrix Multiplier
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You can do one of two things to improve the initiation interval: Pipeline the loops or
pipeline the entire function. You begin by pipelining the loops and then compare those
results to pipelining the entire function.

When pipelining loops, the initiation interval of the loops is the important metric to
monitor. As seen in this exercise, even when the design reaches the stage at which the loop
can process a sample every clock cycle, the initiation interval of the function is still reported
as the time it takes for the loops contained within the function to finish processing all data
for the function.

Step 3: Pipeline the Product Loop

1. Select the New Solution toolbar button or use the menu Project > New Solution to
create a new solution, solution?2.

2. Click Finish and accept the defaults to create solution?2.

3. Ensure the C source code is visible in the Information pane.

When pipelining nested loops, you realize the greatest benefit by pipelining the inner-most
loop, which processes a sample of data. High-Level Synthesis automatically applies loop
flattening, collapsing the nested loops, removing the loop transitions (essentially creating a
single loop with more iterations but overall fewer clock cycles).

4. In the Directive tab:
a. Select loop Product.
b. Right-click and select Insert Directive.

¢. In the Directive Editor dialog box, activate the Directive drop-down menu at the
top and select PIPELINE.

d. Click OK. With the default options, an initiation interval (II) of 1 (one new loop
iteration per clock) will be the default.

The Directive pane should show the following optimization directives. (The new directive is
highlighted.)
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o= Outline |4 Directive &3 =g

4 @ matrixmul
2 a
@b
? res
2% Row
2% Col
4% Product
% HLS PIPELINE

Figure 7-5: Initial Pipeline Directive

5. Click the Run C Synthesis toolbar button to synthesize the design to RTL.

During synthesis, the information reported in the Console pane shows loop flattening was
performed on loop Row and that the default initiation internal target of 1 could not be
achieved on loop Product due to a dependency.

INFO: [XFORM 203-541] Flattening a loop nest 'Row' (matrixmul.cpp:54:37) in function
'matrixmul’.

INFO: [SCHED 204-61] Pipelining loop 'Product'.
WARNING: [SCHED 204-68] Unable to enforce a carried dependency constraint (II = 1,
distance = 1)

between 'store' operation (matrixmul.cpp:60) of variable 'tmp 8', matrixmul.cpp:60
on array 'res' and 'load' operation ('res load', matrixmul.cpp:60) on array 'res'.
INFO: [SCHED 204-61] Pipelining result: Target II: 1, Final II: 2, Depth: 2.

The synthesis report (Figure 7-6) shows that although the Product loop is pipelined with an
interval of 2, the interval of top-level loop is not pipelined.
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Performance Estimates

- Timing (ns)

- Summary
Clock | Target | Estimated | Uncertainty
ap_clk 13.33 4,306 1.67

- Latency (clock cycles)

- Summary

Latency Interval

min | max | min | max | Type
82 82 82 82 | nocne

= Detail

7] Instance

Latency Initiation Interval

Loop Mame | min | max | lteration Latency | achieved | target | Trip Count | Pipelined
- Row_Col a1 a1 g - - 9 no
+ Product ] & 2 2 1 3 YES

Figure 7-6: Matrixmul Initial Pipeline Report

The reason the top-level loop is not pipelined is that loop flattening only occurred on loop
Row_Col. There was no loop flattening of loop Col into the Product loop. To understand why
loop flattening was unable to flatten all nested loops, use the Analysis perspective.

6. Open the Analysis perspective.

7. In the Schedule Viewer, expand loops Row_Col and Product.
8. Select the write operation in state C1.
9

Right-click and select Goto Source to see the view in Figure 7-7.

The write operation in state C1 is due to the code that sets res to zero before the Product
loop. Because res is a top-level function argument, it is a write to a port in the RTL: This
operation must happen before the operations in loop Product are executed. Because it is
not an internal operation but has an impact on the 1/0 behavior, this operation cannot be
moved or optimized. This prevents the Product loop from being flattened into the Row_Col
loop.
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Operation\ Control Step | 1 | 5 | 3 |

indvar_flatten_nesxt(+] ~
i_1(+)

exitcond1(icmp)

j_mid2(select)

trp_mid2_v(select)

tmp_1(-)

tmp_s(+) —

node_33(write) gy

F’deUCt - Product_ii=2

16 v q i
= > <

Schedule Viewer | Resource Viewer
= Properties | &4 Warnings ‘= DRCs| [£] C Source 52

File: C:\Vivado_HLS_Tutorial\Design_Optimization‘lab1\matrixmul.cpp
57 res[i[i] = 0

53 A Dothe inner product of & row of A and col of B

5% Froduct: for(int k = 0; k < MAT_B_ROWS; k++) £

60 res[il[i] += a[il[k] * b[k][]:
81}
62 1}

Figure 7-7: Matrixmul Initial Schedule Viewer

More importantly, it is worth addressing why only an initiation interval (Il) of 2 was possible
for the Product loop (as shown in Figure 7-6).

The message SCHED-68 in the console pane (and file vivado hls.log) tells you:

WARNING: [SCHED 204-68] Unable to enforce a carried dependency constraint (II = 1,
distance = 1)

between 'store' operation (matrixmul.cpp:60) of variable 'tmp 8', matrixmul.cpp:60
on array 'res' and 'load' operation ('res_load', matrixmul.cpp:60) on array 'res'.

« Theissue is a carried dependency. This is a dependency between an operation in one

iteration of a loop and an operation in a different iteration of the same loop. For
example, an operation when k=1 and when k=2 (where k is the loop index).

« The first operation is a load (memory read operation) on array res on line 61.

« The second operation is a store (memory write operation) on array res on line 61.

From Figure 7-8 you can see line 61 is a read from array res (due to the += operator) and a
write to array res. An array is mapped into a block RAM by default and the details in the
Schedule Viewer can show why this conflict occurred.

The Schedule Viewer shows in which states the operations are scheduled. Figure 7-8 shows
that two of the operations are responsible for the Il violation. These are the operations
which have a dependency between loop iterations. The Analysis perspective provides that
capability to filter the analysis view to the operations causing an Il violation. To use this
feature, select Il Violation in the filter drop-down list.
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The first iteration of the loop shows the states in which the operations occur. The read in
states 2 and 3, and the write in state 3. The operation in the next iteration must start 1 cycle
after this, because the 2nd read cannot occur until the 1st write has finished: the operations
in each iteration of the loop are to a different address and only 1 address can be applied at
the same time.

| 4= wp | E = ST |1 Vielation ~
Operation’Control Step 0 1 2 3
w Product - Product ii=2
res_|loadiread)

node_62 (write)

< > <

Schedule Viewer | Resource Viewer
] Properties | & Warnings | “Z DRCs | [ C Source &2

File: C\Vivado HLS_TutorialDesign_Optimization\labT\matrizmul.cpp
5T res[l[]=0 -
28 Jt Do the inner product of & row of A and col of B
59 Froduct: for{int k = 0; k <« MAT_B_ROWS: k++) {
60 res{i]fi] += afij[k] * b(k][]:
a1 1
Figure 7-8: Carried Dependency Analysis

You cannot pipeline the Product loop with an initiation interval of 1. The next lab exercise
shows how re-writing the code can remove this limitation. In this lab exercise you will
continue to optimize the code as it is.

The next step is to pipeline the loop above, the Col loop. This automatically unrolls the
Product loop and creates more operators and hence more hardware resources, but it
ensures there is no dependency between different iterations of the Product loop.

10. Return to the Synthesis perspective.

Step 4: Pipeline the Col Loop

1. Select the New Solution toolbar button to create a new solution, solution3.

2. Because solution?2 already has a directive added, use the drop-down menu to select
solution1 as the source for existing directives and constraints (solution1 has none).

3. Click Finish and accept the default solution name, solution3.

4. Open the C source code matrixmul.cpp to make it visible in the Information pane.
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5. In the Directive tab:
a. Select loop Col.
b. Right-click and select Insert Directive.

c. In the Directive Editor dialog box activate the Directive drop-down menu at the
top and select PIPELINE.

d. Click OK. With the default options, an initiation interval (Il) of 1 (one new loop
iteration per clock) becomes the default.

The Directive pane, shown below, displays the following optimization directives (the new
directive is highlighted).

o= Outline |4 Directive &3 =g

@ matrixmu
@ a
@b
P res
4 %" Row
4% Col
% HLS PIPELINE
%" Product

Figure 7-9: Col Pipeline Directive

6. Click the Run C Synthesis toolbar button to synthesize the design to RTL.

During synthesis, the information reported in the Console pane shows that loop Product
was unrolled, loop flattening was performed on loop Row, and the default initiation internal
target of 1 could not be achieved on loop Row Col due to resource limitations on the
memory for array a.

INFO: [XFORM 203-502] Unrolling all sub-loops inside loop 'Col' (matrixmul.cpp:56) in
function 'matrixmul' for pipelining.

INFO: [XFORM 203-501] Unrolling loop 'Product' (matrixmul.cpp:59) in function
'matrixmul' completely.

INFO: [XFORM 203-541] Flattening a loop nest 'Row' (matrixmul.cpp:54:37) in function
'matrixmul’.

INFO: [SCHED 204-61] Pipelining loop 'Row Col'.

WARNING: [SCHED 204-69] Unable to schedule 'load' operation ('a load 1',
matrixmul.cpp:60) on array 'a' due to limited memory ports.

INFO: [SCHED 204-61] Pipelining result: Target II: 1, Final II: 2, Depth: 3.

Reviewing the synthesis report shows, as noted above, that the interval for loop Row_Col is
only two: the target is to process one sample every cycle. Once again, you can use the
Analysis perspective to highlight why the initiation target was not achieved.
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7. Open the Analysis perspective.

8. In the Schedule Viewer, expand the Row Col loop.

The operations on array a (mentioned in the SCHED-69 message above) are highlighted in
Figure 7-10. There are three read operations on array a. One operation in each state C1
through C3.

Arrays are implemented as block RAMs and arrays which are arguments to the function are
implemented as block RAM ports. In both cases a block RAM can only have a maximum of
two ports (for dual-port block RAM). By accessing array a through a single block RAM

interface, there are not enough ports to be able to read all three values in one clock cycle.

| |#m mp | & @ 32 || Focus Off k4

Operation\Centrol Step |

tmp_1(-) ~
a_load(read)
b_load(read)
tmp_8(+)
tmp_s(+]
a_load_2(read)
b_load_2(read)
10+
tmp_4(+]
tmp_9(+)
tmp_10(+)
tmp_T(*)
a_load_1{read)
b_load_1{read)

Figure 7-10: Matrixmul Pipeline Col Schedule Viewer

Another way to view this resource limitation is to use to the Resource pane.

9. Click the Resource tab.

10. Expand the Memory Ports to see the view shown in Figure 7-11.

In Figure 7-11 the 2-cycle read operations in state C1 overlap with those starting in state C2
and so only a single cycle is visible: however, it is clear that this resource is used in multiple
states.

In looking at this view, it is clear that even when the issue with port a is resolved, the same
issue occurs with port b: it also has to perform 3 reads.

High-Level Synthesis can only report one schedule error or warning at a time, because, as
soon as the first issue occurs, the actions to create an achievable schedule invalidates any
other infeasible schedules.
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Operation\Control Step | 0 | 1 | 2 | 3 | 4 |

[+]1I/0 Ports
v [+]Memeory Ports
a(pl)
b(p0)
bip1)
a(pl)
res(pl)
[+]Expressions

33

Figure 7-11: Matrixmul Pipeline Col Resource View

High-Level Synthesis allows arrays to be partitioned, mapped together and re-shaped.
These techniques allow the access to array to be modified without changing the source
code.

11. Return to the Synthesis perspective.

Step 5: Reshape the Arrays

1. Select the New Solution toolbar button or use the menu Project > New Solution to
create a new solution, solution4.

2. Click Finish and accept the default solution name solution4.

Because the loop index for the Product loop is k, both arrays should be partitioned along
their respective k dimension: the design needs to access more than two values of k in each
clock cycle.

For array a, this is dimension 2 because its access patternsis a[i] [k]; for array b, this is
dimension 1 because its access patternis b [k] [].

Partitioning these arrays creates MAT_A_COLS arrays - in this case, MAT_A_COLS number
ports. Alternatively, we can use re-shape instead of partition allowing one wide array (port)
to be created instead of k ports.

After this transformation, the data in the block RAM outside this block must be reshaped in
an identical manner: if this process is not done by HLS, the data must be arranged as:

« For array a: MAT_A_ROWS elements, each of width data_word_size times MAT_A_COLS.
« For array b: MAT_B_COLS elements, each of width data_word_size times MAT_B_ROWS.
3. Open the C source code matrixmul.cpp to make it visible in the Information pane.
4. In the Directive tab, do the following:

a. Select variable a.

b. Right-click and select Insert Directive.
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c. In the Directive Editor dialog box activate the Directive drop-down menu at the
top and select ARRAY_RESHAPE.

d. Set the dimension to 2.

e. Click OK.

5. Repeat this process for variable b, but set the dimension to 1.

The Directive pane should show the following optimization directives.

o= Outline |4 Directive &3 -

@ matrixmul
2 a
% HLS ARRAY_RESHAPE reshape variable=a complete dim=2
b
% HLS ARRAY_RESHAPE reshape variable=b complete dim=1
d res
% Row
% Col
% HLS PIPELINE
% Product

Figure 7-12: Array Reshape Directive

6. Click the Run C Synthesis toolbar button to synthesize the design to RTL.

The synthesis report shows the top-level loop Row_Col is now processing data at 1 sample
per clock period (Figure 7-13).
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Performance Estimates

5] Timing (ns)

-] Summary
Clock | Target | Estimated | Uncertainty
ap_clk 13.33 7.566 1.67

- Latency (clock cycles)

-] Summary

Latency Interval

min | max | min | max | Type
N 1 1 11 | none

o Detail

1 Instance

- Loop

Latency Initiaticn Interval
Loop Mame | min | max | lteration Latency | achieved | target | Trip Count | Pipelined
- Row_Col 9 g 2 1 1 g YES

Figure 7-13: Optimized Loop Processing Report
The top-level module takes 11 clock cycles to complete.
The Row_Col loop outputs a sample after 2 cycles (iteration latency).
It then reads 1 sample every cycle (Initiation Interval).
After 9 iterations/samples (Trip count) it completes all samples.

2 +9 =11 clock cycles

The function can then complete and return to start to process the next set of data.

Now, change the block RAM interfaces to FIFO interfaces to allow for streaming data.

Step 6: Apply FIFO Interfaces

1.

2
3.
4

High-Level Synthesis

Select the New Solution toolbar button to create a new solution.

Click Finish and accept the default solution name, solution5.

Open the C source code matrixmul.cpp to make it visible in the Information pane.
In the Directive tab, do the following:

a. Select variable a.

b. Right-click and select Insert Directive.
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c. In the Directive Editor dialog box activate the Directive drop-down menu at the
top and select INTERFACE.

d. Click the mode drop-down menu to select ap fifo.
e. Click OK.

5. Repeat this process for variables b and variable res.

The Directive pane displays the following optimization directives. (The new directives are
highlighted).

o= Outline |4 Directive =g

4 @ matrixmul
@ a
9 HLS ARRAY_RESHAPE reshape variable=a complete dim=2
% HLS INTERFACE ap_fifo port=a
b
% HLS INTERFACE ap_fifo port=b
9 HLS ARRAY_RESHAPE reshape variable=b complete dim=1
d res
9 HLS INTERFACE ap_fifo port=res
% Row
% Col

F]

Figure 7-14: Matrixmul FIFO Directives

6. Click the Run C Synthesis toolbar button to synthesizes the design to RTL.

Figure 7-15 shows the Console display after synthesis runs.

£ Console 32 @ Errors| & Warnings ‘= DRCs

Vivado HLS Console
INFO: [HLS 268-18

Opening project 'C:/Vivado_q;S_Tutnria1/Design_Dptimization/labl/matrixmul_prj'.
INFO: [HLS 2ee-18

Adding design file ‘matrixmul.cpp’ to the project

INFO: [HLS 28@-1@] Adding test bench file 'matrixmul_test.cpp’ to the project

INFO: [HLS 288-1@] Opening solution 'C:/Vivado_HLS_ Tuterial/Design_Optimization/labl/matrixmul_prj/solutions’
INFO: [SYN 281-281] Setting up clock '"default’ with a peried of 13.333ns.

INFO: [HLS 28@-18] Setting target device to "xcwu9p-flgb2le4-1-e’

INFO: [SCHED 284-61] Option 'relax_ii_for_timing"' is enabled, will increase II to preserve clock frequency co
INFO: [HLS 28@-1@] Analyzing design file 'matrixmul.cpp’

INFO: [HLS 288-111] Finished Linking Time (s): cpu = 8@8:88:81 ; elapsed = 8@:88:18 . Memory (MB): peak = 185.
INFO: [HLS 288-111] Finished Checking Pragmas Time (s): cpu = @8:88:81 ; elapsed = @8:88:18 . Memory (MB): pe
INFO: [HLS 28@-1@] Starting code transfermations ...

INFO: [HLS 288-111] Finished Standard Transforms Time (s): cpu = 88:80:81 ; elapsed = 88:808:18 . Memory (MB):
INFO: [HLS 288-1@] Checking synthesizability ...

ERROR: [SYNCHK 28@-91] Port 'res' (matrixmul.cpp:48) of function 'matrixmul’ cannot be set to a FIFO

ERROR: [SYNCHK 28@-91] as it has both write (matrixmul.cpp:68:13) and read (matrixmul.cpp:6@:13) operations.

[y S

Figure 7-15: FIFO Synthesis Warning

From the code shown in Figure 7-16, array res performs writes in the following sequence
(MAT_B_COLS = MAT_B_ROWS = 3):

« Write to [0][0] on line 58.
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« Then a write to [0][0] on line 61.
« Then a write to [0][0] on line 61.
« Then a write to [0][0] on line 61.
»  Write to [0][1] on line 58 (after index J increments).

« Then a write to [0][1] on line 61.

Four consecutive writes to address [0][0] does not constitute a streaming access pattern;
this is random access.

matrixmul.cpp 2 =0
24 -
3 // Iterate over the rows of the A matrix

4 Row: for(int i = @; i < MAT_A ROWS; i++) {

5 // Iterate over the columns of the B matrix

6 Col: for(int j = @; j < MAT_B_COLS; j++) {

7 res[1][j] = @;

8 // Do the inner product of a row of A and col of B

9 Product: for(int k = @; k < MAT_B_ROWS; k++) {

o res[1][J] += a[il[k] * b[k][]l;

2

3

4

5

et
m

1 3

Figure 7-16: Matrixmul Code

Examining the code in Figure 7-16 reveals that there are similar issues reading arrays a and
b. It is impossible to use a FIFO interface for data access with the code as written. To use a
FIFO interface, the optimization directives available in Vivado High-Level Synthesis are
inadequate because the code currently enforces a certain order of reads and writes. Further
optimization requires a re-write of the code, which you accomplish in Lab 2.

Before modifying the code, however, it is worth pipelining the function instead of pipelining
the loops to contrast the difference in the two approaches.

Step 7: Pipeline the Function

1. Select the New Solution toolbar button to create a new solution, solution6.

f IMPORTANT: /n this step, copy the directives from solution4 as this solution does not have FIFO
interfaces specified.

2. Select solution4 from both the drop down menus in the Options section. The Solution
Wizard appears as shown in Figure 7-17.
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¢ Solution Wizard O *

Solution Configuration f—

Create Vivado HLS solution for selected technology

Solution Mame: | colutionb |

Clock
Period: | 73MHz | Uncertainty: | |

Part Selection

Part: xcvu9p-flgh2104-1-e

Options
Copy directives and censtraints from solution: w

[[]SDAccel Bottorn Up Flow

Figure 7-17: New Solution Based on Solution4 Directives

3. Click Finish and accept the default solution name, solutionsé.

4. Open the C source code matrixmul.cpp to make it visible in the Information pane.

5. In the Directive tab:

a.

b.

f.

Select the pipeline directive on loop Col.
Right-click and select Remove Directive.
Select the top-level function matrixmul.
Right-click and select Insert Directive.

In the Directive Editor dialog box activate the Directive drop-down menu at the
top and select PIPELINE.

Click OK.

The Directives tab should appear as Figure 7-18.

High-Level Synthesis
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82 Outline (I Directive &2 =0
4 @ matrixmul

% HLS PIPELINE

@ a

9 HLS ARRAY_RESHAPE reshape variable=a complete dim=2

b

9 HLS ARRAY_RESHAPE reshape variable=b complete dim=1

d res

4% Row
% Col

Figure 7-18: Directives for Solution6
6. Click the Run C Synthesis toolbar button to synthesize the design to RTL.
7. Click the Compare Reports toolbar button.
a. Add solution4.
b. Add solutioné.
c. Click OK.

The comparison of solutions 4 and 6 is shown in Figure 7-19.

P
£" compare reports &2

Performance Estimates

=l Timing (ns)
Clock solutiond | solutiong
ap_clk | Target 13.33 13.33
Estimated | 7.366 7.566

El Latency (clock cycles)

solutiond | solution®
Latency | min | 11 3
max | 11 5
Interval | min | 11 5
max | 11 3

Utilization Estimates

solutiond | solutiong
BRAM_18K | O 0
D5P42E 2 18
FF 18 343
LuT 187 565
URAM 0 0

Figure 7-19: Loop Versus Function Pipelining
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The design now completes in fewer clocks and can start a new transaction every 5 clock
cycles. However, the area and resources have increased substantially because all the loops
in the design were unrolled.

INFO: [XFORM 203-502] Unrolling all loops for pipelining in function 'matrixmul'
(matrixmul.cpp:49) .INFO: [HLS 200-489] Unrolling loop 'Row' (matrixmul.cpp:54) in
function 'matrixmul' completely with a factor of 3.

INFO: [HLS 200-489] Unrolling loop 'Col' (matrixmul.cpp:56) in function 'matrixmul'
completely with a factor of 3.

INFO: [HLS 200-489] Unrolling loop 'Product' (matrixmul.cpp:59) in function
'matrixmul' completely with a factor of 3.

Pipelining loops allows the loops to remain rolled, thus providing a good means of
controlling the area. When pipelining a function, all loops contained in the function are
unrolled, which is a requirement for pipelining. The pipelined function design can process a
new set of 9 samples every 5 clock cycles. This exceeds the requirement of 1 sample per
clock because the default behavior of High-Level Synthesis is to produce a design with the
highest performance.

The pipelined function results in the best performance. However, if it exceeds the required
performance, it might take multiple additional directives to slow the design down.
Pipelining loops gives you an easy way to control resources, with the option of partially
unrolling the design to meet performance.

Lab 2: C Code Optimized for I/O Accesses

In Lab 1, you were unable to use streaming interfaces. The nature of the C code, which
specified multiple accesses to the same addresses, prevented streaming interfaces being
applied.

« In a streaming interface, the values must be accessed in sequential order.

« In the code, the accesses were also port accesses, which High-Level Synthesis is unable
to move around and optimize. The C code specified writing the value zero to port res
at the start of every product loop. This may be part of the intended behavior. HLS
cannot simply decide to change the specification of the algorithm.

The code intuitively captured the behavior of a matrix multiplication, but it prevented a
required behavior in the hardware: streaming accesses.

This lab exercise uses an updated version of the C code you worked with in Lab 1. The
following explains how the C code was updated.

Figure 7-20 shows the /O access pattern for the code in Lab 1. Out of necessity the address
values are shown in a small font.
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As variables i, j and k iterate from 0 to 3, the lower part of Figure 7-20 shows the
addresses generated to read a, b and write to res. In addition, at the start of each Product
loop, res is set to the value zero.

Al
T | | . " (R — | S——)f——
Product k @mmmmmmmﬂ

b DI R ED mm-m
@;n @;mF:mFIEPInF:mFﬂF:BF:m
Figure 7-20: Matrix Multiplier Address Accesses

To have a hardware design with sequential streaming accesses, the ports accesses can only
be those shown highlighted in red. For the read ports, the data must be cached internally to
ensure the design does not have to re-read the port. For the write port res, the data must
be saved into a temporary variable and only written to the port in the cycles shown in red.

The C code in this lab reflects this behavior.

Step 1: Create and Open the Project

1. From the Vivado HLS command prompt used in Lab 1, change to the lab2 directory as
shown in Figure 7-21.

2. Create a new Vivado HLS project by typing vivado hls -f run hls.tcl.

C:\Vivado_HLS_Tutorial\Design_Optimizationilabl>cd ..

C:\Vivado_HLS_Tutorial\Design_Optimization>cd lab2

4 |1

C:\Uivado_HLS_Tutorial\Design_Optimization\lab2>vivado_hls -f run_hls.tcl

Figure 7-21: Setup for Interface Synthesis Lab 2
3. Open the Vivado HLS GUI project by typing vivado _hls -p matrixmul prj.

4. Open the Source folder in the Explorer pane and double-click matrixmul . cpp to open
the code as shown in Figure 7-22.
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[¢| matrixmul.cpp &2 =0
21 -

3 #pragma HLS ARRAY_RESHAPE variable=b complete dim=1

4 #pragma HLS ARRAY_RESHAPE variable=a complete dim=2

5 #pragma HLS INTERFACE ap_fifo port=a

6 #pragma HLS INTERFACE ap_fifo port=b

7 #pragma HLS INTERFACE ap_fifo port=res

mat_a_t a_row[MAT_A ROWS];

mat_b_t b_copy[MAT_B_ROWS][MAT_B_COLS];

int tmp = 8;

co

& D

// Iterate over the rowa of the A matrix
Row: for(int i = @; i < MAT_A ROWS; i++) {
// Iterate over the columns of the B matrix
Col: for(int j = @; j < MAT_B_COLS; j++) {
#pragma HLS PIPELINE
// Do the inner product of a row of A and col of B
tmp=0;
// Cache each row (so it's only read once per function}
if (j == @)
Cache_Row: for(int k = 0; k < MAT_A ROWS; k++)
a_rowl[k] = a[i][k];

[ Y= - RN RS RV, R VR ]

m

// Cache all cols (so they are only read once per function)
if (i == 0)
Cache_Col: for(int k = @; k < MAT_B_ROWS; k++)
b_copy[k][3j] = b[k][]1;

Product: for(int k = @; k < MAT_B_ROWS; k++) {
tmp += a_row[k] * b_copy[k][i]; v
< 1 3

[N - RN = YRR, I N VU ]

Figure 7-22: C Code with Updated I/O Accesses

Review the code and confirm the following:

« The directives from Lab 1, including the FIFO interfaces, are specified in the code as
pragmas.

« For-loops have been added to cache the row and column reads.

« A temporary variable is used for the accumulation and port res is only written to when
the final result is computed for each value.

« Because the for-loops to cache the row and column would require multiple cycles to
perform the reads, the pipeline directive has been applied to the Col for-loop, ensuring
these cache for-loops are automatically unrolled.

Synthesize the design and verify the RTL using co-simulation.

5. Click the Run C Synthesis toolbar button to synthesize the design to RTL.

6. When synthesis completes, use the Run C/RTL CoSimulation toolbar button to launch
the Co-simulation Dialog box.

7. Click OK to start RTL verification.

The design has been now been fully synthesized to read one sample every clock cycle using
streaming FIFO interfaces.
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Conclusion

In this tutorial, you learned:

« How to analyze pipelined loops and understand exactly which limitations prevent
optimizations targets from being achieved.

« The advantages and disadvantages of function versus loop pipelining.

*  How unintended dependencies in the code can prevent hardware design goals from
being realized and how they can be overcome by modifications to the source code.
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Chapter 8

RTL Verification

Overview

The High Level Synthesis tool automates the process of RTL verification and allows you to
use RTL verification to generate trace files that show the activity of the waveforms in the

RTL design. You can use these waveforms to analyze and understand the RTL output. This
tutorial covers all aspects of the RTL verification process.

To perform RTL verification, you use both the RTL output from High-Level Synthesis
(Verilog, VHDL or SystemC) and the C test bench. RTL verification is often called
CoSimulation or C/RTL CoSimulation; because both C and RTL are used in the verification.

This tutorial consists of three lab exercises.

Lab 1 Description

Perform RTL verification steps and understand the importance of the C test bench in
verifying the RTL.

Lab 2 Description

Create RTL trace files and analyze them using the Vivado Design Suite.

Lab 3 Description

Create RTL trace files and analyze them using a third-party RTL simulator. This lab requires
a license for Mentor Graphics ModelSim simulator. (You can use an alternative, third-party
simulator with minor modifications to the steps).

Tutorial Design Description

You can download the tutorial design file from the Xilinx website. See the information in
Locating the Tutorial Design Files.
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This tutorial uses the design files in the tutorial directory
Vivado HLS Tutorial\RTL Verification.

The sample design used in the lab exercise is a DUC (digital up converter) function. The
purpose of this lab is to demonstrate and explain the features of RTL verification. There are
no design goals for these lab exercises.

Lab 1: RTL Verification and the C Test Bench

This exercise explains the basic operations for RTL verification and highlights the
importance of the C test bench.

ﬁ IMPORTANT: The figures and commands in this tutorial assume the tutorial data directory
Vivado_HLS_Tutorial is unzipped and placed in the location C:\Vivado_HLS_Tutorial. If the tutorial data
directory is unzipped to a different location, or on Linux systems, adjust the few pathnames referenced,
to the location you have chosen to place the Vivado_HLS_Tutorial directory.

Step 1: Create and Open the Project

1. Open the Vivado HLS Command Prompt.

o On Windows use Start > All Programs > Xilinx Design Tools > Vivado 2020.1 >
Vivado HLS > Vivado HLS 2020.1 Command Prompt.

o On Linux, open a new shell.

2. Using the command prompt window (Figure 8-1), change directory to the
RTL_Verification tutorial, 1ab1.

3. Execute the Tcl script to setup the Vivado HLS project, using the command vivado _hls
-f run hls.tcl, as shown in Figure 8-1.

C:\Uivado_HLS_Tutorial>cd RTL_VUerification

C:\Vivado_HLS_Tutorial\RTL_Verification>cd labl

4 M

C:\Uivado_HLS_Tutorial\RTL_Uerification\lab1l>vivado_hls -f run_hls.tcl

Figure 8-1: Setup the RLTL Verification Tutorial Project

4. When Vivado HLS completes, open the project in the Vivado HLS GUI using the
command vivado_hls -p duc_prj, as shown in Figure 8-2.
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@I [LIC-101] Checked in feature [HL$] -
Generating csim.exe

xxx DUC hardware test PASSED t xxx

@I [SIM-1] CSim done with @ errors.
@I [LIC-101] Checked in feature [HL$]

4 |1

C:\Uivado_HLS_Tutorial\RTL_Uerification\labl>vivado_hls -

Figure 8-2: Open RTL Verification Project for Lab 1

Step 2: Perform RTL Verification

1. Click the Run C Synthesis toolbar button to synthesize the design to RTL.

2. When synthesis completes, use the Run C/RTL CoSimulation toolbar button
(Figure 8-3) to launch the Co-simulation dialog box.

File Edit Project Solution Window Help

e

b e R & » VS8

Figure 8-3: Run C/RTL CoSimulation Toolbar Button

The CoSimulation Dialog box opens, as shown in Figure 8-4.
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# Co-simulation Dialog >

C/RTL Co-simulation =

Verilog/WHDL Simulator Selection

Auto w
RTL Selection
(®) Verilog () WVHDL
Options

[] Setup Only

Dump Trace |none
(] Optimizing Compile
[]Reduce Diskspace

Wave Debug

[] Disable Deadlock Detection

Compiled Library Location | Browse...

Input Argurnents |

[J Do not show this dialog bex again.

Figure 8-4: Co-simulation Dialog Box

The drop-down menu allows you to select the RTL simulator for HDL simulation. For this

exercise, you use the default Auto selection (Auto selects the Vivado Simulator) with Verilog
RTL for CoSimulation.

3. Click OK to start RTL verification.

When RTL Verification completes, the simulation report opens automatically (Figure 8-5).

The report indicates if the simulation passed or failed. In addition, the report indicates the
measured latency and interval.

High-Level Synthesis

. l Send Feedback I 162
UG871 (v2020.1) August 7, 2020 www.xilinx.com



https://www.xilinx.com
https://www.xilinx.com/about/feedback/document-feedback.html?docType=Tutorials&docId=UG871&Title=Vivado%20Design%20Suite%20Tutorial&releaseVersion=2020.1&docPage=162

(: X”_INX® Chapter 8: RTL Verification

High-Level Synthesis

Cosimulation Report for ‘duc’

Result
Latency Interval
RTL Status min  avg max min  avg max
VHDL NA  NA NA NA  NA NA NA

Verilog Pass 36 37 44 37 38 45

Figure 8-5: CoSimulation Report

RTL simulation completes in three steps. To better understand how the RTL verification
process is performed, scroll up in the console window to confirm that the messages
described below were issued.

First, the C test bench is executed to generate input stimuli for the RTL design.

INFO: [COSIM 212-14] Instrumenting C test bench ...

< C simulation executes to generate input stimuli >

At the end of this phase, the simulation shows any messages generated by the C test bench.
The output from the C function is not used in the C test bench at this stage, but any
messages output by the test bench can be seen in the console.

INFO: [COSIM 212-302] Starting C TB testing ...
*%% DUC hardware test PASSED | *#*%*

An RTL test bench with newly generated input stimuli is created and the RTL simulation is
then performed.

INFO: [COSIM 212-333] Generating C post check test bench ...
INFO: [COSIM 212-12] Generating RTL test bench ...

Finally, the output from the RTL simulation is re-applied to the C test bench to check the
results. Once again, you can see any message output by the C test bench in the console.
Finally, RTL verification issues message SIM-1000 if the RTL verification passed.

INFO: [COSIM 212-316] Starting C post checking ...
*** DUC hardware test PASSED | ***
INFO: [COSIM 212-1000] *** C/RTL co-simulation finished: PASS **x*

To fully understand why the C test bench should check the results and how message
SIM-1000 is generated, you will modify the C test bench.
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Step 3: Modify the C Test Bench
1. Expand the Test Bench folder in the Explorer pane (Figure 8-6).

2. Double-click duc_test.c to open the C test bench in the Information pane.

[t5 Explorer 22 w" = O|[[£ duc test.c &3 =8
. od /7 Lheck The result =/
=d - . . ) -
_UCI'pIrJd 61 dint retl = system("diff --brief duc_i.dat golden/duc_i.d:
&t Includes 62 int ret2 = system("diff --brief duc_g.dat golden/duc_g.d:
£ Source 63
= Test Bench 64 if (retl | ret2) {
[gl duc_test.c 65 printf("\n *** DUC hardware test FAILED ! *** \n\n"):
= golden 66 ]} else {
¢= solutiont 67 printf("\n *** DUC hardware test PASSED ! *** \n\n"},
& constraints ?2 ¥
i 69
BC_SII‘H 70 return ((retl | ret2) ? 1 : @);
= sim 71//return 1; =
= syn 72}
73 =
4 | 111 P

Figure 8-6: RTL Test Bench
3. Scroll to the end of the file to see the code shown in Figure 8-7.

4. Edit the return statement to match Figure 8-7 and ensure the test bench always returns
the value 1.

l¢| *duc_test.c &2 =B
0 /7 Check The result =/ N
int retl = system("diff --brief duc_i.dat golden/duc_i.d:
system("diff --brief duc_g.dat golden/duc_g.d:

2 int ret2 =
3
4 if (retl | ret2) {
5 printf("\n *** DUC hardware test FAILED ! *** \n\n").
6 } else {
7 printf("\n *** DUC hardware test PASSED ! *** \n\n").
8 1
9
8//return ((retl | ret2) ? 1 : 8);
return 1; =
4 | 1 b

Figure 8-7: Modified RTL Test Bench
5. Save the file.
6. Click the Run C Synthesis toolbar button to synthesize the design to RTL.

7. Click the Run C/RTL CoSimulation toolbar button to launch the Co-simulation dialog
box.
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8. Leave the CoSimulation options at their default value and click OK to execute the RTL
CoSimulation.

When RTL CoSimulation completes, the CoSimulation report opens and says the verification
has failed (Figure 8-8).

£ Simulation(solutionl) &2 = B ||8 Qutline & . [ Directive ~ = 0

. . . . An outline is not available.
Cosimulation Report for 'duc

Result
Latency Interval
RTL Status min  avg max min  avg max
VHDL NA NA NA NA NA NA NA

Verilog Fail  NA NA NA NA NA NA

Export the report(.html) using the Export Wizard

& Consale &2 . @) Errars| & Warnings <= "B~y 4 =0
Vivado HLS Console
INFO: [COSIM 212-382] Starting C TB testing ... -

*#*% DUC hardware test PASSED | **¥*

CRITICAL WARMIMG: [COSIM 212-359] Aborting co-simulation: C TB simulation failed, nonzero return value '1'.
CRITICAL WARMINMG: [COSIM 212-320] C TB testing failed, stop generating test vectors. Please check C TB or re-run cosim.
CRITICAL WARMING: [COSIM 212-4] *** (/RTL co-simulation finished: FAIL ***
command 'ap_source' returned error (odﬂ
while executing
"source C:/Vivado_HLS_Tutorial/RTL_Verification/labl/duc_prj/solutionl/cosim.tcl™
invoked from within
"hls::main C:/Vivado_HLS_Tutorial/RTL_Verification/labl/duc_prj/solutionl/cosim.tcl"
("uplevel™ body line 1)
invoked from within
"uplevel 1 hls::main {*}$args"
4

4 |

11 2

Figure 8-8: CoSimulation Report Failure

In Figure 8-8, you can see from the message printed to the console (DUC hardware test
PASSED) that the results are correct, however, the verification report says the RTL
verification failed.

If required, you can confirm the results are correct. To do this, compare the output files
created by the RTL simulation with the golden results. The RTL simulation is executed in the
simulation directory wrapc, which is inside the solution directory. Figure 8-9 shows the
solution directory, with the output files highlighted.
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Chapter 8:
[ Explorer 2 = 0
i Includes -
» = Source

» = Test Bench
a = solution1
4 @ constraints
“ directives.tcl
& scripttcl
> = csim
4 = sim
+ = autowrap
: = report
A=A
4 (= wrapc
le AESL_pkg.h
l¢] apatb_duc.cpp
l¢| apatb_duch
|5 apcc.log
b cosim.tv.exe

m

cosim.tv.mk

l¢| dds.c_pre.ctb.c
duc_ldat
duc_g.dat

l¢ duc_test.c_pre.ctb.c
duc.autotvin.dat
duc.autotvout.dat

lel duc.c_pre.ctb.c

lel imfl.c_pre.ctb.c

lel imf2.c_pre.ctb.c

Figure 8-9: Cosimulation Output Files

RTL Verification

RTL CoSimulation only reports a successful verification when the test bench returns a value
of 0 (zero). Modifying the test bench to return a non-zero value ensures RTL verification
(and C simulation if it was performed) would always report a failure.

To ensure that the RTL results are automatically verified: the C test bench must always check
the output from the C function to be synthesized and return a 0 (zero) if the results are
correct OR return any other value if they are not correct.

When RTL Verification is performed, the same testing occurs in the test bench, and the
output from the RTL block is automatically checked. This is why it is important for the C test
bench to check the results and return a zero value only if they are correct (or return a
non-zero value if they are incorrect).

9. Exit the Vivado HLS GUI and return to the command prompt.
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Lab 2: Viewing Trace Files in Vivado

This exercise explains how to generate RTL trace files and how to view them using the
Vivado Design Suite tools.

Step 1: Create an RTL Trace File using Vivado Simulator

1. From the Vivado HLS command prompt you used in Lab 1, change to the lab2 directory
as shown in Figure 8-10.

2. Create a new Vivado HLS project by typing vivado hls -f run hls.tcl.
c:\Vivado_ HLS_Tutorial\RTL_Verification\lab2>1ls

dds.c duc.c golden imf2.c imf3_coef.h run_hls_tcl
dds.dat duc.h imfl.c imf2 coef.h mac.c srrc.c

dds_table.h duc_test.c imfl_coef.h imf3.c mixer.c srrc_coef.h

c:\Vivado_ HLS_Tutorial\RTL_Verification\lab2>vivado_hls -f run_hls.tcl

Figure 8-10: Setup for RTL Verification Lab 2
3. Open the Vivado HLS GUI project by typing vivado hls -p duc_ prj.
4. Click the Run C Synthesis toolbar button to synthesize the design to RTL.

5. Click the Run C/RTL CoSimulation toolbar button to launch the Co-simulation dialog
box.

In this case, you will produce a trace file you can open using the Vivado Simulator.

6. In the Co-simulation Dialog box:
a. Leave the default auto selection (using Vivado Simulator and Verilog).

b. Activate the Dump Trace drop-down menu and select the all option, to have the
options shown in Figure 8-11.

c. Click OK to execute RTL CoSimulation.
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¢ Co-simulation Dialog X

C/RTL Co-simulation

Verilog/VHDL Simulator Selection

Auto w
RTL Selection
(®) Verilog (JVHDL
Options

[ Setup Only

Dump Trace |port

[[] Optimizing Cornpile

[J Reduce Diskspace
Wave Debug

[] Disable Deadlock Detection

Compiled Library Location | Browse...

Input Arguments |

] Do not show this dialog box again.

Figure 8-11: Co-simulation Dialog Box for Lab 2

When RTL verification completes, the CoSimulation report automatically opens. The report
shows that the Verilog simulation has passed (and the measured latency and interval). In
addition, because the Dump Trace option was used with the Vivado Simulator simulator
option and because Verilog was selected, two trace files are now present in the Verilog
simulation directory. These are shown highlighted in Figure 8-12.
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[ Explorer
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2 = 8

sim -

» = autowrap

» = report
=t

F

Figure 8-12:
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= verilog
“@ check_sim.tcl
ait duc_am_submul_16s_16s_18s_32 4v
st duc_ama_addmuladd_18s_18s_16s5 325 32 3w
rit duc_ama_submuladd_18s_18s_165_32s_32 3
= duc_c_ 2 rom.dat
ad duc_c_2v

= duc_c_3 rom.dat

[

Ril duc_c_3v
= duc_imf2_c_ 1 rom.dat

P

duc_imf2_c_lv
=l duc_imf2_shift_reg_p_ram.dat

RTI

st duc_imf2_shift_reg_p.v
it duc_imf2y
= duc_imf3_c_0_rom.dat

rd duc_imf3_c 0w

m

= duc_imf3_c_rom.dat

st duc_imf3_cv

=l duc_imf3_shift_reg_p0_ram.dat
st duc_imf3_shift_reg_pO.v

rit duc_imf3.v

st duc_mac_muladd_18s_18s 38ns_38 4w
=l duc_mixer_dds_table_rom.dat
s duc_mixer_dds_tablew

= duc_mixer_DI_cache_ram.dat
s duc_mixer DI cachev

it duc_mixery

|=l duc_shift_reg_p_1_ram.dat

st duc_shift_reqg_p_lv

|=l duc_shift_reg_p_2_ram.dat

st duc_shift_reqg_p_2.v

sl duc.autotby
duc.performance.result.transaction.xml

= duc.prj

|5l ducresultlatrb

W ductcl

arit ducy

|5 ducwcfg

=l ducwdb gl

Verilog Vivado Simulator CoSimulation Results
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High-Level Synthesis

The next step is to view the trace files inside the Vivado Design Suite.

Since waveform trace data has been generated for the Vivado Simulator, the Open Wave
Viewer toolbar button is now highlighted, as shown in Figure 8-13.

Note: The Open Wave Viewer toolbar button can only be used when Vivado Simulator is selected
as the Verilog/VHDL Simulator.

File Edit Project Solution Window Help

X O R EGWR RO P B S

Figure 8-13: Opening the Trace File in Vivado

7. Click on the Open Wave Viewer toolbar button to open the Vivado IDE with the RTL
waveforms traces.

Note: The only functionality provided by the Vivado IDE by this action is the viewing and analysis of
RTL waveforms.

You can then view the waveforms in the waveform viewer. Figure 8-14 shows the zoomed
waveforms where the output data ports and their associated 1/O protocol signals (output
valid signals) are expanded to view.

duc.wcfg

Q H | a Q |2X| o |I4|M +

100 us

% C Outputs

% |Design Top Signals ‘ ‘

~ W dout_g{wire)

W dout_q_ap_vid 0

o dout_q[17:0] 00000 ! OTEEKKEKEK
W dout_i(wire)
w dout_i_ap_wvid 0

¥ dout_i{17.0] 00000 5 -Ei_ﬁi_'_l._'-li'_]f.':Til-l-lllilﬁ""-r:-'-'{fl KRN ™

% Clinputs ‘

W din_i(wire) ‘ l |
W din_i[17:0] 00000 ) :
% Block-level 10 Handshake \

W freq(wire)
» W freq[15:0] e K 15e

o ap_star

= ap_done

o ap_idle

W ap_ready
% Reset

- 397r51

% Clock

W ap_clk

Figure 8-14: Analyzing the RTL Trace File
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8. Exit the Vivado IDE.
9. Exit and close the Vivado HLS GUI.

Lab 3: Viewing Trace Files in ModelSim

This exercise explains how you can generate and view RTL trace files and using the Mentor
Graphics ModelSim RTL simulator. Other third-party simulators are supported, and similar
process can be used if another RTL simulator is selected.

C CAUTION! This lab exercise requires that the executable for ModelSim is defined in the system search
path and that the required license to perform HDL simulation is available on the system.

Step 1: Create an RTL Trace File using ModelSim

1. From the Vivado HLS command prompt you used in Lab 2, change to the 1ab3
directory.

Create a new Vivado HLS project by typing vivado hls -f run hls.tcl.
Open the Vivado HLS GUI project by typing vivado _hls -p duc_prj.
Click the Run C Synthesis toolbar button to synthesize the design to RTL.

vk W

Click the Run C/RTL CoSimulation toolbar button to launch the Co-simulation dialog
box.

This exercise uses the Mentor Graphics ModelSim RTL simulator. The path to the simulator
executable must be set in your system search path.

6. In the Co-simulation Dialog box:
a. Select ModelSim from the Verilog/VHDL Simulator Selector.
b. Select VHDL.

c. Activate the Dump Trace drop-down menu and select the all option, to have the
options shown in Figure 8-15.

d. Click OK to execute RTL CoSimulation.
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¢# Co-simulation Dialog @

C/RTL Co-simulation

Verilog/VHDL Simulator Selection

ModelSim -

RTL Selection

() Verilog @ VHDL
Options

[] Setup Only

Dump Trace

[ Optimizing Compile

|| Reduce Diskspace

Compiled Library Location

Input Arguments

[] Do not show this dialog box again.

[ OK l l Cancel

Figure 8-15: Co-simulation Dialog Box for Lab 3

When RTL verification completes, the CoSimulation report automatically opens, showing
the VHDL simulation has passed (and the measured latency and interval). In addition,
because the Dump Trace option was used with the ModelSim simulator option and because

VHDL was selected, a trace file is now present in the VHDL simulation directory. The trace
file is shown highlighted in Figure 8-16.
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[ Explorer &2 ¥ = B
4 2 duc_prj -
e Includes
= Source

= Test Bench
a4 Y= solution1
& constraints
= csim
4 = sim
= autowrap
= report
= tv
4 = vhdl
st AESL_sim_pkg.vhd
W check_sim.tcl
E compile_modelsim.sh

11

= cosim.modelsim.scr

s duc_c_l.whd

s duc_c.vhd

s duc_mul_175_18s_32 4.vhd

s duc_mul_18s_17ns_35_3.vhd

rrd duc_mul_18s 18s 36 3.vhd

sl duc_mul_19s_16s_32 3.vhd

s duc_shift_reg_p_lvhd

s duc_shift_reg_p.vhd

s duc.autotb.vhd

El duc.performance.result.transaction.xml
=l duc.resultlatrb

s ducvhd

= duc.wlf

sl imf2_c_2.vhd

st iImf2_shift_reg_p_2vhd -

Figure 8-16: VHDL ModelSim Trace File

The next step is to view the trace files inside ModelSim.

7. Exit the Vivado HLS GUI and return to the command prompt.

Step 2: View the RTL Trace File in ModelSim

1. Launch the Mentor Graphics ModelSim RTL Simulator.

2. Click the menu File > Open.

3. Select Log Files as the file type (Figure 8-17).
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4. Navigate to the VHDL simulation directory and select duc.wlf.
5. Click Open.

ﬁ Open File @
@Ov\ <« OSDisk (C) » Vivado_HLS Tutorial » RTL Verification » lab3 » duc_prj » solutionl » sim » vhdl » | 42 || Search vhal 2|
Organize ~ New folder =~ 1 @

=
" Name Date modified Type Size
L. work 3/6/2013 4:52 PM File folder
ducwlf 3/6/2013 4:52 PM WLF File 3,936 KB
3 |
NE
& ¢
&
F
File name: ducwlf - ILDg Files (*.wlf) v]
[ Open |v| l Cancel l

Figure 8-17: ModelSim Open File WLF

6. Add the signals to the trace window and adjust to see a view similar to Figure 8-18.
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Figure 8-18: Viewing the Trace File in ModelSim

7. Exit and close the ModelSim RTL simulator.
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Conclusion

In this tutorial, you learned how to:

« Perform RTL verification on a design synthesized from C and the importance of the test
bench in this process.

« Create and open waveform trace files using the Vivado Design Suite.

« Create and open waveform trace files using a third-party HDL simulator (ModelSim)
and view the trace file created by RTL verification.
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Chapter 9

Using HLS IP in IP Integrator

Overview

You can package the RTL from High-Level Synthesis and use it inside IP integrator. This
tutorial demonstrates how to take HLS IP and use it in IP integrator as part of a larger
design.

This tutorial consists of a single lab exercise.

Lab 1 Description

Complete the steps to generate two HLS blocks for the IP catalog and use them in a design
with Xilinx IP, an FFT. You validate and verify the final design using an RTL test bench.

Tutorial Design Description

You can download the tutorial design file from the Xilinx Website. See the information in
Locating the Tutorial Design Files.

This tutorial uses the design files in the tutorial directory Vivado HLS Tutorial\
Using IP with IPI.

The design blocks in this tutorial process the data for a complex FFT.

« The Xilinx FFT IP block only operates on complex data. Although you can perform an
FFT of real data on a complex data set with all imaginary components set to zero, it can
be done more efficiently by pre-processing the data.

» The front-end HLS block in this lab applies a Hamming windowing function to the 1024
(N) real data samples and sends even/odd pairs to an N/2-point XFFT as though they
are complex data.

« The back-end HLS block takes bit-reverse ordered data, puts it in natural order and
applies an O(N) transformation to FFT output to extract the spectral data for the
N-point real data set. Note, the first output pair packs the Oth and 512th (purely real)
spectral data point into the real and imaginary parts, respectively.
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« The designs are fully pipelined, streaming designs for high throughput; intended for
continuous processing of data, but with throttling capability (stalls if input stalls).

« AXl4-Stream interfaces are used to connect all blocks in IP integrator.

Lab 1: Integrate HLS IP with a Xilinx IP Block

This lab exercise shows how two HLS IP blocks are combined with a Xilinx IP FFT in IP
integrator and the design verified in the Vivado Design Suite.

ﬁ IMPORTANT: The figures and commands in this tutorial assume the tutorial data directory
Vivado_HLS_Tutorial is unzipped and placed in the location C:\Vivado_HLS_Tutorial. If the tutorial data
directory is unzipped to a different location, or on Linux systems, adjust the few pathnames referenced,
to the location you have chosen to place the Vivado_HLS_Tutorial directory.

Step 1: Create Vivado HLS IP Blocks

Create two HLS blocks for the Vivado IP Catalog using the provide Tcl script. The script runs
HLS C-synthesis, RTL co-simulation and package the IP for the two HLS designs
(hls real2xfft and hls xfft2real).

1. Open the Vivado HLS Command Prompt.

- On Windows use Start > All Programs > Xilinx Design Tools > Vivado 2020.1 >
Vivado HLS > Vivado HLS 2020.1 Command Prompt.

o On Linux, open a new shell.

2. Using the command prompt window, change the directory to
Vivado HLS Tutorial\Using IP with IPI\labl\hls designs (Figure 9-1).

3. Type vivado hls -f run hls.tcl to create the HLS IP (Figure 9-1).

C:\Vivado_HLS_Tutorial>cd Using_IP_with_IPI

C:\Vivado_HLS_Tutorial\Using_IP_with_IPI>cd lab1l

C:\Vivado_HLS_Tutorial\Using_IP_with_IPI\labl1>cd hls_designs

C:\Vivado_HLS_Tutorial\Using_IP_with_IPI\lab1\hls_designs>vivado_hls -f run_hls.
tecl

4 [

Figure 9-1:  Create the HLS Design for IP Integrator

When the script completes, there are two Vivado HLS project directories, fe vhls prj
and be_vhls_ prj, which contain the HLS IP, including the Vivado IP Catalog archives for
use in Vivado designs.
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« The "front-end” IP archive is located at fe_vhls prj/IPXACTExport/impl/ip/

« The "back-end” IP archive is located at be_vhls prj/IPXACTExport/impl/ip/

The remainder of this tutorial shows how the Vivado HLS IP blocks can be integrated into a
design (in IP integrator) and verified.

Step 2: Create a Vivado Design Suite Project

1. Launch the Vivado Design Suite (not Vivado HLS):

o On Windows use Start > All Programs > Xilinx Design Tools > Vivado 2020.1 >
Vivado 2020.1.

o On Linux, type vivado in the shell.

2. From the Welcome screen, click Create Project (Figure 9-2).

Eile  Flow Tools  Window  Help Q- Quick Access

VIVADO!

HLx Editions

Quick Start

Create Project >

Open Project »

Open Example Project »

Tasks

Manage IP >
Open Hardware Manager »

Xilinx Tcl Store >

Learning Center 1

Figure 9-2: Create a Vivado Project

3. Click Next on the first page of the Create a New Vivado Project wizard.

4. Click the ellipsis button to the right of the Project location text entry box and browse to
and select the tutorial directory (Figure 9-3).
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42 Choose Project Location

31

Recent: | & C:f -

-
5}
[
=

%

i
x
G
B4
5

Directory: C:\Vivado_HLS_Tutorial\Using_IP_with_IPT\lab1

Titus -
Users

Vivado_HLS
Vivado_HLS_Tutorial
Arbitrary_Precision
C_Validation
Design_Analysis
Design_Optimization
Interface_Synthesis
Introduction
RTL_Verification
Using_IP_with_IPI
--miﬂs_designs
E=8 verilog_tb
Using_IP_with_SysGen -
Lisina TP with Fwnn (=]

m

’ Select ” Cancel

Figure 9-3: Path to the Vivado Design Suite Project
5. Click Next to move to the Project Type page of the wizard.
a. Select RTL Project.
b. Select Do not specify sources at this time (if not the default).
c. Click Next.

6. On the Default Part page, under Specify, click Boards and select the ZYNQ-7 ZC702
Evaluation Board, as shown in Figure 9-4 and press Next.
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A New Project

Default Part

Select: {8k Parts | [ Boards

~ Filter/ Preview

Vendor: All w

Display Mame: | All w

Board Rewv Latest w
Search: w

Display Mame
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@ Kintex Ultrascale+ KCU11& Evaluation Platform

@ Kintex UltraScale KCU1500 Acceleration Development Board
@ virtex-7 VC707 Evaluation Flatform

@ virtex-7 VC709 Evaluation Flatform

@ virtex-Ultrascale VCU108 Evaluation Platform

@ virtex-Ultrascale VCU110 Evaluation Platform

@ virtex Ultrascale+ VCU118-E51 Evaluation Platform

| @ ZYnNQ-7 2C702 Evaluation Board

@ 7yNQ-7 ZC706 Evaluation Board

@ Zyng UltraScale+ ZCU102 Evaluation Board
<

Board Connectors
FMC1_LPC
FMC2_LPC

Choose a default Xilinx part or board for your project. This can be changed later.

Vendor Board Rev
xilinx.com 1.0
xilinx.com 1.0
xilinx.com 1.0
xilinx.com 11
xilinx.com 1.0
xilinx.com 1.0
xilinx.com 1.0
xilinx.com 11
xilinx.com 1.0
xilinx.com 11
xilinx.com 1.0

Target Connactions

Part 1/0 Pin Co

8 xcku040-fivalls6-2-e 1,156 &

& xckuSp-fivib676-2-2 578

8 xckull5-fivb2 104-2 -8 2,104

{8} xc7vi4851ffgl761-2 1,761

8 xcTVE90Mfg1761-2 1,761

8 xow095-ffva2 104-2-e 2,104

8 xow190-flgc2 104-2 -2 2,104

& xow9p-flga2 104-2L-e-as1 2,104

8 xc72020clg484-1 484

{8} xc7z0451fg900-2 Q00

8 xczu9eg-fivib1156-2-i 1,156 -
3
A
A

Figure 9-4: Vivado Project Specification

7. On the New Project Summary Page, click Finish to complete the new project setup.

The Vivado workspace populates and appears as shown in Figure 9-5.
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.
Step 3: Add HLS IP to an IP Repositor
L]
1. In the Project Manager area of the Flow Navigator pane, click IP Catalog.
=
[ * IP Catalog x
°
u o
Hierandvy
L
DeLails

Figure 9-6: Open the IP Catalog

2. The IP Catalog appears in the main pane of the workspace. Click the IP Settings icon.
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A Settings x

IP = Repository
2 Add directories to the list of repositories. You may then add additional IP to a selected ’

Project Settings
repository. If an IP is disakled then a tool-tip will alert you to the reason.

General

Simulation

Elaboration IP Repositories
Synthesis +
Implementation

Bitstream
~ P
Repository

Fackager

Tool Settings
Projact Refrash All

IP Defaults

Source File

Display

WebTalk

Halp

Teaxt Editor

3rd Party Simulators

w

w

Colors

Selaction Rules

Shortcuts

Strategies

» Remote Hosts

> Window Eehavior w

o | B

]

store...

Figure 9-7: Open the IP Catalog Settings
3. Right-click and select Add Repository.
4. In the IP Repositories dialog:

a. Browse to the tutorial directory,
Using IP with IPI\labl\hls designs\fe vhls prj\IPXACTExport\im
pl\ip as shown in Figure 9-8.

b. Click Select to close the IP Repositories window.
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¢ IP Repositories

Recent: | = C:fVivado_HLS_Tuterial/Using_IP_with_IPL/labl/hls_designs/fe_vhls_prj/IPXACTExport/impl... v

Directory: | C:\Wivado_HLS_Tutorial, L[yls S

T\lab1\hls_designs\fe_vhls_pri\IPXACT Export\impl\ip

TH= g

55

mEXDIS

= | Vivado_HLS_Tutorial -
[ | Arbitrary_Precision
| C_Validation
| Design_Analysis
| Design_Optimization
| Interface_Synthesis
t- | Introduction |
H- | RTL_Verification
| Using_IP_with_IPI
= | lab1 =
B Xl
: hls_designs 1
[H- | be_vhls_prj
= A fe_vhls_prj
=+ | IPXACTExport
- | .autopilot
- | csim
E| | impl
=20
) il
| bd
- | constraints -
M- L doc =
Select ] ’ Cancel
Figure 9-8: Create a New IP Repository
5. Press Select to accept the new repository, then select OK on the added repository.
6. Follow the same procedure to add the second HLS IP package:
labl/hls designs/be vhls prj/IPXACTExport/impl/ip/.
7. Click OK to exit the dialog box.
A Vivado HLS IP category now appears in the IP Catalog as HLS IP (Figure 9-9).
Project Summary * | IP Catalog X 700
Cores | Interfaces
= F F o4 | o]
Name Al pxi4 Status License VLNV
~ User Repaository (fwrk/xbj_wvdi/brucey/homefUGEB7 1/ug87 1-design-files/Using_IP_with_IPI/lab 1 /hls_designs/fe_vhis_prj/IFXACTExport /impl/ip) o
~ VIVADO HLE P
4F His_real2xfft AX|4-5tream Pre-Production  Included xilinx.com:hls:his_real2xff1:1.0
~ User Repository (/wrk/xb]_vdi/brucey/home/UCE7 1/ug87 1-design-files/Using_IP_with_IPI/lak 1/hls_designs/be_vhis_pr}/IPXACT Expart/impl/ip)
~ VIVADO HLS IP
4F His_xfft2real AX|4-5tream Pre-Production  Included xilinx.com:hls hls_xfft2real:1.0
~ Vivado Repository
» Alliance Fartners
¥ Autormnotive & Industrial
> AXI Infrastructure
> BaselP
> Basic Elements i
Details
Selact an IP or Interface or Repository to see datails

Figure 9-9: 1P Catalog with HLS IP
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Step 4: Create a Block Design for RealFFT

1. Click Create Block Design under IP integrator in the Flow Navigator.

a. In the resulting dialog box, name the design RealFFT.

b. Click OK.
File Edit Flow Tools Window Layout View Help
Pilmdl ) X9 P ¥ S K| Z E |2 pefault Layout ~ e R ®
Flow Navigator « Project Manager - project_1
Q= Sources — O v = L Project Summary x |iF IP Catalog X
A= weh B 31| search:

4 Project Manager

. . 2 Design Sources = 1
Project Settings : L

?’ L < 5 Constraints | Name

@7 Add Sources == Simulation Sources = gk ECC

' Language Templates 5 sim_1 ENg iF Ethernet 1000BASE-X PCS/PMA or SGMII

1F P catalo By iF Ethernet PHY MII to Reduced MII

£ % £F Fast Fourier Transform
I} |£F FIFO Generator

a P InFegrator :D: iF FIR Compiler

;7 Create Block Design W& Fixed Iterval Timer

¥ Open Block Design .
) : ¢ Create Block Design
Generate Block Design Hierarchy | Libraries | Comy

4 Simulation & Sources | 7 Templat Flease specify name of block design.

% simulation Settings IP Properties

(i, Run Simulation & 0 Design name: RealFFT]|
4 RTL Analysis i Hls_real2xdft Directory: & <Local to Project> -

. B i

= Open Elaborated Design Version: 1.0 (Rev. 1411 Specify source set: 1 Design Sources -
4 Synthesis Interfaces:  AXI4-Stream

@ Synthesis Settings Description: An IP generate

@ Run Synthesis Status: Pre-Production

) ; OK Cancel
> [@¥ Open Synthesized Design License: Included ] I fo HLS

4 (1] T | Sfatie: Fra-Fradurcfinn

4 Tmnlamantatinn

Figure 9-10: Create Block Design

The upper-right pane now has a Diagram window. Add a Xilinx FFT IP block to the design
and customize it.

2. In the Diagram tab click the Add IP link (Figure 9-11).
a. Inthe Search box type fourier.
b. Select Fast Fourier Transform.

c. Press Enter.
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[P
X

J I= Diagram X O
#] 4 RealFFT

Search: | O fourier] (3 matches)

Discrete Fourier Transform

ENTER to select, ESC to cancel, Ctrl+Q for IP details

This design is empty. Press the 3F button to add IP.

FCQedR S IHALIZEAR

Figure 9-11: Add the Xilinx FFT IP

The Xilinx IP block FFT is now instantiated in the design, as shown in Figure 9-12.
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e
Fast Fourier Transform

] »

m

Figure 9-12: Xilinx FFT IP

3. Double-click the new Fast Fourier Transform IP symbol to open the Re-customize IP

dialog box.

4. On the Configuration tab (Figure 9-13):

a. Change the Transform Length to 512.

b. Select Pipelined, Streaming 1/0 in the Architecture Choice section.
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LF Re-customize IP
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il Documentation [ TP Location
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Figure 9-13: Xilinx FFT Configuration

5. Select the Implementation tab (Figure 9-14):

a. Select ARESETN (active low) in the Control Signals group.

b. Verify that Non Real Time is selected as Throttle Scheme.

c. Click OK to exit the Re-customize IP dialog box.
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Figure 9-14: Xilinx FFT Implementation

Add one instance of each of the HLS generated blocks to the design.

6. Right-click in any space in the canvas and select Add IP (Figure 9-15).
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Figure 9-15: Add IP Blocks

7. Type “hls” into the Search text entry box.

a. Highlight both IPs. (Click the control key and select both.)

b. Press Enter.

The design block now has three IP blocks, as shown in Figure 9-16.
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Figure 9-16:

RealFFT IP Blocks

The next step is to connect HLS blocks to the FFT block and ports.

8. Hover the cursor over the dout interface connector of the H1s real2xftt block until

pencil cursor appears.

a. Left-click and hold down the mouse button to start a connection.

b. Drag the connection line to the S_AXIS DATA port connector of FFT block and
release (when green check mark appears next to it).

9. In a similar fashion, connect the FFT's M_AXIS DATA interface to the din interface of

the Hls xfft2real block.

The two connections are shown in Figure 9-17.
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5= Diagram X O
#l & RealFFT

T
*

his_xfft2real 0 hls_real2xfft_0
ﬂ -J|ll= m"ﬂﬂ Virada™ LS E -J|ll= dh_‘l’_\r Virada™ LS
| ddin dout V4 l #-2p con A [ = xfmt_0

|
M_AXIS_DATA - [
evernt_frame_started

rstn
= = SFS_AXIS_DATA
His_xfft2real (Pre-Production) His_real 2xfTt {Pre-Production) L event_tlast_unexpeded

1

_clk
_rst_n

B 4k5_ANIS_CONFIG

. ;;( B event_tlast_missing
evernt_status_channel_halt

—aresetn

event_data_in_channel_halt
evert_data_out_channel_hat

Fast Fourier Transform

CREQAN S, G IHL,ODTERR

P
I

P

Figure 9-17: Connecting Ports on the IP Blocks

To create I/O ports for the design, make some external connections.

10. Right-click the din_V_V interface connector on the hls real2xfft block and select
Make External (Figure 9-18).

Z= Diagram X O
3 & RealFFT

Tu
#

his_real2xf_0

his_xfTt2real_0
din_v_V 4 -

His_real2xft (Pre-Production) Slrs AE CONFIG event_tizst_unexpected

Hls_xfft2 real (Pre-Production)

Fast Fourier Transform

R SEQW R IIHA,SDZERR

s
*

Figure 9-18: Make External Connections
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11. Give the new interface port a unique name.
a. Click the port symbol to highlight it.

b. In the External Interface Properties pane (Figure 9-19), click in the Name text entry
box to highlight din_ Vv _V.

c. Type real2xfft din and press Enter.

f IMPORTANT: Property changes might not take effect if this re-naming step is not done.

Block Design - RealFFT *

I
X

Design - o i Diagram X
Q, I [E E= 3l 4, RealFFT
% RealFFT

[=H= External Interfaces

@D

= Interface Connections

+-8F ¥fft_0 (Fast Fourier Transform:9.0)

real 2xfft_din

£ Sources-, H Design Signals | @ Board

External Interface Properties S i I E
PN
= real2xfft_din

CCROQM LY BHLOOTE LR

Name: real2xfft_din

Mode: SLAVE

Connection: | <= din_V_V_1

Clock Port: There are no clock ports in this design.

General | Properties ¢

Figure 9-19: Port Naming

12.In a similar manner to the previous step:

a. Make the dout V interface of the H1s xfft2real block external and rename it
xfft2real dout.

13. Right-click the aclk connector of FFT block and select Make External.

14. Right-click the aresetn connector of the FFT block and select Make External.
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15.Tie the ap_start ports of both HLS blocks High.
a. Right-click the canvas and select Add IP.
b. Type const into the Search text entry box.
c. Select Constant IP.

d. Double-click the Constant IP symbol (Figure 9-20) and verify that Const Width and
Const Val are set to 1.

e. Click OK to close Re-customize IP dialog box.

+F Re-customize IP (5
Constant (1.1) ‘
i bocumentation [ IP Location

Show disabled ports Component Name  xlconstant_0

Const Width | 1| [1 - 4096]
Const Val 1

OK | | Cancel

Figure 9-20: Constant IP Properties

f. Expand the ap ctrl bus port on both hls xfft2real and hls real2xfft
(click the plus symbol associated with each port).

g. Connect ap_start in both HLS blocks to the Constant block (Figure 9-21).
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Diagram 200X
Q a 4 X o Q + ® C g o

,-* Designer Assistance available. Run Connaction Autamation

his_xfft2real_0

his_realzxfft_ 0
== din V.V
din_V_V_TVALID
B din Vo fft2real_dout

4 din_V_V_TREADY
b din_V_V_TDATA[15:0]

— ap_crl Vi 13
< ap_done P dout 4
> ap_sart
- xfft_0
< ap_ready
4 ap_idle M_AXIS_DATA +[Z—d
ap_dlk B armzmn event fame started

xlconstant_0
L =y mip— event_tlast_unexpected

aclk

event_tlast_missing
event_status_channel_halt
event data_in_channel_halt
event_data_out_channel_halt

dout [0:0]

aclk D—| His_real2xfft (Pre-Production)
aresetn D—‘ Constant

aresemn

Fast Fourier Transfarm

Figure 9-21: Connect AP_START to Constant
16. Make the remaining connections.

a. Click and drag from the aclk connector of hls real2xfft and hls xfft2real
blocks to the aclk external port (or aclk connector on FFT block or anywhere on
“wire"” connecting them).

b. Connectap rst n of the hls real2xfft and hls xfft2real blocks to the
aresetn network.

17. Click the Regenerate Layout icon to clean up and reorganize the Block Design.

Diagram 00X
nA R I
a X ® 0 Q + ¢ C 9 & &
his_xfftZreal_0
hls_real2xfft_0 NIl = ap_ctrt
real 2 xfft_din [ —1 din V.V
I}~ ap_ari I s
<ap_done [ xfft_0 dout ¥ 4 Ge——f> xfft2real_dout
::"’::: dout + Gt M_ANIS_DATA 45
xlconstant_0 ST ‘ | event_frame_started
< ap_idke =4 §_AXIS_DATA Py o
E event_thst_unexpecte
dout[0:0] Z|4 5_AXIS_CONFIG e
S GO His_xfft2real (Pre-Production)
Constant L d aresen event_status_channel_hatt - ’
ack > His_real2xfft (Pre-Production) | event data_in_channel_halt
aresetn [ : event_data_out_channel_halt
Fast Fourier Transfarm

Figure 9-22: Re-generated Design Diagram

18. Click the Validate Design button to validate the design is correct.

The validate design will show some warnings. These are related to the s_axis_config pin of
the FFT.
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a. The XFFT configuration interface is left unconnected because this design always
operates in the default mode of the core.

b. Click OK to close the messages.
19. Click File > Save Block Design.
20. Close the Block Design.
21. The next step is to generate output products.

a. In the Sources window (Figure 9-23), right-click RealFFT.bd and select Generate
Output Products.

b. Click Generate in the resulting dialog to initiate the generation of all output
products.

c. Select OK to ignore the warnings discussed above.

| @ % E 5 | ES Default Layout - \\\ )

Project Manager - project_1

Sources — O @ = L Project Summary X

B D opdg N =
N b ot @ | = #3 Project Settings
=I5 Design Sources (1) | Iiﬂ

P Project name: projec
+ | Canstraints (1) & Source Mode Properties.., Ctrl+E uck Family: Zyng-
=i Simulation Sources (1) | [ Open File Alt+0 bct part: AN
Fh-E sim_1 (1)
Create HDL Wrapper rmodule narne: Mok O
Wiews Instantiation Template Synthesis
Generate Output Products..,
Reset Cutput Products.., us: = Ready
72020cl948¢
Export Hardware for SDE... Feradaiely

tegy: Wivado Synthe
Package Block Design.., o

Hierarchy | IF Sources | Lib

&5 Sources | 77 Templ
Source Node Properties Al DRC Yiolations
i # Remove File fram Project... Delete
|
#, RealFFT (RealFFT.bd) Ali3epElE DRC information i

Disable File Alt+Minus
Module: Re. g .

Figure 9-23: Generating Output Products
22. Create an HDL Wrapper.

a. In the Sources window, right-click RealFFT.bd and select Create HDL Wrapper.
This is the same procedure and menu as described in the previous step.

b. Click OK and let Vivado manage the wrapper.

Step 5: Verify the Design

The next step in creating the final design is to verify design with the HDL test bench
provided in the lab exercise: realfft rtl tb.v.

High-Level Synthesis N Send Feedback 196
UG871 (v2020.1) August 7, 2020 www.xilinx.com [—\/—]


https://www.xilinx.com
https://www.xilinx.com/about/feedback/document-feedback.html?docType=Tutorials&docId=UG871&Title=Vivado%20Design%20Suite%20Tutorial&releaseVersion=2020.1&docPage=196

(: X”_INX® Chapter 9: Using HLS IP in IP Integrator

1. Right-click Simulation Sources in the Sources tab of the Project Manager pane
(Figure 9-24).

2. Select Add Sources.

J V ” M \[:} W L \':'j £S5 LElduiL Ldyuue - . i D&\ k=4
Block Design - RealFFT
Sources — O @ = E= Diagram X | ¥ RealFF
AT B B B | < edinixftutorislsHLS _IF
=7 Design Sources (1) 1 ‘t,:i.lm.asc:ale 1 p
| [H-E88% RealFFT_wrapper (RealFFT_wrapper. ) (1) 2// lib IP_Inteq
+ Constrainks (11 3module RealFFT
= 7 B nulabion SOl ’éf' 4 [aclk,
Fh-E sim_1 (1) Ctrl+E - j 5 aresetn,
Hierarchy Update 3 :ﬁ & realdxffr
. 4= 7 lzxffr
@  Refresh Hierarchy pea axtit f
X| 8 realZxffr_o
Edit Constraints Sets.., il ] realZxEfr_¢
Edit Simulation Sets... |40 realZxffe ¢
=EL xfftireal ¢
B Add Sources.., Alt+a, CH:J 12 wEEtZreal o
|13 xfftiZreal ¢
& 14 xfftiZreal ¢
@15 xEftZreal ¢
Hierarchy | IP Sources | Libraries | Compile Order 8 16 input aclk;
4% Sources | [ Design Hierarchy = 17 input areset
4p |18 input [31:001
Properties — 0O Q@ = |18 input [3:0]r
« [P |20  dinput [0:07re
21  output realZ:

Figure 9-24: Adding Simulation Sources
3. Select Add or Create Simulation Sources in the Add Sources dialog box.

4. Click Next.
5. In the Add Sources dialog box, click the “+” symbol Figure 9-25 and select Add Files.
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¢ Add Sources @

Add or Create Simulation Sources

Specify simulation specific HOL files, or directories containing HOL files, to add to your project. Create a new source file on disk and add ‘
it to your project.

Specify simulation set: | &= sim_1 A
+
- Add Files...

Add Directories...

Create File...

Use Add Files, Add Directories or Create File buttons below

Add Files ] ’ Add Directories ] ’ Create File

Scan and add RTL include files into project
Copy sources into project
Add sources from subdirectories

Include all design sources for simulation

Figure 9-25: Add Source Dialog Window

6. Browse to the file realfft rtl tb.wv in the tutorial directory
Using IP with IPI\labl\verilog tbh.

7. Select it and click OK.
8. Select the checkbox Copy sources into the project (Figure 9-26).
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4. Add Sources @

Add or Create Simulation Sources

Specify simulation specific HDL files, or directories containing HOL files, to add to your project. Create a new source file on '?1‘/
disk and add it to your project.

Specify simulation set: | &= sim_1 -
Index  Name Library  Location
@ 1 realfft_rtl_tb.v work C:fVivado_HLS_Tutorial/Using_IP_with_IPI/labl/verilog_tb
b2
£
[ AddFiles.. | I Add Directories... ‘ I Create File...

["] scan and add RTL include files into project
Copy sources into project
Add sources from subdirectories

Include all design sources for simulation

Next = Finish ‘I Cancel

Figure 9-26: Copy Design Sources

Note: When you copy the design source files into the project, edits to the file(s) are not
automatically propagated to the original source file.

9. Click Finish.

10. Click Run Simulation in the Flow Navigator (Figure 9-27) and select Run Behavioral
Simulation.

Flows Mavigator L
4 Project Manager

@ Project Settings

O? Add Sources

ﬁ IP Catalog

4 TP Integrator
Iﬁ,”‘ Create Block Design
--,b Open Block Design

4 Simulation
@ Simulation Settings
() Run Simulation

Run Behaviaral Sirmulation

4 RTLA

>

Figure 9-27: Execute Simulation

11. Once the simulation has started, click the Run All icon to complete simulation.
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L S R i
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b | 55 Default Layout - \&\ 4] Em Jpiri 10 |us = | b= Q|8
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| * Run the simulation until there are no more events or until a Verilog pp
= =1 '$finish' or '$stop’.
2| =GB | & ~ L T ST |
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n

Tu

Design Unit Block Type | | Mame Value Data Type |

Figure 9-28: Run the Simulation to Conclusion

Conclusion

In this tutorial, you learned:

+ How to create Vivado HLS IP using a Tcl script.

« How to import a created design using IP integrator and include both Xilinx IP and the
Vivado IP blocks.

« How to verify the design in IP integrator.
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Chapter 10

Using HLS IP in a Zynqg SoC Design

Overview

A common use of High-Level Synthesis design is to create an accelerator for a CPU - to
move code that executes on the CPU into the FPGA programmable logic to improve
performance. This tutorial shows how you can incorporate a design created with High-Level
Synthesis into a Zynq device.

This tutorial consists of two lab exercises:

Lab 1 Description

You create and configure a simple HLS design to work with the CPU on a Zynq device. The
HLS design used in this lab is simple to allow the focus of the tutorial to be on explaining
the connections to the CPU and how to configure the software drivers created by
High-Level Synthesis to control the device and manage interrupts.

Lab 2 Description

This lab illustrates a common high performance connection scheme for connecting
hardware accelerator blocks that consume data originating in the CPU memory and/or
producing data destined for it in a streaming manner. The lab highlights the software
requirements to avoid cache coherency issues.

Tutorial Design Description

You can download the tutorial design file can be downloaded from the Xilinx Website. See
the information in Locating the Tutorial Design Files.

This tutorial uses the design files in the tutorial directory
Vivado HLS Tutoriall\Using IP with Zyng.

The sample design is a simple multiple accumulate block. The focus of this tutorial exercise
is the methodology, connections and integration of the software drivers. (The tutorial does
not focus on the logic in the design itself.)
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Lab 1: Implement Vivado HLS IP on a Zynq Device

This lab exercise integrates both the High-Level Synthesis IP and the software drivers
created by HLS to control the IP in a design implemented on a Zynq device.

i? IMPORTANT: The figures and commands in this tutorial assume the tutorial data directory
Vivado_HLS_Tutorial is unzipped and placed in the location C:\Vivado_HLS_Tutorial. If the tutorial data
directory is unzipped to a different location, or on Linux systems, adjust the few pathnames referenced,
to the location you have chosen to place the Vivado_HLS_Tutorial directory.

Step 1: Create a Vivado HLS IP Block

1. Open the Vivado HLS Command Prompt.

- On Windows use Start > All Programs > Xilinx Design Tools > Vivado 2020.1 >
Vivado HLS > Vivado HLS 2020.1 Command Prompt.

o On Linux, open a new shell.

2. Using the command prompt window, change the directory to
Vivado HLS Tutoriall\Using IP with Zyng\labl\hls macc (Figure 10-1).

3. Type vivado_hls -f run hls.tcl to create the HLS IP (Figure 10-1).

C:\Vivado_HLS_Tutorial>cd Using_IP_with_2Zynqg

C:\Vivado_HLS_Tutorial\Using_IP_with_2yng>cd labl

C:\Vivado_HLS_Tutorial\Using_IP_with_2Zyng\labl1>cd hls_macc

C:\Vivado_HLS_Tutorial\Using_IP_with_2Zyng\labl1\hls_macc>vivado_hls -f run_hls.tcliE

Figure 10-1: Create the HLS Design

When the script completes, there is a Vivado HLS project directory vhls prj, which
contains the HLS IP, including the Vivado IP Catalog archive for use in Vivado designs.

The remainder of this tutorial exercise shows how the Vivado HLS IP blocks can be
integrated into a Zynq design using IP integrator.

Step 2: Create a Vivado Zynq Project

1. Launch the Vivado Design Suite (not Vivado HLS):

- On Windows use Start > All Programs > Xilinx Design Tools > Vivado 2020.1 >
Vivado 2020.1.
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o On Linux, type vivado in the shell.

2. From the Welcome screen, click Create New Project (Figure 10-2).

¢ Vivado 2017.1

File  Flow Tools Window Help Q- QuickAccess

VIVADO'

HLx Editions

Quick Start

Create Project >
Open Project >
Open Example Project »

Tasks

Manage IP >
Open Hardware Manager >

Xilinx Tcl Store >

Learning Center

Documentation and Tutorials >

Quick Take Videos »

Tcl Console

Q =/ Il B B @

¢ start gui

Figure 10-2: Vivado Welcome Screen
3. In the New Project wizard:
a. Click Next.

b. In the Project Location text entry box, browse to the location of the tutorial file
directory Using IP with Zyng\labl and click Next (Figure 10-3).

c. On the Project Type page, select RTL Project and Do not specify sources at this
time (if it is not the default).

d. Click Next.
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¢ New Project l__ﬁ_:l

Project Name

Enter a name for your project and specify a directory where the project data files will be stored. ‘

Project name: project_1
Project location:  C:Vivado_HLS_Tutorial/Using_|IP_with_Zynagilab II‘

v | Create project subdirectory

Project will be created at C:MVivado_HLS_TutoriallJsing_IP_with_Zyngflabi/project_1

Figure 10-3: Specify the Vivado Project Directory
4. On the Default Part page:
a. Click Boards.
b. Select the ZYNQ-7 ZC702 Evaluation Board (Figure 10-4).
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§ New Project \_Xi__l

Default Part

Choose a default Xilinx part or board for your project. This can be changed later. [

Select @ Parts | [l Boards

~ Filter/ Preview

Vendor: All v

Display Name:  All v

Board Rey. Latest v

Reset All Filters
Search X v
’ " . Available  LUT "
Display Name Vendar BoardRev  Part /O Pin Count  File Version | 2 Elements  TIBFIoF
~

@ Virtex-UltraScale VCU110 Evaluation Platform Hilinx.com 1.0 @ xovu190-ge2104-2-e - 2,104 +1 418 1074240 214848
@ ZYNQ-7 ZCT02 Evaluation Board xilinecom 10 8 xc72020clg484-1 484 13 200 53200 106400
ZYNQ-7 ZCT06 Evaluation Board Filinx.com 14 8 xc7z045fig900-2 200 14 362 218600 437200
@ Zynq UitraScale+ ZCU102 Evaluation Board Filinx.com 1.0 8 xczu9eg-fub1156-2- 1,156 30 328 274080 548160,

€ £

Figure 10-4: Specify the Vivado Project Details
a. Click Next.

b. Click Finish on the New Project Summary Page.

The project workspace opens as shown in Figure 10-5.

High-Level Synthesis N Send Feedback 205
UG871 (v2020.1) August 7, 2020 www.xilinx.com [—\/—]


https://www.xilinx.com
https://www.xilinx.com/about/feedback/document-feedback.html?docType=Tutorials&docId=UG871&Title=Vivado%20Design%20Suite%20Tutorial&releaseVersion=2020.1&docPage=205

& XILINX.

Chapter 10

: Using HLS IP in a Zynq SoC Design

e £ few oo
& -
=TT
- PROJECT MANAGER
& Sengs
A Souces
Langusps Teplatn

T P Catsiog

~ P RTIGRATOR

Crease Block Dasign

~ SMLLATION

Fun Simetasen

v RTL AHALYEES

» Coen Blasceste Casign

TS
I Fun Smhests

¥

~ WPLOMENTATION

B FRun imglementation

~ PROGRAN AND DEBUG
1 Ganerate Desyeam

5 Gpen Hardwars Manages

¢ peoject_1 - [C/Vivado_HLS Tutorial/Using_IP_with_Zyna/labl/project_1/project_1apr] - Vivado 2017.1

ol B8
Wndsw Lt Yew  Hep Reesey
» B o X Commws v
PROUICT MANAGER - gesject_1 7 x
Saurean ? O  Project Summary
Q = & + L
Sattags  Eot
Denign Sources
P— Project nama project_1
S Progwet iscaton CNats_HLS_Teteassing IP_wih_Tmatsstpnnc, 1
sim_1 Prosuct tamay 2Zma 7000
Prigect part m i gasa.
Top mosuse name:
Tarpetiangusge
Simutaer language
e Boart Part
Outptay name 2MGT 2ET0T Dusteaton o
L R4 L Boadpatname  wlLcomzcTOZpaslld
L Connecton:
s
R ——
Boadovendew  ZYNG7 ZCTO2 Exaeation B
Syathesis impkmentation
st bt stanea s et startes
Wessages: o amors orwamings Massapss Ma erroes o wamings.
v PSR
QT € %
Hame Conswanes  Smmis WNE TS WS THE TPWS TotwPowsr FaledRouss LUT FF BRANS URAM DSP Sun Elased  Swaegy Pat Dascrgton
BORL1 conamit  Notstd Viads Simianis Detauits (Vieado Syrhetia 2017) TTHI0AEEA  Vheadn Symmeal
Impit consmat Netstsd o Datasts 1 2017)  wTAG0GEE  Delatssmegy

e for syrneais,

Figure 10-5:

Step 3: Add HLS IP to the IP Catalog

1. In the Project Manager area of the Flow Navigator pane, click IP Catalog.
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¢ project_1 - [C/Vivado_HLS_Tutorial/Using_IP_with_Zyng/labl/project_1/project_1.xpr] - Vivado

File  Edit Flow Tools Window  Layout View  Help Q- Quick Access
m, - > ¥ B =
Flow Navigator e B PROJECT MANAGER - project_1
w PROJECT MANAGER
Sources ? 00 X
£ Settings
Q ¥ & + : o
Add Sources
Design Sources
Language Templates
* Constraints
¥ IP Catalog ~ Simulation Sources
sim_1
v |P INTEGRATOR
Create Block Design
Open Block Design
Generate Block Design
~  SIMULATION Hierarchy Libraries Compile Order
Run Simulation
Properties ? 00 X
v RTL AMALYSIS R
» Open Elaborated Design
v SYNTHESIS
P Run Synthesis
. . Select an objectto see properties
» Open Synthesized Design

Figure 10-6: Open the IP Catalog

The IP Catalog appears in the main pane of the workspace.

2. Right-click in an open space, and select Add Repository.

Properties...

IP Settings...
Add Repository...
Refresh All Repositories

{if Compatible Eamilies
Product Webpage

Exportto Spreadsheet...

Figure 10-7: Open the IP Catalog Settings
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(: X”_INX® Chapter 10: Using HLS IP in a Zynqg SoC Design

3. Right-click on IP Catalog Canvas and select Add Repository.
4. In the IP Repositories dialog box:

a. Browse to the location of the IP created by Vivado HLS,
Using_IP_with_Zyng\lab1\hls_macc\vhls_prj\solutionT\imp\ip and click Select.

¢ Repositories

S ‘sg‘

M4

Recent: C:Vivado_HLS_TutoriallUsing_IP_with_Zynglab2/his_designs/be_vhls.. i "h 2 g v W | x J

Directory: CWivado_HLS_TutoriallJsing_IP_with_Zyngiab1thls_maccwhls_prjisolutionTimplip

~ Using_IP_with_Zyng
he lab1
» arm_src
~ hls_macc
A vhls_prj
hd solution
> .autopilot
> cgim
~ impl
b ip
b verilog
» vhdl
> sim
> syn
» project_1
» lab2
Windows
Xilinx
proj
wireless o

oW W W

Figure 10-8: IP Repository

5. Click OK to close the IP repository manager.
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Chapter 10: Using HLS IP in a Zynq SoC Design

Project Summary x| IPCatalog x 2006
Cores | Interfaces
= | S||Fw#F e 0 &
MName Al A4 Status License VLNV
A User Repasitory (/1 HLS_TutoriallUsing_IP_wi ynallao1/hls_maccivhls_prifsolution1Amplip 2
9F His_macc AXl4 Pre-Production  Included Filinx.com:hls:hls_macc:1.0
i Vivado Repository
4F 1G/2.5G Ethemet PCSIPMA or SGMII Production Included xlinx.com:ip:gig_ethernet_pcs_pma:16.0
4F 2D Graphics Accelerator Bit Block Transfer  AXI4 Production Purchase  logicbricks.com:logicbricks:logibitblt:0.0
4F 3GPP LTE Channel Estimator AXl4-Stream Production Purchase  xlinx.com:ip:lte_3gpp_channel_estimator:2.0
4F 3GPP LTE MIMO Decoder Production Purchase  xilinx.comip:ite_3gpp_mimo_decoder3.0
%F 3GPP LTE MIMO Encoder AXl4-Stream Production Purchase  xilinx.comip:ite_3gpp_mimo_encoder4.0
4F 3GPPLTE Turbo Encoder Production Purchase  xilinx.com:ip:icc_encoder_3gpplte:4.0
4F 3GPP Wixed Mode Turbo Decoder AXl4-Stream Production Included xilinx.com:ip:tcc_decoder_3gppmm:2.0
4F 3GPP Turbo Encoder Production Purchase  xilinx.com:ip:tcc_encoder_3gpp:5.0
4F 100G Ethernet MAC AXl4, AXI4-Stream  Production Purchase  xlinx.com:ip:ten_gig_eth_mac:15.1
4F 32-bit Initiator/Target for PCI (7-Series) Production Purchase  xilinx.com:ip:pci32:5.0
4F B4-bit Initiator/Target for PCI (7-Series) Production Purchase  xlinx.com:ip:pci64:5.0 ~
Figure 10-9: HLS IP in the Repository
6. There is now an HLS IP in the IP Catalog, Hls macc.
. . . f
Step 4: Creating an IP Integrator Block Design of the System
1. In the IP integrator area of the Flow Navigator, click Create Block Design and type
Zyng_Design in the dialog box.
¢ project 1 - [CyVivado HLS Tutorial/Using_IP with_Zyna/labl/praject_1/project_ Lypr] - Vivade 2017.1 o || & &2
fde  Eot  Flow Toos fndow Layoul  Yew  Help wiile_tits¥eam Complele E4
=, o] X r B 8 T ¥ 2 Defaun Lapout -
TR oo o z
~ PROJECT MANAGER
Sources ? ¥ T 1 Sl ¥ ® 1P Catnleg
£ setings
a = 2 + o coes
Add Sources
Lamgsgs Tompisess 7 Dol Soueeas e B s o0 Py
T— l;;i:;:v:?nqn.m-mr Hame At A Satus License VLIV
» Simulaton Sources . Usae Reocsto u
I 2 His_macc Aas Pre-Production  Inckeded  winecomchits:his_macc 1.0
¥ IFNTEGRATOR
e Feer S Vivado Repository
e € 162 56 Eume PCEPMA o SCI1 Peoducben Ichuged
Open Dlock Design 20 Graphics Accelerator Bt Block Transfer Producton Purchase
B 3GPP LTE Crannel Estrmstor Producton Purchase

Genprate Bock Design

v SuULATION
Run Simuiation Higrarchy
v RTLANALYSIS )
* Open Elatorated Design @ Has_mace
Wersion. 1.0 (Raw. 1703471507}
v smiEsE Inteetaces: A4
I Run Swmaais Duscrigtion AnlP gensrabed by Vivads HLS
> Open Symasized Dasign St
License.
v WPLEMENTATION Change Log
Vendor %
Ly ML COm S _mase 10

| # Create Block Design

Purchase
Purchase

Pleaie specily name of block dusign Purchage
' Prod s2n Inchuded
> Productizn Purchass
o Design name: Zyng_Design fream  Production Furchase  xlinecomogien_gig_eth
~ Direciery & <Local lo Praject " Froduction Furchase  xilinecomoigpaddso
Production Purchase  wlinecomog pofid 50
Specily Souce set Design Sources -
Interiacan A4
Descriphon. An IF generaled by Vivado MLS
- Statrs.

Figure 10-10: Create the Zynq Design

The Block Design view opens in the main pane, with a new Diagram tab, containing a blank

Block Design canvas.

2. Press the Add IP button on the main screen open the IP search dialog.
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€ XILINX, Chapter 10: Using HLS IP in a Zyng SoC Design

a. Type zyng into the Search text entry box.

b. Select ZYNQ7 Processing System and press Enter.

Diagram

Search yng (1 maich)

4F ZYNQT Processing System

ENTER to select, ESC to cancel, Ctrl+Q for IP details

Figure 10-11: Add a CPU Processor to the Design

An IP symbol for the ZYNQ7 Processing System appears on the canvas.

3. Double-click the ZYNQ IP symbol to open the associated Re-customize IP dialog box.
a. Click the Presets icon and select ZC702 (Figure 10-12).
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¢ Re-customize [P

ZYNQT Processing System (5.5)

¢

@ Documentation 4} Presets IP Location €3 Import XPS Settings
Page Navigator — Zyng Block Design Summary Report
Zyng Block Design
yng g =
| Vo Penghecais Gl
PS-PL Configuration £l Settioge Apglication Procassor Unit (APL)
=) SWOT
e S [ Tre e .
Peripheral /0 Pins (15:0) 1261 = ARM Conex 48 ARM Conex -A9
_gm‘: | Sy!‘em Laval CFU
MIO Configuration |__UARTO =73
ro ] r—_l W
MUX GPIO Sncop Control
Clock Configuration M) = * nms i eop Lot i : i
& R 50 1 1 512 KB L2 Cache and Controlier Ports
U580 T
DDR Configuration TEEE oo 2EEKE
= o el
SMC Timing Calculation B TS & GEge Y
5!;:1‘ FLASH Memory - !
{53 Interda. —_ -
et » —JW
-
| _nawn

i 4
| ouansel | f— Programmabie DDR23,LPODOR2
— e ||, ]
Inter connect
m i
Cabculation
OMA $ync EIEE

2 |5 11011
s Processing System(PS)
o 1

AP, ‘

===

Resets

o al1]2]3 DMA
CTETIFTETER I_I_I_I_I wsar I onie | | Hin Petamames o
Mmio(Emiy _ PSPL hannela | oo A 320840 Stave
Clock Ports Mn. Stave SHA Bt
Poms Ports

Programmable Logic(PL)

oK | | Cancel

Figure 10-12: Configure the Zynq SoC
4. Click MIO Configuration in the Page Navigator pane.
a. Expand the Application Processor Unit tree view.

b. Deselect Timer 0 (or any other timers if they are selected).
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¢ Re-customize IP

ZYNQT Processing System (5.5)

@ Documentation  £F Presets

Page Navigator —

Zyng Block Design

PS-PL Configuration

Peripheral /0 Pins

MIO Configuration

Clock Configuration

DDR Configuration

SMC Timing Calculation

Interrupts

4

e a

Chapter 10: Using HLS IP in a Zynq SoC Design

IP Location ﬁj Import XPS Settings

»

»

w

MIO Configuration

4=  [Bank 0 /0 Voltage LVCMOS33V Bank 1 /0 Voltage | LVCMOS 3.3V«

Q Search:

= Peripheral 10 Signal 10 Type Speed

Memory Interfaces
IO Peripherals
Application Processor Unit
Timer 0
Timer 1
Watchdog

Programmable Logic Test and Debug

Figure 10-13: Zynqg SoC MIO Configuration

5. Click Interrupts in the Page Navigator pane.

Summary Report

Pullup Dire

a. Select Fabric Interrupts and expand its tree view and expand the PL-PS Interrupt

Ports.

b. Select IRQ_F2P[15:0] and click OK to close the Re-customize IP dialog box.
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€ XILINX, Chapter 10: Using HLS IP in a Zyng SoC Design

¢ Re-customize IP | &3

ZYNQT Processing System (5.5) g

@ Documentation  4F Presets IP Location @;‘p Import XP3 Settings

Page Navigator - Interrupts Summary Report
Zyng Block Design - Search
PS-PL Configuration Q| interrupt Port D Description
Peripheral 0 Pins E ~ Fabric Interrupts Enable PL Interrupts to PS and vice versa b
v  PL-PS Interrupt Ports
MIO Configuration é IRC_F2P[15:0] [91:84],[6.. Enables 16-bit shared interrupt port from the PL. MSB iz assignedth...
Core0_nFICQ 28 Enables fast private interrupt signal for CPUD from the PL
Clock Configuration Core0_nIR0 3 Enables private interrupt signal for CPUD from the PL
DDR Configuration Corel1_nFIQ 23 Enables fast private interrupt signal for CPU1 from the PL
Core1_niRQ N Enables private interrupt signal for CPU1 from the PL
SMC Timing Calculation v PS-PL Interrupt Ports
IRQ_P2F_DMAC_ABORT Enables shared interrupt abort signal from DMAC to the PL
et IRQ_P2F_DMACO Enables shared interrupt signal 0 fom DMAC to the PL
IRQ_P2F_DMACA Enables shared interrupt signal 1 from DMAC to the PL
IRQ_P2F_DMAC2 Enables shared interrupt signal 2 from DMAC to the PL
IRQ_P2F_DMAC3 Enables shared interrupt signal 3 from DMAC to the PL
IRC_P2F_DMAC4 Enables shared interrupt signal 4 from DMAC to the PL
IRC_P2F_DMACS Enables shared interrupt signal 5 from DMAC to the PL
IRQ_P2F_DMACE Enables shared interrupt signal 6 from DMAC to the PL
IRQ_P2F_DMACT Enables shared interrupt signal 7 from DMAC to the PL
IRQ_P2F_SMC Enables shared interrupt signal from SMC to the PL
IRQ_P2F_QSPI Enables shared interrupt signal from Q5P to the PL
T e e ) e P SR S G U SR LY, o YT O S ]
oK ‘ | Cancel

Figure 10-14: Zynqg SoC Interrupt Configuration

IP integrator provides Designer Assistance to automate certain tasks, such as making the
correct external connections to DDR memory and Fixed 1/O for the ZYNQ PS7.

6. Click the Run Block Automation link under the title bar (Figure 10-15).
a. Ensure processing_system7_0 is selected.

b. Ensure Apply Board Presets is deselected. If this remains selected it re-applies the
timers that were disabled in step 4 and results in additional ports on the Zynq block
in Figure 10-15.

c. Click OK to complete in the resulting dialog box.
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¢ Run Block Automation | &3 |
Automatically make connections in your design by checking the boxes of the blocks to connect. Select a block on the left to display its
configuration options on the right. ‘
- -
Q = < Description

v ]
v e, A R R o) This option sets the board preset on the Processing System. All current properties will be

overwritten by the board preset. This action cannot be undone. Zyng7 block automation
applies current board preset and generates external connections for FIXED_IO, Trigger
and DDR interfaces.

¥ F processing_system7_0

MOTE: Apply Board Preset will discard existing IP configuration - please uncheck this box,
if you wish to retain previous configuration.

Instance: /processing_system7_0

Options

Make Interface External: FIXED_IO, DDR

Apply Board Preset: v
Cross Trigger In: Disable v
Cross Trigger Qut. Disable v

Figure 10-15: Run Automation
7. To add HLS IP to the design:
a. Right-click in an open space of canvas and select Add IP from the context menu.

b. Type hls in the Search text entry box and press Enter to add it to design
(Figure 10-16).
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Diagram X Address Editor % e Ja i 4
Q a Xk & Q + E|C|a o

# Designer Assistance available. Run Block Automation Run Cennection Automation

his_macc_0

S|4 s ad_HLS MACC_PERIPH_ BUS [wsaso- s
ap_clk interrupt
ap rst n '

-

His_macc (Pre-Production)

processing_system7_0

DDR +.||

= FIXED 10 + |||

M_axi_eroAct 7VN|() M :gliKGZfK:—
FCLK RESETO_N

ZYNQ7T Processing System

Figure 10-16: Processor and HLS IP

Designer assistance is also available to automate the interconnection of IP blocks.

8. Click the Run Connection Automation link at the top of the canvas.

9. Select /hls macc 0/S _AXI HLS MACC PERIPH BUS and click OK in the resulting
dialog box to automatically connect the HLS IP to the M AXI GPo interface of the Zynq
Processor.

This adds an AXI Interconnect (block instance: processing system7_0), a Proc Sys Reset
block and makes all necessary AXI related connections to create the design shown in
Figure 10-17.
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Diagram »® Address Editor X

200
Ra  nA - I
@ a X M o Q s |+ & C a9 =& o
| bis_mace_0
{4 o a4 pas mnce pEEw Bus e
@k P Intomupt processing_system?_0
prn — > oor
Hls_macc PrePraducion FOED IO O FixEo_0
1 M_AKI_GPO_ACLE - usmAD 0 + J
=t_pe7_0_S0M
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Figure 10-17: Design with AXI4 Interconnect

The only remaining connection necessary is from the HLS interrupt port to the pPs7
IRQ F2P port.

10. Mouse over the interrupt pin on the hls macc_0 IP symbol. When the cursor changes
to pencil shape, click and drag to the IRQ F2P[0:0] port of the PS7 and release,
completing the connection.

11. Select the Address Editor tab and confirm that the hls macc_ 0 peripheral has been

assigned a master address range. If it has not, click the Auto Assign Address icon.

Diagram % Address Editor % ?O0O0C
a = £ L
Cell Slave Interface

Base Name OffsetAddress  Range High Address
~ 9F processing_system7_0

~ B Data (32 address bits : 0

0000000 [1G])

= his_macc_0  s_axi_HLS_MACC_PERIPH_BUS Reg 0x43C0_0000  B4K v Ox43CO_FEEF

Figure 10-18: Address Editor
The final step in the Block Diagram design entry process is to validate the design.
12. Click the Validate Design icon in the toolbar.

13. Upon successful validation, save the Block Design.
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Step 5: Implementing the System

Before proceeding with the system design, you must generate implementation sources and
create an HDL wrapper as the top-level module for synthesis and implementation.

1. Return to the Project Manager view by clicking on Project Manager in the Flow
Navigator.

2. In the Sources browser in the main workspace pane, a Block Diagram object called
Zyng Design is at the top of the Design Sources tree view (Figure 10-19). Right-click
this object and select Generate Output Products.

3. In the resulting dialog box, click Generate to start the process of generating the
necessary source files.

PROJECT MANAGER - project_1

Sources ? 00 X
Q =& + &
~ Design Sources (2
» @B Fyng_Design_wrapper (Zyng_Design_wrapperv) (1
RO des|

Source Mode Properties...
* Constrain

» Simulatiol = OpenFile

Create HDL Wrapper...
View Instantiation Template
Generate Qutput Products...

Reset Qutput Products...

Hierarchy IF

Figure 10-19: Generate Output Producs

4. Right-clickthe zyng Design object again, select Create HDL Wrapper, and click OK to
exit the resulting dialog box.

The top-level of the Design Sources tree becomes the Zyng Design wrapper.v file. The
design is now ready to be synthesized, implemented and to have an FPGA programming
bitstream generated.

5. Click Generate Bitstream to initiate the remainder of the flow.
a. Click Yes to implement the design.

6. In the dialog that appears after bitstream generation has completed, select Open
Implemented Design and click OK.

High-Level Synthesis N Send Feedback 217
UG871 (v2020.1) August 7, 2020 www.xilinx.com [—\/—]


https://www.xilinx.com
https://www.xilinx.com/about/feedback/document-feedback.html?docType=Tutorials&docId=UG871&Title=Vivado%20Design%20Suite%20Tutorial&releaseVersion=2020.1&docPage=217

€ XILINX, Chapter 10: Using HLS IP in a Zyng SoC Design

Step 6: Developing Software and Running it on the ZYNQ
System

You are now ready to export the design to Xilinx Vitis™. In Vitis, you create software that
runs on a ZC702 board (if available). A driver for the HLS block was generated during HLS
export of the Vivado IP Catalog package. This driver must be made available in Vitis so that
the PS7 software can communicate with the block.

1. From the Vivado File menu select Export > Export Hardware.

Note: Both the IP integrator Block Design and the Implemented Design must be open in the Vivado
workspace for this step to complete successfully.

2. In the Export Hardware dialog box (Figure 10-20), ensure that the Include Bitstream is
enabled and click OK.

¢ Export Hardware G

Export hardware platform for software development
tools.

¥ Include bitstream

Exportto: | @0 =Local to Project= A
@

Figure 10-20: Export Hardware Dialog Box
3. From the Vivado File menu, select Launch SDK.
4. Click OK to open Vitis.
5. From the Vitis File menu, select New > Application Project.
a. Inthe New Project dialog enter the project name Zyng Design Test.
b. Click Next.
c. Select the Hello World template.
d. Click Finish.
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B New Project o || B &
Application Project —
/—
Create a managed make application project.

Project name: Zync_Design_Test

[¥] Use default location

CA\Vivado_HLS_Tutorial\Using_IP_with_Zyng\labl\project 1\project_

o
A
T

default «
OS Platform: ‘5tanda|0ne v|
Target Hardware
Hardware Platform: |Zynq_Design_wrapper_hw_platform_[} '] |New...|
Processor: l ps/_cortexa?_0 - ]
Target Software
Language: @C @ C++
32-bit >
/A -
Board Support Package: @) Create New  Zync_Design_Test bsp
(©) Use existing |Zyng_Design_Test_bsp -
Ef?j} < Back MNext = ‘ [ Finish ] l Cancel

Figure 10-21: Application Project

6. Power up the ZC702 board and test the Hello World application. Ensure the board has all
the connections to allow you to download the bitstream on the FPGA device. See the
documentation that accompanies the ZC702 development board.

7. Click Xilinx Tools > Program FPGA (or toolbar icon).
Notice that the Done LED (DS3) is now on.

8. Click on Vitis Terminal and click on add button to add a port to the terminal.
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a. Click the Connect icon (Figure 10-22).

i*! Problems ¥ Tasks & Console [ Properties B SDK Terminal 2 w &L 70O

Click on + button to add a port to the terminal.

4 I

Figure 10-22: The Connect Icon
b. Select Connection Type > Serial.

c. Select the COM port to which the USB UART cable is connected (generally not COM1
or COM3). On Windows, if you are not sure, open the Device Manager and identify
the port with the Silicon Labs driver under Ports (COM & LPT).

d. Change the Baud Rate to 115200 (Figure 10-23).
e. Click OK to exit the Terminal Settings dialog box.

@ Connect to serial port | 3 |

Basic Settings

Port: COM3 -
Baud Rate: 115200 v|

= Advance Settings

Data Bits: [8 ']
Stop Bits: [1 v]
Parity: [None ']
Flow Control: [None v]

Timeout (sec):

OK l [ Cancel l

Figure 10-23: Terminal Settings

9. Right-click the application project Zynq_Design_Test in the Explorer pane
(Figure 10-24).
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a. Click Run As > Launch on Hardware.

B project_1.sdk - C/C++ - Xilinx SDK
File Edit Navigate Search Project Run Xilinx Tools Window Help

OrlQ ®~Q~BiWD2R@E S H-0OviFridivbyo~
[t Project Explorer B%|¥Y v= 0 & system.hdf i system.mss l¢l helloworld.c 2
» |2 Zyng Dacinn Tact @®% Copyright (C) 2009 - 2014 Xilinx, Inc. All
bl Zyna Mew k
b t?Zynq Go Into B /%
* helloworld.c: simple test application
Open in New Window *
B Copy Ctrl+C * This application configures UART 1655@ to
Paste Ctrl+V * PS7 UART (Zyng) is not initialized by this
* bootrom/bsp configures it to baud rate 115
Delete Delete i .
Source s T
Move... * | UART TYPE  BAUD RATE
Rename... F2 i SEe e S S SERE eSS SSEaE s S e
s 5 *  uwartns558 9600
o= POt *  uyartlite Configurable only in HW desi
fa Export. *  ps/_ uart 115200 (configured by bootrc
Build Project */
Clean Project . .
#include <stdio.h>
HERE ) = #include "platform.h"
Close Project #include "xil printf.h"
Close Unrelated Projects
Build Configurations 4 - int main()
Run As »| & 1 Launch on Hardware (System Debugger)
Debug As » | Ed 2 Start Performance Analysis
Compare With v | ¥ 3 Launch on Hardware (System Debugger on QEMU)
Restore from Local History... % 4 launch on Hardware (GDB)
5 Local C/C++ Application
C/C++ Build Settings . i
Tl Generate Linker Script R;m Comguisions.
¥ Change Referenced BSP I

Figure 10-24: Run the Application Project

10. Switch to the Terminal tab and confirm that Hello World was received.
I*! Problems | Tasks & Console & Properties B SDK Terminal o X 7 = O
Connected to: Serial { COM3, 115200, 0, 8)

Connected to COM3 at 115200
Hello World

4 P

Figure 10-25: Console Output
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Step 7: Modify Software to Communicate with HLS Block

The completely modified source file is available in the arm code directory of the tutorial
file set. The modifications are discussed in detail below.

1. Open the helloworld.c source file.

2. Several BSP (and standard C) header files need to be included:

#include <stdlib.h> // Standard C functions, e.g. exit()

#include <stdbool.h> // Provides a Boolean data type for ANSI/ISO-C
#include "xparameters.h" // Parameter definitions for processor peripherals
#include "xscugic.h" // Processor interrupt controller device driver
#include "xHls macc.h" // Device driver for HLS HW block

3. Define variables for the HLS block and interrupt controller instance data. The variables
will be passed to driver API calls as handles in the respective hardware.

// HLS macc HW instance
XHls_macc HlsMacc;

//Interrupt Controller Instance
XScuGic ScuGic;

4. Define global variables to interface with the interrupt service routine (ISR).

volatile static int RunHlsMacc = 0;
volatile static int ResultAvailHlsMacc = 0;

5. Define a function to wrap all run-once APl initialization function calls for the HLS block.

int hls macc_init (XHls macc *hls maccPtr)
XHls_macc_Config *cfgPbtr;
int status;

cfgPtr = XHls macc_LookupConfig (XPAR XHLS MACC 0 DEVICE ID) ;

if (lcfgPtr) {
print ("ERROR: Lookup of accelerator configuration failed.\n\r");
return XST_ FAILURE;

}
status = XHls _macc_CfgInitialize(hls_maccPtr, cfgPtr);
if (status != XST SUCCESS) {

print ("ERROR: Could not initialize accelerator.\n\r");
return XST FAILURE;

}

return status;

}

6. Define a helper function to wrap the HLS block API calls required to enable its interrupt
and start the block.

void hls macc_start (void *InstancePtr) {
XHls macc *pAccelerator = (XHls macc *)InstancePtr;
XHls macc_InterruptEnable (pAccelerator,1);
XHls macc_InterruptGlobalEnable (pAccelerator) ;
XHls_macc_Start (pAccelerator) ;
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An interrupt service routine is required in order for the processor to respond to an interrupt
generated by a peripheral.

Each peripheral with an interrupt attached to the PS must have an ISR defined and
registered with the PS’s interrupt handler.

The ISR is responsible for clearing the peripheral’s interrupt and, in this example, setting a
flag that indicates that a result is available for retrieval from the peripheral. In general, ISRs
should be designed to be lightweight and as fast as possible, essentially doing the
minimum necessary to service the interrupt. Tasks such as retrieving the data should be left
to the main application code.

void hls macc_isr(void *InstancePtr) {
XHls_macc *pAccelerator = (XHls macc *)InstancePtr;

//Disable the global interrupt

XHls macc_InterruptGlobalDisable (pAccelerator) ;
//Disable the local interrupt

XHls macc_InterruptDisable (pAccelerator, OXff£f£ff£ff) ;

// clear the local interrupt
XHls macc_InterruptClear (pAccelerator,1);

ResultAvailHlsMacc = 1;
// restart the core if it should run again
if (RunHlsMacc) {

hls macc_start (pAccelerator) ;

}
}

7. Define a routine to setup the PS interrupt handler and register the HLS peripheral’s ISR.

int setup_interrupt ()
{

//This functions sets up the interrupt on the Arm
int result;
XScuGic_Config *pCfg = XScuGic_LookupConfig (XPAR SCUGIC_ SINGLE_DEVICE_ID) ;
if (pCfg == NULL) {

print ("Interrupt Configuration Lookup Failed\n\r");

return XST_ FAILURE;
}
result = XScuGic CfgInitialize (&ScuGic,pCfg,pCfg->CpuBaseAddress) ;
if (result != XST SUCCESS) {

return result;
}
// self-test
result = XScuGic_SelfTest (&ScuGic) ;
if (result != XST SUCCESS) {

return result;
}
// Initialize the exception handler
Xil_ ExceptionInit () ;
// Register the exception handler
//print ("Register the exception handler\n\r") ;
Xil ExceptionRegisterHandler (XIL EXCEPTION ID INT,

(Xil ExceptionHandler)XScuGic_ InterruptHandler, &ScuGic) ;

//Enable the exception handler
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Xil ExceptionEnable() ;
// Connect the Adder ISR to the exception table
//print ("Connect the Adder ISR to the Exception handler table\n\r");
result = XScuGic Connect (&ScuGic, XPAR FABRIC HLS MACC 0 INTERRUPT INTR,
(Xil_InterruptHandler)hls macc_isr, &HlsMacc) ;
if (result != XST SUCCESS) {
return result;
}

//print ("Enable the Adder ISR\n\r");
XScuGic_ Enable (&ScuGic,XPAR FABRIC HLS MACC 0 INTERRUPT INTR) ;
return XST SUCCESS;

8. Define a software model of the HLS hardware functionality with which you can compare
reference results.

void sw _macc(int a, int b, int *accum, bool accum clr)
{
static int accum reg = 0;
if (accum_clr)
accum_reg = 0;
accum _reg += a * b;
*accum = accum_reg;

}

9. Modify main() to use the HLS device driver APl and the functions defined above to test
the HLS peripheral hardware.

int main()
{
print ("Program to test communication with HLS MACC peripheral in PL\n\r");
int a = 2, b = 21;
int res hw;
int res sw;
int 1i;
int status;

//Setup the matrix mult
status = hls macc_init (&HlsMacc) ;

if (status != XST SUCCESS) {
print ("HLS peripheral setup failed\n\r");
exit (-1);

}

//Setup the interrupt

status = setup_ interrupt();

if (status != XST SUCCESS) {
print ("Interrupt setup failed\n\r");
exit (-1);

}

//set the input parameters of the HLS block
XHls macc_SetA(&HlsMacc, a);

XHls macc_SetB(&HlsMacc, b);

XHls macc_ SetAccum clr (&HlsMacc, 1);

if (XHls_macc_IsReady (&HlsMacc))
print ("HLS peripheral is ready. Starting... ");
else {
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print ("!!! HLS peripheral is not ready! Exiting...\n\r");
exit (-1);

}

if (0) { // use interrupt
hls macc_start (&HlsMacc) ;
while (!ResultAvailHlsMacc)
i // spin
res hw = XHls macc_GetAccum(&HlsMacc) ;
print ("Interrupt received from HLS HW.\n\r") ;
} else { // Simple non-interrupt driven test
XHls_macc_Start (&HlsMacc) ;
do {
res_hw = XHls macc_GetAccum(&HlsMacc) ;
} while (!XHls macc IsReady (&HlsMacc)) ;
print ("Detected HLS peripheral complete. Result received.\n\r");

}

//call the software version of the function
sw_macc(a, b, &res sw, false);

printf ("Result from HW: %d; Result from SW: %d\n\r", res hw, res_ sw);
if (res_hw == res_sw) ({

print ("*** Results match ***\n\r");

status = 0;

}

else {
print ("!!! MISMATCH !!!\n\zr");
status = -1;

}

cleanup platform() ;
return status;

}
10. Save the modified source file. When you save the file, Vitis automatically attempts to
re-build the application executable. If the build fails, fix any outstanding issues.

Run the new application on the hardware and verify that it works as expected. Ensure that
a TCF hardware server is running, that the FPGA is programmed and a terminal session is
connected to the UART. Then Launch on Hardware, as you did for the previous Hello World
application code.

Upon success, the Terminal session looks similar to Figure 10-26.

[20 Problems | ¥4 Tasks | E] Console | & Properties | 4% Terrninal 1 52 HEL ug| M - =8
Serial: (COMS, 115200, 8, 1, None, Mone - CONMECTED] - Encoding: (I50-8859-1)
Result from HW: 42; Result from SW: 42 -

SWoand HW results match!

Frogram to test communication with HLS MACC bleck in PL

fccelerator is ready. Starting... Detected HLS bleock complete. Result received.
Result from HW: 42; Result from SW: 42

*#*% Sl oand HW results match ##*

m

Figure 10-26: Console Output with Updated C Program
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Lab 2: Streaming Data Between the Zynq CPU and
HLS Accelerator Blocks

This lab illustrates a common high-performance connection scheme for connecting
hardware accelerator blocks that consume data originating in the CPU memory and/or
producing data destined for it, in a streaming manner.

« This tutorial uses the same Vivado HLS and XFFT IP blocks created in Lab 1 of the
tutorial, see Chapter 9, Using HLS IP in IP Integrator. In this lab exercise these blocks
are connected to the HPO Slave AXI4 port on a Zynq7 processing system via an AXI
DMA IP core.

« The hardware accelerator blocks are free-running and do not require drivers; as long as
data is pushed in and pulled out by the CPU (often simply referred to as the Processing
System or PS).

« The lab highlights the software requirements to avoid cache coherency issues.

Step 1: Generate the HLS IP

1. From the Vivado HLS command prompt used in Lab 1, change to the 1ab2 directory as
shown in Figure 10-26.

2. Run Vivado HLS to create two HLS IP blocks by typing vivado _hls -f run hls.tcl.

[ Vivado HLS 2013.2 Command Prompt == EoE <™

C:\Vivado_HLS_Tutorial\Using_IP_with_2Zyng\labl>cd .. -

C:\Vivado_HLS_Tutorial\Using_IP_with_2ynq>cd lab2

C:\VUivado_HLS_Tutorial\Using_IP_with_2yng\lab2>cd hls_designs

C:\Vivado_HLS_Tutorial\Using_IP_with_2Zyng\lab2\hls_designs>vivado_hls -f run_hls{E
.tel b

Figure 10-27: Setup for Zynq Lab 2

When the script completes, there are two Vivado HLS project directories, fe vhls prj
and be_vhls prj, which contain the HLS IP, including the Vivado IP Catalog archives for
use in Vivado designs.

« The “front-end” IP archive is located at fe vhls prj/IPXACTExport/impl/ip/

+ The "back-end” IP archive is located at be_vhls prj/IPXACTExport/impl/ip/

Step 2: Create a Vivado Design Suite Project

1. Launch the Vivado Design Suite (not Vivado HLS):
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- On Windows use Start > All Programs > Xilinx Design Tools > Vivado 2020.1 >
Vivado 2020.1.

o On Linux, type vivado in the shell.
2. From the Welcome screen, select Create New Project.
3. Click Next on the first page of the Create a New Vivado Project wizard.

4. Click the ellipsis button to the right of the Project location text entry box and browse to
the 1ab2 tutorial directory.

5. Set the project name to project 1, if it is not already specified.
6. Click Next to move to the Project Type page of the wizard.
a. Select RTL Project.
b. Select do not specify sources at this time (if not the default); just click Next.

7. On the Default Part page, under Specify, click Boards and select the ZYNQ-7 ZC702
Evaluation Board. Click Next.

8. On the New Project Summary Page, click Finish to complete the new project setup.

Step 3: Add HLS IP to an IP Repository

1. In the Project Manager area of the Flow Navigator pane, click IP Catalog.
2. Click the IP Catalog pane, right-click and select Add Repository.
3. In the IP Repositories dialog box:
a. Browse to the 1ab2 tutorial directory.
b. Click the Create New Folder icon.
c. Entervivado ip repo in the resulting dialog box.
d. Click OK.
e. Click Select to close the IP Repository window.
4. On returning to the IP Setting dialog box:
a. Click the “+" symbol to Add IP.

b. In the IP Repositories dialog box, browse to the location of the HLS IP
lab2/hls designs/fe vhls prj/IPXACTExport/impl/ip/ or, if using IP
created in previous tutorial, browse to the corresponding path.

c. Selectthe xilinx com hls hls real2xfft 1 00 a.zip file.

d. Click OK.
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Follow the same procedure to add the second HLS IP package, in directory
lab2/hls designs/be vhls prj/IPXACTExport/impl/ip/, to the repository:
xilinx com_hls _hls xfft2real 1 00_a.zip.

The new HLS IP now appears in the IP Setting dialog box.
Click OK to exit the dialog box.
There is now HLS IP in the IP Catalog (Hls_real2xfft and Hls_xfft2real).

Step 4: Create a Top-level Block Design

1.

High-Level Synthesis

Click Create Block Diagram under IP integrator in the Flow Navigator.
a. In the resulting dialog box, name the design Zyng RealFFT.

b. Click OK.

In the Diagram tab, click the Add IP button to add IP

a. Inthe Search box, type fourier.

b. Select the Fast Fourier Transform and double-click with the mouse.

Double-click the new Fast Fourier Transform IP symbol to open the Re-customize IP
dialog box. On the Configuration tab:

a. Change the Transform Length to 512.

b. Change the Target Clock Frequency to 100 MHz.

c. In the Architecture Choice section, select Pipelined, Streaming 1/0.
Select the Implementation tab:

a. Select ARESETN (active-Low) in the Control Signals group.

b. Verify that Bit/Digit Reversed Order is selected under Output Ordering Options.
c. Verify that Non Real Time is selected as Throttle Scheme.

d. Click OK to exit Re-customize IP dialog

Add one instance of each of the HLS generated blocks to the design.

a. Right-click in any space in the canvas and select Add IP.

b. Type hls into the Search text entry box.

c. Highlight both IPs. (Click the control key and select both.)

d. Press Enter.

Connect the HLS blocks to the FFT block.

a. Mouse over the dout interface connector of the hls real2xftt block until a
pencil cursor appears.
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b. Left-click and hold down the mouse button to start a connection.

c. Dragthe connection line tothe S AXIS DATA input port connector of the FFT block
and release when a green check mark appears next to it.

7. In a similar fashion:

a. Connect the FFT's M_AXIS DATA interface to the din input interface of the
hls xfft2real block.

8. Put the data processing blocks into their own level of hierarchy.
a. Select everything in the current digram by pressing Ctrl+A.

b. Right-click the canvas and select Create Hierarchy from the context menu.

Diagram > OO X

@ a| X kB &/ a + | & F E|C|o | & o
Block Properties... Ctri+E
%, Highlight b
| X Delete
r 1B copy
+
+
Q.  search.
W SelectAl
L |+ addip.
Add Module... L -1 r -1
s Make External - = 4 ‘
Vivade™ HLS
& Customize Block... + 5
IP Documentation ¥ '

Editin IP Packager
Orientation b
IP Settings...
[ validate Design 1 -l

Debug

Create Hierarchy...

Figure 10-28: Create a Hierarchy Block
c. In the Create Hierarchy dialog box, enter RealFFT as the Cell name.

d. Ensure that the Move ‘3’ selected blocks to new hierarchy option is checked, as
shown in Figure 10-29.
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2 Create Hierarchy @
Please specify name of hierarchical cell to create in Zyng_RealFFT.
You can also move selected blocks to new hierarchy. ‘

Cell name: | 3E5lE30

[] Move '3' selected blocks to new hierarchy

’ 0K H Cancel ‘

Figure 10-29: Name Hierarchy Block
e. Click OK.

The diagram will appear as shown in Figure 10-30.

Diagram 00 X

@ a ¥ & ¢ Q s + = C o o

RealFFT

Figure 10-30: New Hierarchy Block

Add pins to the RealFFT hierarchical block so that you can connect it at the top-level.

9. Double-click the RealFFT block to open its diagram.
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Diagram % | Diagram - RealFFT  x 200
a a|d | x| e a + | C|e | &
his_xfft2real 0
his_real2xfft_0 xfit_0

Fio ~

M_AXIS_DATA + =

= § AXIS_DATA event_frame_started

=+ S_AXIS_CONFIG

ack

-+ piill

T Tk / dout +
Ep__C
ap_rst_n

Hls_xfft2real (Pre-Production)

event_tlast_unexpected

aih din V Vivado™ HLS
ctrl
II|+ adnk ’ dait o =
ap
ap rst n

His_real2xfft (Pre-Production)

event_tlast_missing

event_status_channel_halt
event_data_in_channel_halt

event_data_out_channel_halt

aresetn

Fast Fourier Transform

Figure 10-31: RealFFT Diagram

10. Right-click the din VvV _V pin of the hls real2xfft 0 block and select Create
Interface Pin from the context menu.
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his_xfft2real _0
his_real2xfft_0 xfft_0
P = = \ = ~ ” + ap_ctrl e
+ - - M_AXIS_DATA + + din
|Il+ apt Block Interface Properties... : j— event_frame_started ap_clk [ ' ] dout 4
ap_clk &  Highlight » CONFIG event_tlasl unexpfac:tled \ap rst_n |
St | event flast missing 'H\s_ xfft2real (Pre-Production)

= event_status_channel_halt
Hls_re

event_data_in_channel_hall
B copy * event_data_out_channel_halt
)
Fast Fourier Transform
Q  Search...
We  SelectAll
<+  AddIP

Add Module
M Make External
IP Settings...
[ Vvalidate Design
Start Connection Mode

Make Connection...

Create Hierarchy.
Create Comment
Create Interface Pin... Cri+L

C Regenerate Layout

Figure 10-32: Creating an Interface Pin

11. In the Create Interface Pin dialog box, change the Interface name to
realfft s axis_ din.

a. Accept all other defaults and click OK.

4. Create Interface Pin @

Create interface pin for cell RealFFT.

Interface name:
VLNV: xilinx.com:interface:axis_rtl:1.0 A

Mode: SLAVE A

Qonnect to selected interface din_V_V

’ 0K ” Cancel ]

Figure 10-33: Naming an Interface Pin

12. Right-click the ap_clk pinofthe hls real2xfft 1 block and select Create Pin from
the context menu.

a. Change the name to aclk and click OK.
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Figure 10-34:
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M_AXIS_DATA -+ F

evenl_lrame_starled

i DATA
B avent_Bast_unexpecied
evend_tiast_missing
evenl_slatus_chanrel_al
event_data_in_channel_halt
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=+ dn [ ] ot +5
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After you create this clock pin, the RealFFT diagram appears as shown in Figure 10-35.
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% Diagram - RealfFT

a a X X o Q + E C 9 & &

realfit_s_axis_din

hs_xfft2real_0

||+ap:|n S

= dn -
= ap.dik [' ]Dﬂul"‘..
Q ap_rstn

His_sfftZreal (Pre-Production)

his_realZxift_0 xift_0

A M_AXIS_DATA 4 [
ack m+ apen | event_liame_started
ot - e - &_AXIS_DATA
ap_ck ’ st o+ 3 =t event_Bast unexpecied

a P =4 S_AXIS_CONFIG
ap_mtn

evend_tiast_missing
ack

His_realzalil (Pre-Production) @ aresom SOl e T L

event_data_in_channel_halt
owent_datn_out_channel_hait

Figure 10-35: RealFFT Diagram with Interface Pin and Clock Pin
13. Following the procedures in steps 10 to 12:

a. Create an interface pin called realfft m axis dout connected to the dout Vv
pin of the hls xfft2real component.

b. Create a pin for aresetn (from any one of the blocks).

After this step, the RealFFT diagram appears as shown in Figure 10-36.
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Figure 10-36: RealFFT Diagram with All Pins

Finalize RealFFT block internal connections. The ap_start pins for the HLS blocks are
tied HIGH, and the aclk and aresetn pins on all blocks are tied together.

14. Right-click the canvas and select Add IP from the context menu.
a. Type const into the search box and press Enter.

b. Double-click the x1constant 0 component and verify that the Const Val field in
the Customize IP dialog is set to 1.
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¢ Re-customize IP [ &3
Constant (1.1) y
ﬂ Documentation IP Location
Show disabled ports Component Name | RealFFTilconstant 0
Const Width | 1 [1-4098]
Constval 1

dout[0:0]

OK | | Cancel

Figure 10-37: Create a Constant 1 Tie-Off

15. Expand the ap ctrl interface by clicking the + sign next to iton the hls real2xfft
and hls xfft2real block symbols and:

a. Connect the output pin of x1constant 0 to the ap start pin of
hls real2xfft O.

b. Connect the output pin of x1constant 0 to the ap start pin of
hls xfft2real_ O.

16. Similarly, connect all remaining component dout V and reset pins to the RealFFT
block diagram aclk and aresetn pins respectively.

17. Add another x1constant block and configure it with a Const Width of 16 and Const
Val of 0.

18. Expand the S AXIS CONFIG interface of the FFT block and connect
s _axis config tdata and s axis config tvalid to the new constant block.

Leave all other output pins of the components disconnected. The final RealFFT diagram
appears with the connections shown in Figure 10-38.
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Figure 10-38: Final RealFFT Diagram
19. Close the RealFFT diagram tab and return to the top-level Zyng RealFFT diagram.
20. Create the Zynq system.

a. Right-click the canvas of the top-level diagram and select Add IP from the context
menu.

b. Type zyng in the search box, select ZYNQ7 Processing System and press Enter.

c. Notice that designer assistance is available and click the Run Block Automation
link. Accept the defaults in the dialog by clicking OK.

d. Double-click the processing_system7_0 component to enter the Re-customize IP
wizard for the ZYNQ?7.

e. Click the Presets button near the top of the wizard screen, select the ZC702
Development Board Template, and click OK.

f. Click PS-PL Configuration in the Page Navigator pane on the left of the wizard.

g. Expand the HP Slave AXI Interface category and check the box for the S AXI HPO
interface, leaving the S AXI HPO DATA WIDTH at 64.
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Figure 10-39: Configuring Port HPO

h. Select Clock Configuration in the Page Navigator, expand PL Fabric Clocks, and
change the requested frequency to 100 (MHz).
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¢ Re-customize IP a3 |
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Figure 10-40: Configuring the Clock
i. Leave all other settings at their defaults; click OK to apply customizations.

21. Make a connection from RealFFT block’s realfft_s_axis_din to Zyng SoC's S_AXI_HPO,
accept the defaults in the Make Connection dialog and click OK.

IP integrator will place several new blocks require to complete the connection
automatically, including an AXI DMA core, an AXI Interconnect and a Processor System
Reset block.

22. Make a connection from the RealFFT block’s realfft_m_axis_dout to the Zynq's
S_AXI_HPO interface. Accepting the defaults in the Make Connection dialog will cause IP
integrator to use the existing AXI DMA (which has an unused write channel) and AXI
Interconnect to make the ‘'S2MM’ connection.

23. Note that Designer Assistance is again available. Run Connection Automation on
/axi_dma/S_AXI_LITE and click OK in the resulting dialog box.

24. Connect the aclk and aresetn ports of the RealFFT hierarchical block to nets
processing_system7_0 pin FCLK_CLKO and rst_processing_system7_0_100M pin
peripheral_aresetn respectively.
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25. To complete the design, run Validate Design. When validation completes successfully,
the block diagram should look like Figure 10-41.

Step 5: Implementing the System

BHLOCK DESIGN - Zyna_ReasFT

Dusgram

ilaalxiola 2 + ¥ Coog D o

> COR
L AXED_IO

o PEEET___
]
Ll 4 matt s un am
R
wain

Figure 10-41: Zynq Diagram with Internal Connections

Before proceeding with the system design, you must generate implementation sources and
create an HDL wrapper as the top-level module for synthesis and implementation.

1. Return to the Project Manager view by clicking Project Manager in the Flow Navigator.

2. In the Sources browser in the main workspace pane, a Block Diagram object called
Zyng RealFFT appears at the top of the Design Sources tree view. Right-click this
object and select Generate Output Products.

3. In the resulting dialog box, click OK to start the process of generating the necessary
source files.

4. Right-click the Zzyng RealFFT object again, select Create HDL Wrapper, and click OK
to exit the resulting dialog box.

The top-level of the Design Sources tree becomes the Zyng RealFFT wrapper.v file.
You are now ready to synthesize, implement, and generate an FPGA programming bitstream
for the design.

5. Click Generate Bitstream to initiate the remainder of the flow.
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6.

In the dialog that appears after bitstream generation has completed, select Open
Implemented Design and click OK.

Step 6: Setup Vitis and Test the ZYNQ System

You are now ready to export the design to Xilinx Vitis. In Vitis, you create software to run on
a ZC702 board (if available). A driver for the HLS block was generated during HLS export of
the Vivado IP Catalog package and must be made available in Vitis for the PS7 software to
communicate with the block.

1.

From the Vivado File menu select Export > Export Hardware for Vitis.

Note: Both the IP integrator Block Design and the Implemented Design must be open in the Vivado
workspace for this step to complete successfully.

2.

High-Level Synthesis

In the Export Hardware for Vitis dialog box, ensure that the Include Bitstream option is
checked, and click OK.

From the Vivado File menu, select Tools > Launch Vitis.
Click OK to launch Vitis.

Create a Hello World application (also creates BSP).
a. Select File > New > Application Project.

b. Enter the project name Zyng RealFFT Test.

c. Click Next.

d. Select Hello World (if it is not the default).

e. Click Finish.

Power up the ZC702 board and program the FPGA.

Ensure the board has all the connections to allow you to download the bitstream on the
FPGA device. Refer to the documentation that accompanies the ZC702 development
board.

Click XilinxTools > Program FPGA. The Done LED (DS3) goes on.
Set up a Terminal in the tab at bottom of workspace:

a. Click the Connect icon.

b. Select Connection Type > Serial.

c. Select the COM port to which the USB UART cable is connected (generally not COM1
or COM3). On Windows, if you are not sure, open the Device Manager and identify
the port with the Silicon Labs driver under Ports (COM & LPT).

d. Change the Baud Rate to 115200.
e. Click OK to exit Terminal Settings dialog box.
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f. Check that terminal is connected by message in tab title bar.

9. Right-click application project Zzyng Design_ Test in the Explorer pane.
a. Select Run As > Launch on Hardware.

10. Switch to the Terminal tab and confirm that Hel1lo World was received.

11. This project uses the C math library (1ibm), so you must adjust the build settings to link
to it.

a. Right-clickthe zyng realfft test projectinthe Project Explorer pane and select
C/C+ Build Settings (Figure 10-42).

@ project_l.sdk - C/C++ - Zyng_RealFFT_Test_bsp/system.mss - Xilinx S
File Edit Navigate Search Project Run Xilinx Tools Window F

i~ [ B~R @ F-O0- WD D@E G &
[5 Project Explorer 2 2 &|¥Y =0

+ |2 Zyng_RealFFT ==+

. @ Zyng_RealfFT  NeW ’

4 (8 Zynq_RealFfT]  Golnto
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[l ps7_init_gg

n B copy Ctrl+C
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9 ps?_!n!t.htr SEITE ’
= ps7_inittcl Yl
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&1 Export..
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Clean Project
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Close Project

Close Unrelated Projects

Build Configurations 4
Run As 4
Debug As 4
Compare With 4

Restore from Local History...

C/C++ Build Settings
T Generate Linker Script

Figure 10-42: Specify C/C++ Build Settings
b. Add the Arm gcc linker libraries.

i. In the Tool Settings tab, select Arm gcc linker > Libraries.

ii. Click the Add icon.
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c. Enter min the text field in the Enter Value dialog box and click OK.
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Figure 10-44:

Library search path (-L)

Library Setting

d. Click OK to exit the Properties for the zyng realfft test dialog box.
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Step 7: Modify Software to Communicate with HLS Block

The completely modified source file is available in the arm code directory of the tutorial
file set. The modifications are discussed in detail below.

1.
2.

5.

Open the helloworld. c source file.

Several BSP (and standard C) header files must be included:

#include <stdlib.h> // Std C functions, e.g. exit()
#include <math.h> // libm header: sqgrt(), cos(), etc
#include "xparameters.h" // System parameter definitions
#include "xaxidma.h" // Device driver API for AXI DMA

Define the (real data) transform length of the FFT:
#define REAL FFT LEN 1024
Define a custom complex data type with 16-bit real and imaginary members:

typedef struct ({
short re;
short im;

} complexlé;

Declare helper functions before the definition of main (); they will be defined later.

Note: The init dma () function wraps up all run-once, initialization AXI DMA driver API calls and
checks that hardware initialization is successful before returning or exiting on an error condition.
The generate waveform() function fills an array with a simple, periodic waveform to be used as
input stimulus for the RealFFT accelerator.

High-Level Synthesis

int init dma (XAxiDma *axiDma) ;
void generate waveform(short *signal buf, int num samples) ;

Modify main () to generate and send input data to the RealFFT accelerator and receive
the spectral data from it via the AXI DMA engine. Sections of particular importance will
be discussed in detail.

// Program entry point
int main ()

{

a. Declare an XAxiDma instance to use as a handle to the AXI DMA hardware:

// Declare a XAxiDma object instance
XAxiDma axiDma;

b. Declare variable for local data storage:

// Local variables

int i, j;

int status;

static short realdata[4*REAL_FFT LEN] ;

volatile static complexl6 realspectrum[REAL FFT LEN/2];

o l Send Feedback I 244
UG871 (v2020.1) August 7, 2020 www.xilinx.com


https://www.xilinx.com
https://www.xilinx.com/about/feedback/document-feedback.html?docType=Tutorials&docId=UG871&Title=Vivado%20Design%20Suite%20Tutorial&releaseVersion=2020.1&docPage=244

€ XILINX, Chapter 10: Using HLS IP in a Zyng SoC Design

¢. Run platform and DMA initialization functions:

// Initialize the platform
init _platform() ;

Print (M-mmmmm oo e \n\r") ;
print ("- RealFFT PL accelerator test program -\n\r");
Print (M-----mmmm e - \n\r") ;

// Initialize the (simple) DMA engine

status = init_dma (&axiDma) ;

if (status != XST SUCCESS) {
exit (-1) ;

}

d. Generate a stimulus waveform:

// Generate a waveform to be input to FFT
for (i = 0; 1 < 4; 1i++)
generate waveform(realdata + i * REAL FFT LEN, REAL FFT LEN);

e. Before making the DMA transfer request, the buffer containing the data must be
flushed from the processor’s data cache. Without this step, the DMA might pull stale
data from the DRAM.

// *IMPORTANT* - flush contents of 'realdata' from data cache to memory
// before DMA. Otherwise DMA is likely to get stale or uninitialized data
Xil DCacheFlushRange ( (unsigned)realdata, 4 * REAL FFT LEN * sizeof (short));

f. Request DMA transfer from PS to PL. Enough data to fill the front-end block and the
FFT processing pipelines must be sent in order for spectral data to be ready when
the PL to PS transfer is requested. Therefore, four data sets are sent before the first
output set is requested:

// DMA enough data to push out first result data set completely
status = XAxiDma_ SimpleTransfer (&axiDma, (u32)realdata,
4 * REAL_FFT LEN * sizeof (short), XAXIDMA DMA TO DEVICE) ;

// Do multiple DMA xfers from the RealFFT core's output stream and

// display data for bins with significant energy. After the first frame,
// there should only be energy in bins around the frequencies specified
// in the generate waveform() function - currently bins 191~193 only
for (1 = 0; 1 < 8; 1i+4+) {

g. Request DMA transfer of a frame of FFT spectral data from PL to PS then poll for
completion of the transfer before proceeding.

// Setup DMA from PL to PS memory using
// AXI DMA's 'simple' transfer mode
status = XAxiDma SimpleTransfer (&axiDma, (u32)realspectrum,
REAL _FFT LEN / 2 * sizeof (complex16), XAXIDMA DEVICE _TO DMA) ;
// Poll the AXI DMA core
do {
status = XAxiDma Busy (&axiDma, XAXIDMA DEVICE TO DMA) ;
} while(status) ;

h. Before attempting to use the spectral data, the processor’s data cache copy of the
buffer must be invalidated to avoid use of stale data.

// Data cache must be invalidated for 'realspectrum' buffer after DMA
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Xil DCachelInvalidateRange ( (unsigned)realspectrum,
REAL FFT _LEN / 2 * sizeof (complex16)) ;

i.  Push another set of stimulus data to the PL in order to start the accelerator
processing the next frame:

// DMA another frame of data to PL
if (!XAxiDma_Busy (&axiDma, XAXIDMA DMA TO DEVICE))
status = XAxiDma_ SimpleTransfer (&axiDma, (u32)realdata,
REAL_FFT LEN * sizeof (short), XAXIDMA DMA TO DEVICE) ;
printf ("\n\rFrame #%d received:\n\r");

j. Do something to verify that the accelerator is functioning. In this case, the spectral
data is scanned for bins that contain significant energy. The expectation is to detect
only energy in bins around the single tone (192) generated by the
generate waveform() function.

// Detect energy in spectral data above a set threshold
for (j = 0; j < REAL_FFT LEN / 2; Jj++) {
// Convert the fixed point (s.15) values into floating point values
float real = (float)realspectrum([j].re / 32767.0f;
float imag = (float)realspectrum([j].im / 32767.0f;
float mag = sgrtf(real * real + imag * imag) ;
if (mag > 0.00390625f) {
printf ("Energy detected in bin %3d - ",j);
printf ("{%8.5f, %8.5f}; mag = %8.5f\n\r", real, imag, mag);
}
}
printf ("End of frame.\n\r");
}_}arintf("***************\n\r");
printf ("* End of test *\n\r");
printf("***************\n\r\n\r");

return 0O;

}

7. Define the helper function that generates the waveform data sets. This version simply
fills a buffer with a single tone with 192 cycles per num_samples data window with
values in a S.15 fixed point format.

void generate waveform(short *signal buf, int num samples)
{
const float cycles per win = 192.0f;
const float phase = 0.0f;
const float ampl = 0.9f;
int 1i;
for (i = 0; 1 < num samples; i++) {
float sample = ampl *
cosf((i * 2 * M PI * cycles per win / (float)num samples) + phase);
signal buf[i] = (short) (32767.0f * sample) ;

8. Define a routine to set up the and initialize the AXI DMA engine, wrapping all driver API
calls that only need to be run once at startup.

int init dma (XAxiDma *axiDmaPtr) {
XAxiDma Config *CfgPtr;
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int status;
// Get pointer to DMA configuration
CfgPtr = XAxiDma_LookupConfig (XPAR_AXIDMA 0 DEVICE ID) ;
if (1CfgPtr) {
print ("Error looking for AXI DMA config\n\r") ;
return XST FAILURE;
}
// Initialize the DMA handle
status = XAxiDma CfgInitialize (axiDmaPtr, CfgPtr) ;
if (status != XST SUCCESS) {
print ("Error initializing DMA\n\r") ;
return XST FAILURE;
}
//check for scatter gather mode - this example must have simple mode only
if (XAxiDma HasSg(axiDmaPtr)) {
print ("Error DMA configured in SG mode\n\r") ;
return XST FAILURE;
}
//disable the interrupts
XAxiDma_IntrDisable (axiDmaPtr, XAXIDMA IRQ ALI,_MASK,XAXIDMA DEVICE_ TO DMA) ;
XAxiDma_IntrDisable (axiDmaPtr, XAXIDMA IRQ ALIL_MASK,XAXIDMA DMA TO DEVICE) ;

return XST SUCCESS;

9. Save the modified source file. As soon as you save the file, Vitis automatically attempts
to re-build the application executable.

10. Run the new application on the hardware and verify that it works as expected. Ensure
that the FPGA is programmed and a terminal session is connected to the UART. Then
Launch on Hardware, as done for the previous Hello World application code.

Conclusion

In this tutorial, you learned:

« How to create Vivado HLS IP using a Tcl script.
* How to import an HLS design as IP into IP integrator.

« How to connect HLS IP to a Zynq SoC using AXl4-Lite interfaces and AXI4-Stream
interfaces.

« How to configure HLS IP with AXI4-Lite in software.

« How to control DMAs using AXI4-Stream in software.
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Chapter 11

Using HLS IP in System Generator for DSP

¥

High-Level Synthesis

Overview

The RTL created by High-Level Synthesis can be packaged as IP and used inside System
Generator for DSP (Vivado). This tutorial shows how this process is performed and
demonstrates how the design can be used inside System Generator for DSP.

This tutorial consists of a single lab exercise.

Lab 1 Description

Generates a design using Vivado HLS and package the design for use with System Generator
for DSP. Then include the HLS IP into a System Generator for DSP design and execute an RTL
simulation.

Tutorial Design Description

You can download the tutorial design file from the Xilinx Website. See the information in
Locating the Tutorial Design Files.

This tutorial uses the design files in the tutorial directory
Vivado HLS Tutoriall\Using IP with SysGen.

The sample design is a FIR filter that uses streaming interfaces modeled with the High-Level
Synthesis hls::stream class. The design is fully pipelined at the function level. The
optimization directives are embedded into the C code as pragmas.

Lab 1: Package HLS IP for System Generator

This lab exercise integrates the High-Level Synthesis IP into System Generator for DSP.

IMPORTANT: The figures and commands in this tutorial assume the tutorial data directory
Vivado HLS Tutorial is unzipped and placed in the location C:\Vivado HLS_ Tutorial.
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If the tutorial data directory is unzipped to a different location, or on Linux systems, adjust the few
pathnames referenced, to the location you have chosen to place the Vivado HLS Tutorial
directory.

Step 1: Create a Vivado HLS IP Block

Create two HLS blocks for the Vivado IP Catalog using the provided Tcl script. The script
runs HLS C-synthesis, runs RTL co-simulation, and package the IP.

1. Open the Vivado HLS Command Prompt.

- On Windows, go to Start > All Programs > Xilinx Design Tools > Vivado 2020.1
> Vivado HLS > Vivado HLS 2020.1 Command Prompt.

o On Linux, open a new shell.

2. Using the command prompt window, change the directory to
Vivado HLS Tutorial\Using IP with SysGen\labl.

3. Type vivado hls -f run hls.tcl to create the HLS IP.

[ Vivado HLS 2013.2 Command Prompt == EoE <™

C:\Vivado_HLS_Tutorial>cd Using_IP_with_SysGen

C:\Vivado_HLS_Tutorial\Using_IP_with_SysGen>cd labl

4 [

C:\Uivado_HLS_Tutorial\Using_IP_with_SysGen\lab1>vivavo_hls -f run_hls.tcl

Figure 11-1: Create the HLS Design

A key aspect of the Tcl script used to create this IP is the command export design
-format sysgen. This command creates an IP package for System Generator. When the
script completes there is a Vivado HLS project directories £ir_ prj, which contains the HLS
IP, including the IP package for use in a System Generator for DSP design.

The remainder of this tutorial exercise shows how to integrate the Vivado HLS IP block into
a System Generator design.

Step 2: Open the System Generator Project
1. Open System Generator for DSP.
o On Windows use the desktop icon.

o On Linux, open a new shell and type sysgen.
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System
Generat...

Figure 11-2: System Generator Icon

2. When Matlab invokes, click the Open toolbar button, as shown in Figure 11-3.

HOME

E EE:I ’.E [31 o & E 7, New Variable |.s7 Analyze Code
ind Fil :

- £t} open Variable {7 Run and Time
Mew  New || Compare  Import Save
Seript  w Data Workspace [ ClearWorkspace ~  [f Clear Comman

4__,30;1&%.. Ctrl=0

Figure 11-3: Open the System Generator Design

3. Navigate to the tutorial directory
Vivado HLS Tutoriall\Using IP with SysGen\labl and select the file
fir sysgen.slx, as shown in Figure 11-4.

4\ Open @

@Ov| |« Vivado_HLS_Tutorial » Using_IP_with_SysGen » labl » ~ | 43 || Search lab1 L
Organize ~ New folder =~ [ e
Name Date modified Type
| Libraries
L. fir_prj 9/2/2015 1:23 PM File folder
“. Documents
i fir.cpp 3/29/2013 8:38 AM  C++ Source
4. Music )
. firh 7/6/2012 2:18 PM C/C++ Head
~. Pictures
) & fir_sysgen.slx 3/11/201512:15 PM  Simulink Mo
&, Videos
i fir_test.cpp 7/6/2012 2:23 PM C++ Source
4. Vivado_HLS
‘& Computer
& OSDisk (C) =
% duncanm (\xcocl2) ()
— duncanm (\\xsj-smb) (¥:) |
= gdrive (\\ppdeng) (Z:)
v 4| 1 | 3
File name: fir_sysgen.slx A IAII MATLAB files (*.rpt;*.tmf; VI

[ Open Hl Cancel ]

Figure 11-4: Select File fir_sysgen.slx
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When System Generator invokes, all blocks and ports except the HLS IP are already
instantiated in the design.

4. Right-click in the canvas and select Xilinx BlockAdd, as shown in Figure 11-5.

\'ﬁﬁr_sysgen

File Edit View Display Diagram Simulation Analysis Code Tools Help

B~ & e~ 4® b (® ~ 100 Normal - @~
fir_sysgen |

|%alfir_sysgen

®

B e

e Xilinx BlockAdd

. =
Xilinx BlockConnect
| Xilinx Tools ’ >
.—’ im b1 Xilinx View Signals ..
Constant ap rst il
Explore "
Tt ARt
. D | Can't Undo Ctrl+Z »
Puke Generstor ap_start
Can't Redo Ctri+Y

T |
. | Paste Ctrl+V _read

input_val_\_dout

Puke Generatorl R

Paste Duplicate Inport

Gl Cepudieat Ve | Select All Ctrl+A
- a V_wrie *
| Find Referenced Variables... e

) STV i Most Frequently Used Blocks e

Remove Highlighting Ctrl+5Shift+H —

pe
;.4:1__; Update Diagram Ctr+D

Figure 11-5: Adding a New Block
5. Type hls in the Add Block field.
6. Select Vivado HLS.

Add block | hls
Vivado HLS

Figure 11-6: Selecting a Vivado HLS IP Block
7. Double-click the Vivado HLS block to open the Vivado HLS dialog box.

8. Navigate to the fir prj project and click Choose to select the solutionl folder.
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ﬁ IMPORTANT: System Generator for DSP uses the location of the solution folder to identify the IP.

9. Click OK to load the IP block, as shown in Figure 11-7.

5¢ Vivado HLS (Xilinx High Level Sy...| = || B |[mt3m]

This block allows including C,C++ and SystemC source files in
System Generator for DSP designs.

Solution with_SysGen/lab1/fir_prj/solution1/"

|:| Use C simulation model if available

|:| Display signal types

Output Sample Times’SimuIink system period v]

’ OK ” Cancel ” Help ” Apply ]

Figure 11-7: Selecting the FIR IP Block
The FIR IP block is instantiated into the design.

10. Connect the design 1/O ports to the ports on the FIR IP block, as shown in Figure 11-8.
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"ufisysgen E=E
File Edit View Display Diagram Simulation Analysis Code Tools Help
] =l (ol (
B8 a EH-EEOD = @ w @~
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- 8
=%
ap_do > Out
ap_done
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- T P lapide
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Ready 94% oded5 .

Figure 11-8: Design with All Connections

11. Ensure the simulation stop time says 300.

12. Click the Run button on the toolbar to execute simulation.

13. Double-click the Scope block to view the simulation waveforms.

Conclusion

In this tutorial, you learned:

+ How to create Vivado HLS IP using a Tcl script.

« How to import an HLS design as IP into System Generator for DSP.
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Appendix A

Additional Resources and Legal Notices

Xilinx Resources

For support resources such as Answers, Documentation, Downloads, and Forums, see Xilinx
Support.

Solution Centers

See the Xilinx Solution Centers for support on devices, software tools, and intellectual
property at all stages of the design cycle. Topics include design assistance, advisories, and
troubleshooting tips.

Documentation Navigator and Design Hubs

Xilinx Documentation Navigator provides access to Xilinx documents, videos, and support
resources, which you can filter and search to find information. To open the Xilinx
Documentation Navigator (DocNav):

« From the Vivado IDE, select Help > Documentation and Tutorials.
« On Windows, select Start > All Programs > Xilinx Design Tools > DocNav.

« At the Linux command prompt, enter docnav.

Xilinx Design Hubs provide links to documentation organized by design tasks and other
topics, which you can use to learn key concepts and address frequently asked questions. To
access the Design Hubs:

« In the Xilinx Documentation Navigator, click the Design Hubs View tab.
* On the Xilinx website, see the Design Hubs page.

Note: For more information on Documentation Navigator, see the Documentation Navigator page
on the Xilinx website.
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Vivado Design Suite Documentation

Training Resources

Xilinx provides a variety of training courses and QuickTake videos to help you learn more
about the concepts presented in this document. Use these links to explore related training
resources:

1. C-based Design: High-Level Synthesis with the Vivado HLS Tool Training Course
C-based HLS Coding for Hardware Designers Training Course

C-based HLS Coding for Software Designers Training Course

Vivado Design Suite QuickTake Video Tutorials

Vivado Design Suite QuickTake Video Tutorials: Vivado High-Level Synthesis
Vivado Design Suite QuickTake Video: Getting Started with High-Level Synthesis
Vivado Design Suite QuickTake Video: Verifying your Vivado HLS Design

© N o U~ WD

Vivado Design Suite QuickTake Video: Creating Different Types of Projects

Please Read: Important Legal Notices

The information disclosed to you hereunder (the "Materials”) is provided solely for the selection and use of Xilinx products. To the
maximum extent permitted by applicable law: (1) Materials are made available "AS IS" and with all faults, Xilinx hereby DISCLAIMS
ALL WARRANTIES AND CONDITIONS, EXPRESS, IMPLIED, OR STATUTORY, INCLUDING BUT NOT LIMITED TO WARRANTIES OF
MERCHANTABILITY, NON-INFRINGEMENT, OR FITNESS FOR ANY PARTICULAR PURPOSE; and (2) Xilinx shall not be liable (whether
in contract or tort, including negligence, or under any other theory of liability) for any loss or damage of any kind or nature related
to, arising under, or in connection with, the Materials (including your use of the Materials), including for any direct, indirect, special,
incidental, or consequential loss or damage (including loss of data, profits, goodwill, or any type of loss or damage suffered as a
result of any action brought by a third party) even if such damage or loss was reasonably foreseeable or Xilinx had been advised
of the possibility of the same. Xilinx assumes no obligation to correct any errors contained in the Materials or to notify you of
updates to the Materials or to product specifications. You may not reproduce, modify, distribute, or publicly display the Materials
without prior written consent. Certain products are subject to the terms and conditions of Xilinx's limited warranty, please refer to
Xilinx's Terms of Sale which can be viewed at https://www.xilinx.com/legal.htm#tos; IP cores may be subject to warranty and
support terms contained in a license issued to you by Xilinx. Xilinx products are not designed or intended to be fail-safe or for use
in any application requiring fail-safe performance; you assume sole risk and liability for use of Xilinx products in such critical
applications, please refer to Xilinx's Terms of Sale which can be viewed at https://www.xilinx.com/legal.htm#tos.

AUTOMOTIVE APPLICATIONS DISCLAIMER
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AUTOMOTIVE PRODUCTS (IDENTIFIED AS “XA" IN THE PART NUMBER) ARE NOT WARRANTED FOR USE IN THE DEPLOYMENT OF
AIRBAGS OR FOR USE IN APPLICATIONS THAT AFFECT CONTROL OF A VEHICLE (“SAFETY APPLICATION") UNLESS THERE IS A
SAFETY CONCEPT OR REDUNDANCY FEATURE CONSISTENT WITH THE ISO 26262 AUTOMOTIVE SAFETY STANDARD (“SAFETY
DESIGN"). CUSTOMER SHALL, PRIOR TO USING OR DISTRIBUTING ANY SYSTEMS THAT INCORPORATE PRODUCTS, THOROUGHLY
TEST SUCH SYSTEMS FOR SAFETY PURPOSES. USE OF PRODUCTS IN A SAFETY APPLICATION WITHOUT A SAFETY DESIGN IS FULLY
AT THE RISK OF CUSTOMER, SUBJECT ONLY TO APPLICABLE LAWS AND REGULATIONS GOVERNING LIMITATIONS ON PRODUCT
LIABILITY.
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designated brands included herein are trademarks of Xilinx in the United States and other countries. AMBA, AMBA Designer, Arm,
ARM1176JZ-S, CoreSight, Cortex, PrimeCell, Mali, and MPCore are trademarks of Arm Limited in the EU and other countries. All
other trademarks are the property of their respective owners.
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